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Introduction

ou're not a dummy, even if you think you are. But accounting by itself can

be a challenge — and then, when you add the computer part to it . . . well,
the whole thing can seem so overwhelming that you avoid it. (What? Never
crossed your mind?)

Okay, if you're looking at this book, you've probably decided that you've
“avoided” it long enough, and now you’re going to do it — bite the bullet
and computerize your accounting. We want to help you get the job done
as quickly as possible with the least amount of pain. You've got other
things to do, after all.

About This Book

Accounting isn’t exactly a fun subject — unless, of course, you're an accoun-
tant . .. and even then it might not really be all that much fun. You might
think that going to the dentist is more fun than playing with accounting soft-
ware. We help you get past the ugly part so that you can start enjoying the
benefits quickly.

What benefits? Well, computerizing your accounting can save you time and
effort — and can actually be easier than doing it by hand and cheaper than
paying somebody else to do it. Oh, we don’t mean that you don’t need your
accountant, because you do. But you can save money by doing daily stuff for
yourself — and paying your accountant for advice on making your business
more profitable.

Peachtree For Dummies, 2nd Edition, shows you how to set up your company
in Peachtree and then use Peachtree to pay bills, invoice customers, pay
employees, produce reports about your financial picture, and more. But it’s
also a real-life-situation kind of book. We show you how to work in Peachtree
by using everyday, real-life situations as examples. You know, the stuff you
run into in the so-called real world that you need to figure out how to handle.

What You Can Safely Ignore

Throughout the book, we include Accounting Stuff tips — you can probably
ignore those unless you're interested in that kind of stuff.
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Oh, and the gray boxes that you see throughout the book? Those are called
sidebars, and they contain extra information that you really don’t have to
know but that we thought you might find useful and interesting. So feel free
to skip the sidebars as well.

Foolish Assumptions

We'll be honest — we had to assume some things about you to write this
book. So, here’s what we assume about you:

v You already know a little something about the day-to-day stuff that you
need to do financially to run your business — you know, write checks,
bill customers, pay employees, and so on. We don’t assume that you
know how to do all that on a computer.

v You have a personal computer (that you know how to turn on) with
Microsoft Windows 98, Windows XP, or Windows 2000. We wrote this
book by using Windows XP.

»* You bought Peachtree and installed it on your computer.

The Flavors of Peachtree

Peachtree comes in four versions: Peachtree First Accounting, Peachtree
Accounting, Peachtree Complete Accounting, and Peachtree Premium
Accounting. (Peachtree Premium is available in industry-specific versions
such as manufacturing, distribution, and accounting.) In this book, we cover
Peachtree Premium Accounting.

Peachtree Premium Accounting contains everything that you find in the other
three products plus a few additional features, such as the capability to store
three years’ worth of budget information instead of the two years available in
the other Peachtree products. Peachtree Premium and Peachtree Complete
include a time and billing feature that you don’t find in Peachtree First
Accounting or Peachtree Accounting, and Peachtree Premium and Peachtree
Complete are networkable as long as you make sure that you get the multiuser
version. Peachtree Premium and Peachtree Complete contain a job costing fea-
ture, but you find only a job fracking feature in Peachtree First Accounting and
Peachtree Accounting. (If you don’t know the difference between job costing
and job tracking, you probably don’t need either one.) And you can customize
reports and forms in Peachtree Premium Accounting, Peachtree Complete
Accounting, and Peachtree Accounting, but not Peachtree First Accounting.
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Throughout the book, when we cover a feature that you find in Premium but
not in the other flavors, we include notes to let you know. And, throughout
the book, when we refer to the product as Peachtree, we mean Peachtree
Premium — if we want to talk about one of the other flavors, we give you the
full product name.

How This Book Is Organized

Every great book needs a plan. We divided this book into four parts, each
made up of two to eight chapters so that you can easily find the information
that you need.

Part I: Getting Started

If you're new to Peachtree, you probably want to read this part. We explain
how to get around in Peachtree, how to create a company in Peachtree, how
to make an effective chart of accounts, and how to set up default information
that saves you lots of time later.

Part II: The Daily Drudge

In this section, we cover the stuff that you do on a regular basis:
v Buy and pay for goods to sell to your customers (yep, we cover inven-
tory, too)

v~ Bill the customers and collect your money (or you won’t be able to pay
the employees)

v Pay the employees (or they won’t work!)
Stuff like that. We also cover paying for services that keep your business run-

ning, and we cover a couple of more esoteric topics, such as billing cus-
tomers for time that you spend working and tracking project costs.

Part I1I: The Fancy Stuff

In this section, we cover a variety of topics — most that you don’t do every
day. First, we show you how to customize forms and produce and modify
reports — after all, you put information info Peachtree, so you should be able
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to get it out and see the effects of your business habits. Then we cover recon-
ciling the bank statement and the stuff that you do monthly, quarterly, or
annually. We also show you how to easily keep your accounting information
safe — a very important chapter. Why? Because you spend so much time
putting stuff into Peachtree that it would be criminal to lose it just because
your hard drive crashes or your office is robbed.

Part IU: The Part of Tens

If you've ever read a For Dummies book before, you've seen the Part of Tens.
This part contains a collection of ten-something lists. Our Part of Tens
includes the following:

v Ten common error messages that you might see — and what they mean

v Ten things that you can get from the Web — not just Peachtree stuff like
support and additional information, but fun stuff, too, just in case you've
had a bad day and need a laugh

The Peachtree For Dummies Web Site

This book’s Web site, www.dummies.com/go/peachtreefd, features useful
information that’s not necessarily mainstream knowledge. You can find the
following Bonus Chapters:

v Bonus Chapter 1, in which you find out how to tailor Peachtree to sup-
port the way that you work.

v Bonus Chapter 2, in which we discuss how to use the Peachtree money
management tools to analyze your business and help you manage cash,
receivables, and payables.

v Bonus Chapter 3, in which we describe how to use Peachtree in a net-
work environment.

v Bonus Chapter 4, in which we list as many companion products for
Peachtree as we can find. These products can enhance the way that you
work in Peachtree.

v Bonus Chapter 5, in which we discuss who to blame for the whole
debit/credit thing and explain how debits and credits work.
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Icons Used in This Book

Throughout the book, you notice symbols in the margin. These symbols, or
icons, mark important points.

N\
This bull’s eye appears next to shortcuts and tips that make your work easier.
QNG
& When you see this icon, something could go wrong, so make sure that you
read the paragraph anyway. This icon warns you of common mistakes and
ways to avoid them.
“&N\BER
& This icon marks any point that you want to be sure to remember. You might

want to reread paragraphs that are marked with this icon.

This icon identifies information related to accounting in general — not just
Peachtree. You can skip this stuff if you don’t care about accounting.

Where to Go from Here

Just getting started with Peachtree? Turn the page. Do you have a specific
topic of interest? Use the index or the Table of Contents to find the topic and
turn to that page.

5
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In this part . . .

E very project has a beginning point. If you are just get-
ting acquainted with Peachtree, this part is the place
to start. In this part, you find out how to navigate through
the Peachtree screens and how to set up your existing
company records in Peachtree.




Chapter 1

Mastering Peachtree Basics

In This Chapter

Starting Peachtree

Navigating the Peachtree screen

Getting help

f you have been keeping your financial records using manual methods, you
know how time consuming it can be. Plus, keeping books manually provides
too many opportunities for human error. Using Peachtree saves you both time
and money; in addition, you can know at any moment in time your complete
financial status. We know you’re eager to get started. Operating a business is
a nonstop process, but to computerize your accounting, you have to put first
things first.

To work effectively, take some time to get comfortable with some of the fea-
tures unique to Peachtree. In this chapter, you find out how to navigate in the
software as well as open and close companies as needed. We also show you
where you can turn for additional assistance. If you're ready, dig in.

Starting the Program

A\

You have a choice: You can start Peachtree the easy way or the hard way. We
prefer the easy way. When you installed Peachtree, with your permission, it
placed a Peachtree icon on your Windows desktop. Assuming (we know, we're
not supposed to assume) that you haven’t thrown that icon into the Recycle
Bin, you can simply double-click the Peachtree icon (the one with the peachy
little peach on it), and the program starts.

To make sure that Peachtree always starts in a full-sized (maximized)
window, right-click the Peachtree icon and click Properties. In the resulting
dialog box, click the drop-down arrow in the Run box, select Maximized, and
then click OK to accept the changes.
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If you did throw the icon away or you have so many icons on your desktop that
you can’t see it, okay, you can start Peachtree the hard way. Choose Start>

All Programs=Peachtree Premium Accounting 2005=>Peachtree Premium
Accounting 2005— for a total of four mouse clicks.

Choosing opening options

After you start Peachtree, what do you do with it? The Peachtree Start Screen
appears as shown in Figure 1-1, beckoning you to do one of several things.
You can select any of the following options or click the Close button to close
the window:

v Open an existing company: Use this option to open a company already
existing in Peachtree.

1 Create a new company: Select this option to set up your business with
the Peachtree Setup Wizard. (Chapter 2 covers this wizard.)

1 Explore a sample company: Use this option to explore one of several
fictitious companies. One company, Bellwether Garden Supply, is a retail
and service company that uses most of the features of Peachtree, includ-
ing inventory and job costing. Depending on the Peachtree edition you
are using, you may have additional sample companies to investigate.
You explore one of these in the steps in the following section.

v Take a Guided Tour of Peachtree: Wander down this path when you've
got some extra time and try to spot some of the things that you see in
this book.

v Convert from a QuickBooks or One-Write Plus Company: If you have
finally come to your senses and want to transfer to Peachtree from that
other software, click this choice. Peachtree helps to make the conversion
pretty painless.

Exploring a sample company

You can best explore Peachtree’s features by opening the Bellwether Garden
Supply sample company and finding out how to move around in Peachtree.
To open a sample company, follow these steps:

1. Click Explore a Sample Company.

If you're using Peachtree First Accounting or Peachtree Accounting,
Bellwether Garden Supply immediately opens.

If you're using Peachtree Complete Accounting or Peachtree Premium
Accounting, the Explore a Sample Company dialog box opens.
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|
Figure 1-1:
Make a
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|
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2. Click the radio button next to the sample company that you want to
explore.

For this example, click Bellwether Garden Supply.
3. Click OK.

As with other Windows programs, the name of the currently open com-
pany appears at the top of the window in the Peachtree title bar.

Getting around town

When you first open a sample company, the Peachtree Today window appears.
(See Bonus Chapter 2 on this book’s Web site for more information about the
Peachtree Today window.) For now, click the Close box to close the Peachtree
Today window.

Although the main menu window of Peachtree looks pretty plain, don’t skip
too lightly through it. The window actually displays several pieces of informa-
tion. At the bottom of the screen, the Windows-style status bar (see Figure 1-2)
displays information about the field, window, or menu choice that you happen
to be using, as well as the current date, a toolbar, and the current accounting
period. We think that the toolbar Calculator tool is especially helpful!

11
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Hover your mouse over each tool on the main application toolbar to see a
Tool Tip description of its function.

Current accounting period

Peachtree Today
W\ /1507 ][ Peiod -8/1/07 lo 3/31/07 mm B ul B=EE| 8 a9

System date

Choosing menu commands

The pull-down menus should be a familiar sight from your other Windows
programs. Even though the other menu choices are important, you're likely
to spend the majority of your time in Peachtree using the following three
main menu choices:

v Maintain: This menu offers choices for working with data records. For
example, you can store vendor, customer, inventory, and employee infor-
mation, including names, addresses, and phone numbers.

A record is all the information about one person, product, event, and so
on. Every record in a database contains the same fields. A field is one item
of information in a record, such as an ID, name, or transaction number. To
explore the parts of the information that you store in Peachtree, see the
“Exploring fields and records” section, later in this chapter.

v Tasks: This menu is where you do your normal day-to-day work. You can
bill your customers, buy materials, and pay your workers by using the
Tasks menu.

v Reports: This menu is where it all comes together and where you can
see the results of all your hard work.

Opening a Company

Maybe you need to keep numbers for more than one business. Peachtree
enables you to account for the financial information of more than one com-
pany. Although you can open only one company at a time, you can switch
back and forth between companies very easily.
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\\J

Opening a Peachtree company
from within Peachtree

The steps to open a company differ, depending on whether you’re opening a
company while already in a Peachtree company or whether you’re opening a
company from the Peachtree Start Screen. (See Bonus Chapter 1 on this book’s
Web site to find out how to hide the Start Screen and have Peachtree open
directly to your company.) If you're already in a Peachtree company and want
to open a different one, follow these steps:

1. Choose File=>Open Company (or press Ctrl+0O).

You get an annoying little message telling you that you're closing the
current company. Peachtree allows only one open company at a time.

Click the Do not display this message again check box to permanently
disable the message box.

2. Click OK to acknowledge the message.
The Open dialog box appears.
3. From the Open dialog box, click the company name and then click OK.

The newly opened company name appears at the top of the screen. No
matter which company you open, the menu choices remain the same.

Opening a recently used
Peachtree company

If you find yourself frequently switching back and forth between several com-
panies, Peachtree provides an easier method; the Open Previous Company
option. This option lists up to ten previously opened Peachtree company
names from which you can select. Follow these steps to open a previously
open company:

1. Choose File=>Open Previous Company.

A list of previously open Peachtree company names appears.
2. Click the company name that you want to open.

The annoying little message that we mention in the previous section
appears unless you turned it off.

3. Click OK to acknowledge the message.

The selected company opens on the screen.

13
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Opening a company from the
Peachtree Start Screen

If you're opening a company from the Peachtree Start Screen, a different
dialog box appears. To open a company from the Peachtree Start Screen,
follow these steps:

1. Click Open an existing company to display the Open an Existing
Company dialog box.

This dialog box lists the companies that you recently opened in
Peachtree. If the company name that you want to open doesn’t appear,
click the Browse button and make your selection from the Open dialog
box.

2. Click the company name that you want to open and then click OK.

The selected company opens.

Exploring Peachtree’s Windows

Most windows in Peachtree are similar. They have places for you to fill in infor-
mation and buttons that you use to take actions in that particular window. The
Maintain Customers/Prospects window is typical of many other windows that
you use in Peachtree. For an example, open Bellwether Garden Supply and
choose Maintain>Customers/Prospects. Take a stroll around this window.

Managing window sizes and placement

Depending on your screen size and resolution, you might not see enough of a
window to suit your needs. Some windows, such as the Sales/Invoice window,
display more lines when made larger. If you resize the window manually,
Peachtree remembers that setting and uses it each time. You can also maxi-
mize the window, and Peachtree remembers that you like it maximized.

Place your mouse pointer around the border of any window until the pointer

displays as a double-headed arrow. Click and drag the border until the window
is the appropriate size.

Exploring fields and records

The main part of a Peachtree window consists of fields. Stop for a moment
and ponder these components. When we refer to fields, we're not talking
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about the place corn grows. Fields are pieces of information that fit into a
record, which is a type of electronic 3 x 5 index card. A record is all the infor-
mation about one customer, vendor, employee, or inventory part, but a field
is one piece of the record such as the ID, name, or phone number. In Figure
1-3, the record is all of the information about Archer Scapes and Ponds, and
Nancy Archer is in the Contact field.

Browse buttons

Lookup list indicator

9%

= Maintain Customers/Prospacts
I

E= § o) ca | EE 2 3
’EEQ Save Dgle Change il g?fe‘ﬁ Toa| Leffers gp
Customer ID: [ARCHER el [=] I~ Prospect
Name: [Brcher Scapes and Ponds I~ Inactive

General | SoksDefauls | TemsandCiedt | PamentDefauls |  CustomFieds | Histary

Contzer B

— Billoaddess Telsphone 1
Teephons 2
Fig“re 1_3: Address: |778 Dakland Parkway Fax @l

E-mail |narcher@sample peachtree.c @
Each record Dty.ES DTu f.l,: [Fipharetta A [30082 T

has ma ny Sales Tay: [RACHER Beginning Balances: []
d ff t Currert Balapce on Mar 15, 2007 El 743467
Irreren

fields.

Looking up information

Some fields, such as Customer ID, have a magnifying glass next to them. These
fields contain lookup lists that display a list of your customers (or vendors,
accounts, employees, inventory items, and so on). You can choose a record
from a lookup list. Depending on the global options that you set, a lookup list
may automatically appear as you type any character in the field, or you can
click the lookup list indicator (the magnifying glass) to display the list that’s
relevant to the current field. (See Figure 1-2.)

A\
Optionally, to display the lookup list, either click the right mouse button in a
lookup box or press the Shift key along with the question mark (?).

You can do any of the following while in a lookup list:

v Select a customer (vendor, item, and so on) and then click OK.
Peachtree selects the highlighted record and closes the lookup list.

v Click Cancel to close the lookup list without selecting a record.
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v Use the Find feature to search for a string of characters. The search
covers any text that you can see in the displayed list. The Find feature
is not case sensitive. Press Enter after you type the lookup text in the
entry box. Peachtree highlights the first item that matches your request.

v Click Find Next to find the next instance of the previously entered Find
text. If no next instance exists, the Find feature skips to the first instance
in the lookup list. If no instance exists at all, the Find Next feature does
nothing.

v Click Sort to sort the displayed list either alphabetically by the ID or
name. (Numbers come before letters.)

v Use the Help option if you need it.

Some lookup lists, particularly the ones in the Task menu selections, have
two additional buttons.

1 Use the New button to add customers, vendors, employees, or inventory
items on-the-fly, which means Peachtree adds the record right in the
middle of entering a transaction.

v Click the Edit button to edit the record of a customer, vendor, employee,
or inventory item.

Just browsing

Similar to buttons you use with a Web browser, Peachtree includes browse but-
tons to quickly scan the next record or the previous record. If you're in a main-
tenance window, such as Maintain Customers/Prospects or Maintain Inventory
Items, the browse buttons move between the records in the order of customer

ID or inventory item ID.

If you're in a Task window, the browse buttons move between the previous
transaction and the next transaction.

Making a date

Many Peachtree windows have date fields where you need to enter data based
on the calendar. If you're a keyboard-type person, you can simply type the
date. Dates need to be typed as numbers. If you want, you can type the date
by using the / (slash) key, but the slash isn’t necessary. For example, to enter
September 16, 2004, type 091604 or 09/16/04. Be aware that Peachtree doesn’t
allow you to use a dash (-) in a date.
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) In most Peachtree date fields, you can get away with entering just the first

four digits of a date. Peachtree then enters the year. The year is based on the
system date displayed on the Peachtree status bar.

Now if you're like us, we need a calendar in front of us to select dates.
Fortunately, Peachtree fields that require you to select a date also include a
calendar, shown in Figure 1-4, so you can click that to select a date. To select
a date from the calendar, follow these steps:

1. Click the calendar icon next to a date field to display the current
month.

2. Click the left-pointing arrow next to the month name to display a previ-
ous month or click the right-pointing arrow to display a future month.

3. Click the date that you want for the date field.

The small calendar closes, and the date appears in the field.

Calendaricon
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date field.

I Take control of mailing and shipping the easy way!

Using the window toolbar

Earlier in this chapter, we mention the Peachtree toolbar, which appears on the
status bar at the bottom of your screen. Most Peachtree windows include their

17
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own toolbars located across the top of the window. You use the Peachtree tool-
bar across the top of the window to complete the various tasks involved with
the selected window.

The exact buttons vary slightly from window to window, but most of them
have a Close button. To get out of a Peachtree window, you can use the Close
button or the Windows Close button (X).

If you position the mouse pointer over any button on the toolbar, a small
yellow box called a Tool Tip appears to explain the use of the button. Tool
Tips are great for those CRS moments when you look at a button and cannot
remember its function. CRS (Can’t Remember Stuff) is a widespread disease
that affects people of all ages, races, religions, and hair colors.

You also use the Save button frequently. The Save button appears on the tool-
bar if you're modifying data records, such as customers, from the Maintenance
menu or if you're using a transaction entry window under the Tasks menu,
such as Payroll Entry or Inventory Adjustments. You click the Save button

to save the displayed transaction, and if you're using the real-time posting
method, Peachtree also posts the transaction to the General Ledger (G/L).
(See Chapter 2 for an explanation of posting methods.)

Post is one of those words with many different meanings. It can be a noun like
the place you tie your horse, or it can be a verb and mean to send. Of course,
the latter is how the word post is used in accounting, and it means to save and
send. In Peachtree, you're sending transactions to the general ledger (G/L);
then, when you want to find out whether you’ve made any money this month,
Peachtree is able to show you.

Getting a Helping Hand

We really hope that you get most of the answers you need from this book.
However . . . sometimes you need additional assistance.

What’s this all about?

If you're in a Peachtree window and don’t quite know what a particular field
represents or what you're supposed to enter in that field, you can use the
What'’s This feature, which is similar to features that you’ve probably used in
other Windows applications. In Peachtree, right-click the field where you need
a hint. Then choose What’s This from the menu that appears. A summary defi-
nition of the field appears. To close a What’s This text box, click inside it.
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For our next demonstration . . .

Peachtree includes a series of demonstrative movies to help you with some key
practices. The demos include topics such as how to make backups, change
accounting periods, drill down in reports, and a variety of other subjects.

1. Choose Help->Show Me How To to display a list of demo topics.

2. Select the demo that you want to see.

A demonstration window appears. Sit back, relax, and enjoy the show.
Be nice and share the popcorn!

Using the Help Contents

The Peachtree Help system works in an HTML format, which simply means
that it looks and works similar to a Web page. For easy navigation, the help
windows have Back and Forward buttons as well as a Home button. To open
the Help Contents, follow these steps:

1. Choose Help=>Contents and Index to open the Peachtree Help window.

The Contents tab appears on top. The Help Contents feature presents
help information in a book-like format, making browsing available topics
easy. If you've used the Help Contents tab in other Windows programs,
you already know how to use the Help Contents in Peachtree.

2. If they aren’t already displayed, click the Contents tab to display a list
of topics available in Peachtree Help.

3. Double-click a book to open that topic.
4. Continue opening books until you find the topic that you want to read.
5. Click the page icon to display the topic.

The help information is displayed on the right side of the screen. From
this point, you can click the underlined hyperlinks to jump to related
topics or print a topic.

Using the Help Index

Use the Help Index to look up a keyword or phrase in the extensive online
index. The Peachtree Help Index feature works the same as the Help Index in
other Windows applications. To use the Help Index, follow these steps:

1. Choose Help->Contents and Index to open the Peachtree Help window.

2. Click the Index tab.
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3. Scroll through the index to locate the term that you’'re looking for.
Peachtree lists the index in alphabetical order.
4. Double-click a keyword.
Peachtree displays a list of topics relevant to the keyword you selected.
5. Double-click the topic you want.
Peachtree displays the topical information on the Help window’s right
W panel.

If all else fails, you can also access the Peachtree manuals from the Help menu.
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Setting Up Your Company

In This Chapter

Supplying your company information

Specifying an accounting method

Identifying accounting periods
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peachtree tracks all kinds of information, including the names and
addresses of your customers, vendors, or employees, and any business
transactions that you've made with them. But before Peachtree can do any of
that, you have to tell the software about your company. You need to tell it the
usual stuff such as name and address. (That’s so you don’t forget who you
are. . ..) You also need to tell it when you want to pay Uncle Sam taxes on the
money that you earn and spend. (Sorry, but never is not an option.)

Keep this important fact in mind: Two of the options that you determine when
setting up a Peachtree company are written in stone — no going backward.
One is whether you run your business on a cash or an accrual basis, and the
other is the time frame of your accounting year. We talk about these issues in
the accounting method and accounting period sections of this chapter.

Starting the New Company Setup Wizard

When you want to create a new company, the New Company Setup Wizard
simplifies the task for you. It asks you the basic questions in the order that
Peachtree needs to set up your business. (If you're not setting up a new com-
pany but are simply changing settings, see Chapter 4.)

You access the New Company Setup Wizard when you click Create a new com-
pany from the Peachtree start screen. Like most wizards, the New Company
Setup Wizard guides you through the process. You've probably used wizards
dozens of times (not to mention when you install most applications, such as
Peachtree), so we keep things short and sweet.
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If you're already in Peachtree and want to create a new company, choose
File>’New Company to start the New Company Setup Wizard.

When you’re done checking out the opening screen, click Next to move to the
next screen.

The following sections walk you through each step of the New Company
Setup Wizard.

Introducing Your Business to Peachtree

The left half of the New Company Setup Wizard screen is pretty self-explanatory.
Fill in your business name, address, city, two-letter state name, and, optionally,
country. Notice we say country — not county! Many people misread this line. You
see country fields other places in Peachtree. Use the Tab or Enter keys to fill in
or skip through the fields.

The first item on the right side of the screen asks for your business type. To
fill in the rest of the screen, follow these steps:

1. Click the drop-down list to display and select a Business Type.

Options are Corporation, S Corporation, Partnership, Sole Proprietorship,
or Limited Liability Company. Selecting a type of business tells Peachtree
how to determine equity accounts.

Equity is what’s left after you subtract the company’s liabilities from the
assets. The equity is the value of a company to its owners. In a corpora-
tion, the equity is divided among the stockholders, but if the business is
a sole proprietorship or partnership, the equity belongs to the individual
owner or owners, respectively. If you're not sure what type of business
you have, talk with your accountant.

2. Enter your information in the Federal Employer, State Employer, and
State Unemployment IDs fields.

If your state doesn’t use employer IDs or unemployment IDs, leave these
fields blank.

3. Click Next to move to the Chart of Accounts screen.
4. Select a Chart of Accounts option (see Figure 2-1) and then click Next.

If you're not sure which option to select, read the section “Selecting a
Chart of Accounts,” later in this chapter.
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|
Figure 2-1:
The last
option
shown here
appears
only if
you're using
a Peachtree
Premium
version.
|
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New Company Setup - Chart of Accounts

Chart of Accounts

Peachtres provides several methods for setting up your compaty.

Select one of the fallowing setup options:

- Set up a new Retall, Service, Construction, Manufacturing, o Distibution
company, using a simplified chart of accounts

Set up a hew company using an extensive chart of accounts fram one of many
sample companies

" Copy settings from an existing Peachtree Accounting compary
" Corwert a compary from another accounting program
" Build pour own company

" Consolidate existing Peachtres Accounting companies

< Back Next > | Cancel Help

What you see next depends on the option that you selected. For exam-
ple, if you chose to set up a new company based on one of the several
sample companies, a list of business descriptions appears. Don’t worry
if the descriptions of the accounts that you select don’t match yours
completely; you can edit them after you're done with the New Company
Setup wizard. (Chapter 3 shows you how to customize the Chart of
Accounts.)

If you choose to copy settings from an existing Peachtree company, a list
of existing Peachtree companies appears. Peachtree asks whether you
want to copy default information from these other companies. Usually,
you do want to copy default information.

. Select the sample Chart of Accounts that most closely matches your

business or click the company from which you want to copy; then
click Next.

The Accounting Method screen appears.

. Select an accounting method and then click Next.

For important information on choosing an accounting method, see
“Selecting an Accounting Method” later in this chapter.

The accounting method is one of the two items that you can’t change
after you finish creating your Peachtree company. Be sure of your
method before proceeding.

. Select a posting method and then click Next.

To understand posting methods, see “Selecting a Posting Method,” later
in this chapter.

The Accounting Periods screen appears.
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8. Select an accounting period structure option and then click Next.

See “Selecting Accounting Periods,” later in this chapter, if you're not
sure which option to select.

The accounting period is the second of the two items that you can’t
change after you finish creating your Peachtree company. Be sure of
your accounting periods before proceeding.

9. Select the dates as requested and click Next.

The default screen that appears next displays how Peachtree sets up the
standard (default) information for your vendors, customers, and inven-
tory items. Don’t worry if you don’t plan on using one of these modules,
or if the information is incorrect. (See Chapter 4 for information on
changing the default information.)

10. Click Next. The final setup screen appears.

Congratulations! You're almost finished with the New Company Setup
Wizard. Optionally, you can have Peachtree display a checklist of steps
to continue setting up your company information.

We recommend using the Back button to double-check that the account-
ing method and accounting periods are correct before you click Finish.
After you click Finish, you can’t change them.

11. Click Finish.
Peachtree creates a set of data files for your company and displays the
Peachtree Today screen.

The Peachtree Today screen includes a Setup Guide that’s designed to walk
you through the remainder of the setup process.

Selecting a Chart of Accounts

The New Company Setup Wizard also asks you to choose how you want to
start your Chart of Accounts. If you're a new business, you might want to
choose one of the samples provided by Peachtree, or you might already have
a Chart of Accounts supplied by your accountant.

The Chart of Accounts lists the names that you use to classify transaction
information and categorizes the accounts so that they appear in appropriate
places on financial statements. If you're not sure which Chart of Accounts to
select, you can choose one of the sample Charts of Accounts that are supplied
by Peachtree. Peachtree has listed dozens of business types (6.25 dozen, or 75,
to be exact), and each one includes accounts typical to the selected business
type. For example, the accounts that a shoe store uses are different from those
that a drugstore or a dentist uses.
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Accounts are the systematic arrangement of numbers and descriptions to
keep records of the business that your company transacts. Each time you
buy or sell something, you record the transaction and assign it to one or
more accounts. Accounts help you organize information by grouping similar
transactions together.

Peachtree has several Chart of Accounts options (refer to Figure 2-1):

v~ Set Up a New Retail, Service, Construction, Manufacturing, or
Distribution Company, Using a Simplified Chart of Accounts: This option
allows you to select from one of the predefined Charts of Accounts that
comes with Peachtree. The simplified Chart of Accounts includes the
basic accounts that a retail, service, construction, manufacturing, or dis-
tribution company might use.

1 Set Up a New Company Using an Extensive Chart of Accounts from
One of Many Sample Companies: This option allows you to select from
one of the seventy-five detailed predefined charts of accounts that are
industry specific such as florist, auto repair, beauty repair or video
rental businesses.

v Copy Settings from an Existing Peachtree Accounting Company: This
option copies the Chart of Accounts from a Peachtree company that’s
already set up. Use this option if you're starting your Peachtree company
books over or starting another company with a similar Chart of Accounts.

v Convert a Company from Another Accounting Program: Select this
option if you’re switching from Peachtree Complete Accounting for DOS,
Quicken, or Quickbooks.

v Build Your Own Company: Use this choice if your accountant has sup-
plied you with an account list or you're starting with a manual system
that uses account numbers.

v Consolidate Existing Peachtree Accounting Companies: If you're using
one of the Peachtree Premium versions, you can select this option to
combine the Charts of Accounts of other existing Peachtree companies
to create a new consolidated Chart of Accounts.

Selecting an Accounting Method

\NG/
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At the beginning of this chapter, we mention that you enter two pieces of per-
manent information in the New Company Setup Wizard. Selecting your
accounting method is one of those two pieces of info. Your business can be
accrual-based or cash-based.

Because you must report your accounting method to the IRS, don’t just arbi-
trarily pick one. If you're not sure, ask your accountant. Doing so might just
keep you out of jail.
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Accrual or cash: What's the difference?

An accrual-based business is one that recog-
nizes income in the month an invoice was
issued to a customer, regardless of when that
customer decides to pay. Also, accrual-based
businesses recognize a purchase as an
expense in the month that you make the pur-
chase, not whenever you write the check to
your supplier.

A cash-based business is one that declares
income in the month that you receive the pay-
ment from your customer and expenses in the
month that you actually write the check to your

supplier. Dates of customer invoices and vendor
bills play no role in a cash-based business.

Say, for example, that you sell a $20,000 service
to Smith and Sons on December 13th. You
invoice them right away, but they don’t pay you
until April 2nd of the next year. Do you declare
that $20,000 as part of your sales for December?
If the answer is yes, you're running an accrual-
based business. If that $20,000 doesn’t show up
on your income statement until April 2005,
you're running a cash-based business.

Selecting a Posting Method

The posting method determines how Peachtree processes or transfers the

\\J

transactions that you enter from the individual journals to the general ledger.

You have two options: real-time or batch posting. You can switch posting

methods at any time.

Journals are electronic or paper records of accounting transactions. Peachtree
has many different types of journals. For example, the Cash Receipts journal
stores transactions of money that you receive, and the Cash Disbursements
journal stores transactions of the money that you spend. Through posting, the

journals ultimately go into the General Ledger (G/L), where Peachtree sorts
the information and reports it to you on financial statements.

If you choose real-time posting, Peachtree posts the transactions to both the
individual journals (like Cash Receipts) and to the G/L as you enter and save

transactions. This posting method immediately updates the company’s finan-

cial information. For example, if an accrual-based business using real-time

posting enters an invoice to a customer and then prints an income statement,

that invoice is included in the income totals.

Real-time posting can save you a lot of time. We recommend that you use the

real-time posting method.
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If you choose batch posting, Peachtree saves the transactions and then posts
them in a group when you initiate the posting process. When you use batch
posting, you can print registers and check the batch of transactions before
posting them to the journals.

While using batch posting, Peachtree prompts you to post journals when nec-
essary. For example, before you enter a customer receipt, you need to have
all the invoices posted.

Selecting Accounting Periods
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According to a calendar in our office (the one with the Yorkshire Terriers all
over it), a new year starts on January 1. Some businesses, however, start their
business years, or fiscal years, at different times. You can’t watch Dick Clark as
the new fiscal year rolls in, but I guess if you want, you could have champagne
and throw confetti. (For details on closing a fiscal year, see Chapter 17.)

Entering the fiscal periods correctly in Peachtree is very important. Selecting
the accounting periods is the second of the two permanent items you set in
the New Company Setup Wizard. After you create fiscal periods, you can’t
change them.

You can choose from two options on this screen:

1 Twelve Monthly Accounting Periods: Each accounting period’s starting
and ending dates match those of the 12 calendar months. On the next
screen, you can choose the month to start your fiscal year.

1 Accounting Periods That Do Not Match the Calendar Month: Select this
option if you want to set up a custom fiscal year structure. For example,
you might want four accounting periods per year or possibly 13 four-
week accounting periods per year.

On the next screen, Peachtree prompts you to choose the year and month
that you want to begin entering data. If you choose to set your own fiscal cal-
endar month, Peachtree also asks you to enter the number of accounting
periods that you want to use. Most businesses use 12 accounting periods,
based on the calendar months.

Visit this book’s Web site for more information on Peachtree.
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Chapter 3
Designing the Chart of Accounts

In This Chapter

Understanding account types

Using masking
Modifying the Chart of Accounts

We know you’re eager to start using the software. But before you dive
in, we need to tell you a little about the Chart of Accounts, which

serves as the foundation for all your reports. To make sure that you get the
reports you want, you might find that a little planning at this stage is wise.
Some of the material in this chapter might seem a little dry because it deals
with accounting principles and information that you need for your big picture
financial tracking, but understanding this information helps you set up the
Chart of Accounts that produces the business reports that you want.

Understanding the Chart of Accounts

You use accounts to keep records of the business that your company trans-
acts. Each time you buy or sell something, you record the transaction in the
appropriate accounts. Accounts help you organize information by keeping
similar transactions together. In today’s world, for example, you probably get
several different telephone bills for your regular phone, your fax phone, your
cellular phone, your pager, and so on. But when you think of the big picture,
all the bills are related to telephone expenses. So when you pay these bills,
you record all the transactions in the Telephone Expense account.

The Chart of Accounts is nothing more than the list of all your accounts. The
Chart of Accounts doesn’t show any amounts — just titles and numbers that
you assign to each account. But like any list, you can and should organize the
Chart of Accounts to make the best use of it. So where do you get a list of your
accounts and their balances? Use the General Ledger Trial Balance report. See
Chapter 14 for details.
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Understanding account types

Good accountants and bookkeepers are typically very organized people —
they would hate what they do (and probably wouldn’t do it for long) if they
weren’t. So, it should come as no big surprise that they’'ve invented a method
to help them organize things further.

To organize the Chart of Accounts, accounting uses account types. Usually,
accounts are broken down into five general categories of account types:

v Assets: Things that you own but don’t sell to customers. Money in check-
ing and savings accounts, computers, trucks, and money that others owe
you are all assets.

v~ Liabilities: Debts that you owe to others. Bills from your vendors and
bank loans are liabilities.

v Equity: Also known as net worth, equity represents the amount that
owners have invested in the company. Some people prefer to think
of equity as the owner’s claim against the assets of the company (as
opposed to liabilities, which are outsiders’ claims against the business).
Basically, if you used your assets to pay off your liabilities, what you’d
have left is equity.

v Income: The sales that you make to your customers. Income and rev-
enue are interchangeable terms.

v Expenses: The cost of staying in business to do business. The wages
that you pay your employees and the money that you spend advertising
are expenses.

You can break down these account types even further to organize them. In
Table 3-1, you see the account types that are available in Peachtree, their gen-
eral categories, and what they represent. The sidebar “Accounting terms for
account types” gives the accounting details on these types.

Table 3-1 Account Types and What They Represent
Account Type General Represents

Category
Cash Asset Money in the bank that's available for

transacting business, as well as unde-
posited funds (checks, money orders,
and so on).

Accounts Receivable  Asset Money that customers owe but haven’t
yet paid; required for accrual-based
businesses.
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Account Type General Represents
Category
Inventory Asset The value of the goods that you have on
hand and available for sale.
Fixed Assets Asset The value of things (property and equip-

ment) that you own for long-term use
(with an estimated life of longer than
one year) in your business rather than
for resale.

Accumulated
Depreciation

Contra asset

The value by which fixed assets are
reduced to indicate their decline in value,
usually due to age. A truck doesn't last
forever, no matter how hard you try to
keep it in good running condition.

Other Current Assets

Asset

The value of nonworking capital that
has a short life (usually less than a
year). Employee advances and prepaid
expenses, such as deposits made to
utility companies, are examples of other
current assets.

Other Assets

Asset

The value of nonworking capital that
has a long life (usually longer than one
year).

Accounts Payable

Liability

The value of the bills you owe to ven-
dors that are usually due in 30 or 60
days (a short time frame); required for
accrual-based businesses.

Other Current
Liabilities

Liability

The value of debts that you must pay in
less than one year. Short-term loans are
other current liabilities.

Long-Term Liabilities

Liability

The value of debts that you must pay
but you have longer than one year to
pay them. A three-year bank loan to buy
a truck is a long-term liability.

Equity—doesn't close

Equity

The value of things, such as common
stock, that carries forward from year to
year. Typically, you use this account
type for a corporation that issues stock.

(continued)
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Table 3-1 (continued)

Account Type General Represents
Category
Equity—gets closed Equity The value of equity accounts that don’t

carry forward from year to year but
instead become part of retained earn-
ings. Use this account type for divi-
dends that you pay to owners or
shareholders.

Equity—Retained Equity The accumulated value of net profits or

Earnings losses. Peachtree automatically
updates this account for you when you
close your year.

Income Income The value of sales that you make to your
customers.
Cost of Sales Expense The known cost to your business of sell-

ing goods or services to customers.
Generally, the price that you pay for
purchased goods for resale or to use in
manufacturing goods for resale is the
cost of sales.

Expenses Expense The costs that your business incurs to
operate, such as wages, rent, and
electricity.

Accrual-based businesses must use an Accounts Receivable account and an
Accounts Payable account, but many cash-based businesses also want to use
these accounts to produce an aging report of customers’ outstanding bal-
ances or of bills that are due to vendors. See Chapter 2 for more on account-
ing methods.

WBER Keep a couple notes in mind about the account types and equity accounts in
your Chart of Accounts: The account type that you choose for an account
determines the financial report on which it appears and the placement on the
financial report. Consider the three main financial reports: the Income
Statement, the Balance Sheet, and the Trial Balance. Income and Expense
accounts appear on the Income Statement, but not on the Balance Sheet. The
Balance Sheet shows all Asset, Liability, and Equity accounts. The Trial
Balance shows all account types, in the following order: Assets, Liabilities,
Equity, Income, and Expense.
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Accounting terms for account types

Nonworking capital is something that you own  bonds that don’t mature for at least one year,
and don't sell to customers, but you could sell it  you have other assets.

to turn it into cash. Certificates of deposit (CDs)
are an example of nonworking capital. The
length of time before the CD matures deter- Some people call cost of sales, cost of goods
mines whether itis an other current assetor an  sold— same thing.

other asset. If your company owns CDs or

Income and revenue are interchangeable terms.

The account type also determines how Peachtree handles the account when
you close your year. For example, Peachtree zeros out Income and Expense
accounts but doesn’t zero out Asset or Liability accounts. Keep in mind the
following points about equity:

v You can have only one Equity-Retained Earnings account.

v You should show the initial investment in the business as either Paid-In
Capital, if your business type is a corporation, or Owner’s Contributions,
if your business type is a proprietorship (sole or partnership) or an LLC
(Limited Liability Company). These are Equity-doesn’t close account
types.

v You should track withdrawals from the initial investment using a
Dividends Paid (corporation) or Owner’s Draw (proprietorship)
account; these accounts are Equity-gets closed account types.

The sum of the Equity—Retained Earnings account and any Equity—doesn’t
close accounts (you can have more than one Equity—doesn’t close account
types) equals the net worth of the company prior to the current year.

Numbering accounts

Okay, in the previous section, we discuss account types, which help you orga-
nize the appearance of accounts on financial statements. The account num-
bers that you use can also affect the information that you can present on
financial reports.
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First, understand that Peachtree places very few restrictions on the number-
ing scheme that you use. Be aware of the following points when you develop
your account numbering scheme:

v Peachtree sorts Account IDs alphabetically — that means numbers first,
and you need to use leading zeros to get numbers to sort in numerical
order (I know that sounds stupid, but it’s true). For example, to get the
numbers 1, 27, 100, and 1000 to sort in the order just listed, you’d need
to enter them as 0001, 0027, 0100, and 1000.

v Account IDs can contain any printable character except the asterisk (*),
the plus sign (+), and the question mark (?).

v Account IDs cannot contain leading or trailing blanks, but you can use
blanks in the middle.

v Account IDs are case sensitive; cash and CASH are two different accounts.

Most people use numbers, not letters, for Account IDs, and they use letters
for the account’s description. The description appears on all reports; the
Account ID appears on only some reports.

“‘QN\BEI? Because Peachtree places so few restrictions on the Account ID, you can use
> any scheme you want, but we strongly suggest that you keep it logical. For
example, many companies number all asset accounts in the 10000 range, lia-
bility accounts in the 20000 range, equity accounts in the 30000 range, income
accounts in the 40000 range, cost of sales accounts in the 50000 range, and
expense accounts in the 60000 range or higher.

Handling departments or locations

Suppose that your business has multiple geographic locations, and each loca-
tion generates income and expenses. Or suppose that you don’t have geo-
graphic locations but you do have multiple departments, and each department
generates income and expenses that you want to track. Of course, you want to
produce a company-wide income statement, but how do you want it to look?

Perhaps you want a detailed Income Statement that’s broken down by depart-
ment, like the one in Figure 3-1. Or, maybe you want an Income Statement that
summarizes the information for all departments, like the one in Figure 3-2. Or
maybe you want to be able to produce Income Statements for individual
departments, like the one shown in Figure 3-3.

Because we show you all three formats, it’s safe to assume that you can pro-
duce any of these reports in Peachtree. But to do so, you must correctly set
up the numbering of your Chart of Accounts.
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Bellwether Garden Supply
Income Statement
For the Three Months Ending March 31, 2007

Current Month Year to Date
Revenues
Sales $ 175.00 021 § 175.00
Sales - Aviary 5,628.01 6.67 50,153.16
Sales - Books 149.75 0.18 7,293.10
Sales - Ceramics 0.00 0.00 0.00
Sales - Equipment 15,139.29 17.94 57,492.78
Sales - Food/Fert 1,006.96 1.19 5,204.15
Sales - Furntiture 15,000.00 17.77 15,000.00
Sales - Hand Tools 729.67 0.86 7,058.12
Sales - Landscape Services 7,469.43 8.85 16,977.53
Sales - Miscellaneous 0.00 0.00 45.00
Sales - Nursery 31,200.48 36.97 65,042.56
Sales - Pots 5,905.08 7.00 9,469.51
Sales - Seeds 1,457.43 1.73 8,661.39
e S2les - Soil 655.02 0.78 9,082.55
Sales - Statuary 0.00 0.00 0.00
Figure 3-1:  Sales - Topiary 0.00 0.00 0.00
An Income Interest Income 0.00 0.00 0.00
Other Income 0.00 0.00 25,500.00
Statement  inance Charge Income 0.00 0.00 0.00
that shows  Sales Retums and Allowances 0.00 0.00 0.00
all depart-  Sales Discounts (126.03) 0.15) (135.93)
MeNtS.  Total Revenues 8439009  100.00 277,018.92
|
Bellwether Garden Supply
General Income Statement
For the Three Months Ending March 31, 2007
Current Month Year to Date
Revenues
Sales $ 84,516.12 10015 § 251,654.85
Interest Income 0.00 0.00 0.00
Other Income 0.00 0.00 25,500.00
Finance Charge Income 0.00 0.00 0.00
Sales Returns and Allowances 0.00 0.00 0.00
Sales Discounts (126.03) (0.15) (135.93)
Total Revenues 84,390.09 100.00 277,018.92
| = . = - e e W
Figure 3-2: Cost of Sales
AnIncome  Product Cost 11,582.04 13.72 60,523.68
Statement  Direct Labor 1,750.00 2.07 3,062.50
Materials Cost 6,261.35 7.42 10,491.45
thatrollsup  gypcontractors 335.50 0.40 335.50
all depart- T ——
mental Total Cost of Sales ﬂ 23.62 __ﬂ
numbers.  Grogs Profit 6446120 7638 202,605.79
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|
Figure 3-3:
An Income
Statement
for a single
department.
|

Bellwether Garden Supply
Income Statement
For the Three Months Ending March 31, 2007

Current Month Year to Date

Revenues

Sales - Aviary b3 5,628.01 10000 § 50,153.16

Total Revenues 5,628.01 100.00 50,153.16
Cost of Sales

Product Cost - Aviary 1,479.30 26.28 20,222.95
Total Cost of Sales 1,479.30 26.28 20,222.95
Gross Profit 4,148.71 73.72 29,930.21
Expenses

Total Expenses 0.00 0.00 0.00

Net Income s 4,148.71 73.72 % 29,930.21

Setting up departmental account numbers

To produce these reports, Peachtree uses a concept called masking that
enables you, through the use of account numbers, to easily limit the infor-
mation that appears on reports. To use masking, you divide your account
number into segments; you assign the account number, say, 40000, to the first
segment and then assign a digit or two to the second segment of the number
to represent the department or location. That is, 40000-01 might be income
for Department 1, and 40000-02 could be income for Department 2. The impli-
cation here is that the first segment of the account (40000) would appear sev-
eral different times in your Chart of Accounts, but the second segment would
contain a different department number. And, you can set up a 00 level for the
account (that is, 40000-00) that Peachtree can use to display the sum of all
the departments and represent the company as a whole. You record sales
and purchases or payments by using the account number that represents the
department responsible for the sale, purchase, or payment. You would never
record a transaction in the 00 level account. Your expense accounts would
work the same way if you want to track costs separately for each department.

If your situation is more complex, and you want to track expenses for multi-
ple locations and for multiple departments at each location, your account
number should include both a location segment and a department segment.
To track sales for Location 1, Department 1, your Sales account number
might be 40000-01-01, where the first 01 tracks the Location and the second
01 tracks the Department. Table 3-2 shows the various possible combinations
for Sales accounts that you might find in your Chart of Accounts if you had
three locations and three departments:
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Table 3-2 Sample Combinations for Accounts Using
Locations and Departments

Account Description Account Number
Sales for Location 1, Department 1 40000-01-01

Sales for Location 2, Department 1 40000-02-01

Sales for Location 3, Department 1 40000-03-01

Sales for Location 1, Department 2 40000-01-02
Sales for Location 1, Department 3 40000-01-03
Sales for Location 2, Department 2 40000-02-02
Sales for Location 2, Department 3 40000-02-03
Sales for Location 3, Department 2 40000-03-02
Sales for Location 3, Department 3 40000-03-03

Be sure to allow the maximum number of characters that you need for your
departments and locations and keep future growth in mind. For example, if
you have ten or more departments, you need two digits for your department
number. Don’t forget to use a leading zero for department numbers less than
ten (for example, 01, 02, 03, and so on).

If you are using any version of Peachtree other than Peachtree Premium and
you want to use masking, do so when creating your chart of accounts by
simply setting up the appropriate account numbers. If you are using Peachtree
Premium, you can add masking to your existing chart of accounts. Follow these
steps to identify your account segment structure in Peachtree.

1.

Choose Maintain~>Default Information=>General Ledger.

Peachtree displays the General Ledger Defaults dialog box shown in
Figure 3-4.

2. Click the Account Segments tab.

. Click in the Segment Description text box and type a description of

the portion of the account number that you want to define.

. Click in the Length text box and type the value that represents the

number of digits you want to assign to this segment of the account
number.

. Click the Separator drop-down list arrow and select a character to sep-

arate portions of the account number.

6. Repeat Steps 3 through 5 for each segment that you want to define.
7. Click OK.
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|
Figure 3-4:
Set up the
account
segments
that you
want to use
in your chart
of accounts.
|

General Ledger Defaults
B oo | Aecoum SEIBeTE])
Account Segments
Segment Description Length Separator
1 ‘A:counl ,5_ ] j o
2 ‘Locatlon ,2_ | j Help
3] [ | =
al = [
- — [

Total dccount Length |8

Account Stucture o - K

[Total includes the sum of the lengths plus the segment separators.
M aximum account length is 15.]

If you're identifying segments for an existing Chart of Accounts, Peachtree
displays a message that tells you how many accounts you currently have that
don’t match the segment structure that you defined when you clicked OK.
Simply click OK when you see the message and edit your Chart of Accounts
to provide the new segment numbers as appropriate by using the information
in the next section. Remember, you don’t need to assign numbers for any seg-
ment other than the first segment of your account number — the other seg-
ments are optional. Many people use them only for Income and Expense
accounts.

Consolidating departmental figures

You can extend the department/location scenario from the previous section
one step further. Suppose that you find yourself in the situation where you
have two or three geographic locations that each need to use Peachtree —
and you’re not networked. You can set up separate companies in Peachtree,
but at the end of an accounting period, you won’t have a consolidated finan-
cial statement to show the true financial picture of your company. Or sup-
pose that your check writing volume exceeds 200 transactions per month. In
this case, Peachtree can begin to operate quite slowly; therefore, you might
want to consider breaking your company into multiple companies and then
consolidating to produce reports.

In Peachtree Premium, you can consolidate companies by creating a new
company that contains — or consolidates — companies that you select.

If you are not using Peachtree Premium, you can purchase the Consolidation
Wizard, an add-on product that allows you to use multiple companies in
Peachtree and consolidate the information in those companies into one
master company. For more information on the Consolidation Wizard and
other add-on products for Peachtree, see Bonus Chapter 4 on this book’s Web
site.
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If you segment the Chart of Accounts in each company in the same way
(whether you use Peachtree Premium’s consolidation feature or you use the
Consolidation Wizard add-on product), consolidating is quick and painless and
lets you produce departmental as well as company-wide financial statements.

Modifying the Chart of Accounts

|
Figure 3-5:
Use this
window

to make
changes to
the Chart of
Accounts.
|

Once you understand account types, numbering, and so on, you can dive in
and make additions, changes, or deletions to the Chart of Accounts. To make
any changes to the Chart of Accounts, use the Maintain Chart of Accounts
window, shown in Figure 3-5.

=@t

= Maintain Chart of Accounts

= o
EEQ ’g;'ve Delete ﬂe-w* %‘
P I

Description:

| Inactive

scoon pe: [Ch =]

Period Histomy Diebits Credits
Mar 31, 2007 =
Feh 28, 2007
Jan 31, 2007
Dec 31, 2008
Mow 30, 2006
Oct 31, 2006 -

Beginning Balances: D

Period Activity Running B alance |

Adding new accounts

To add an account, follow these steps:

1. Choose Maintain=>Chart of Accounts and, in the Maintain Chart of
Accounts window, type a number for the new account in the Account
ID text box.

Peachtree opens the account list and shows you the number of the
account that most closely matches the number you typed. Make sure
that you type a new number — one that doesn’t already exist.

2. In the Description text box, type a name for the account as you want it
to appear on reports.

3. Open the Account Type drop-down list box and select the correct
account type for the account that you're adding.

4. Click Save.
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|
Figure 3-6:
Change an
account
number in
this box.
|
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If you create an account number that doesn’t match the segmenting scheme,
you see a message. You can click OK and create the account despite the
message.

Editing accounts

You can edit the Account ID, description, and account type of an account by
following these steps:

1. Choose Maintain~>Chart of Accounts to display the Maintain Chart of
Accounts window (refer to Figure 3-5).

2. Click the lookup list indicator to the right of the Account ID text box
or type some characters of the Account ID to display the account list.

3. Highlight the account and click OK or press Enter.

4. Retype the description or change the account type.

5. To change the Account ID, click the ChangelD button on the toolbar.
Peachtree displays the Change Account ID dialog box shown in Figure 3-6.

Change Account ID
(]S
Current Account [D:
C |
Enter New Account 1D: [10300-00 ﬂj
Help

6. Type a new Account ID and click OK.
7. Click Save.

Deleting accounts

You can delete accounts that have no activity — that is, you haven’t used
them in any transactions. Choose Maintain=>Chart of Accounts to display the
Maintain Chart of Accounts window. Select the account; then click the Delete
button.

If you try to delete an account that you've used in transactions, Peachtree
tells you that it can’t delete the account. You can, however, set the status of
the account to Inactive. If you choose to hide inactive accounts, they don’t
appear in the list of any transaction window. In addition, hidden accounts
don’t appear on any report except the Chart of Accounts report. Only people
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who know the account’s number are able to use it. To make an account inac-
tive, display it in the Maintain Chart of Accounts window, select the Inactive
check box, and click the Save button.

When you make an account inactive, you make it eligible for deletion when
you purge. See Chapter 17 for information on purging.

Identifying the rounding account

Peachtree can round numbers on financial statements to either whole dollars
or whole thousands of dollars. So, occasionally, when you prepare financial
statements, Peachtree needs round numbers. Also, Peachtree needs a place
to store the difference caused by rounding. Although the account can be any
account, Peachtree recommends that you use the Retained Earnings account.

To make sure that Peachtree uses the Retained Earnings account for round-
ing, follow these steps:

1. Choose Maintain->Default Information=>General Ledger.

Peachtree displays the General Ledger Defaults dialog box (refer to
Figure 3-4).

2. Click the Rounding Account tab.

3. Confirm that Peachtree has selected the single account that you’'ve
designated as Equity-Retained Earnings.

If necessary, click the magnifying glass next to the account number to
display the list. In the unlikely event that Peachtree chooses the wrong
account, change it.

4. Click OK.

Opening balances

The odds are good . . . very good . . . excellent, in fact, that you've been in
business for some time now and that you’re starting to use Peachtree after
you’ve done some business. In cases like these, you need to enter beginning
balances into Peachtree to represent the business that you conducted before
setting up your Peachtree company.

Timing the start of using Peachtree

And now is a good time to talk about timing. How do you know when you
should go live with Peachtree? Well, ideally, try to start using a new accounting
package on the first day of your accounting year — January 1, if your business
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operates on a calendar year; otherwise, the first day of your fiscal year. If you
can’t wait that long, then start using Peachtree on the first day of a quarter.
And if you can’t start using Peachtree on the first day of a quarter, then start on
the first day of a month.

Why these target dates? Well, you have the least amount of setup work to do.
For example, if your business operates on a calendar year and you start using
Peachtree on January 1, you don’t need to enter any beginning balances for
payroll or any of your income or expense accounts because the balances of
these accounts start at zero on January 1. If you start at the beginning of a
quarter, and you’re willing to forego monthly reports preceding that quarter,
you can enter summarized information for preceding quarters. And, if you
start on the first day of a month, you don’t need to play catch-up for the
month — which you’d need to do if you’d started mid-month.

Where do you get the numbers?

If you've used some other accounting package, you can print an Income
Statement, Balance Sheet, and a Trial Balance as of the last month that you
intend to use that accounting package. You can use a combination of the
Balance Sheet and the Income Statement, or you can use the Trial Balance:
The numbers on these reports in your old software represent the beginning
balance numbers of your new Peachtree company.

If you've never used any other accounting package, contact your accountant.
Provide the date that you want to start your company and ask for a Trial
Balance, a Balance Sheet, and an Income Statement as of that date. Your
accountant probably can’t provide the information instantly, especially if you
want to start on January 1, and you ask for the information in December of the
prior year. Your accountant needs to prepare these reports after December 31
so that the reports include all your prior year transactions.

But don’t worry; you can start working in Peachtree without beginning bal-
ance numbers; in fact, you might as well start working in Peachtree without
beginning balance numbers. You just need to remember that year-to-date
reports aren’t accurate because they don’t show the entire picture until you
enter beginning balances.

Entering beginning balances

After you get the numbers, entering them into Peachtree isn’t difficult. If
you're going to start using Peachtree at any time other than the beginning of
your business year, we suggest you use the alternative method described in
the next section. If you're going to start using Peachtree at the beginning of
your business year (calendar or fiscal), we suggest that you use Peachtree’s
Chart of Accounts Beginning Balances or Prior Year Adjustments window to
enter beginning balances. Follow these steps:
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1. Choose Maintain=>Chart of Accounts to display the Maintain Chart of
Accounts window (refer back to Figure 3-5).

2. Click the Beginning Balances button to display the Select Period

dialog box.
3. Select the period from the list.
“\gN\BEI? Until you have entered transactions, you can enter beginning balances in
& Peachtree by month for the year preceding your first open year, for your
first open year, or for your second open year. If Period 1 for the company
is January 2007, Peachtree makes available each month in 2006, 2007,
and 2008; all balances prior to January 1, 2006, would be lumped
together into Before 1/1/06.
4. Click OK to display the Chart of Accounts Prior Year Adjustments
window (see Figure 3-7).
Chart of Accounts Prior Year Adjustments
— cza @
gﬁe\ g s % Heip
Fi ure 3'7: Prior Year Adjustments as of Before January 1, 2008
)
Use thIS Liahilitie:s,
3 Account ID Account Description Acocount Type Azsets, Expenzes Equity. Income
wi nd ow tO 15400-00 Leasehald Improvements Fixed Assets :J
enter 15500-00 Buildings Fized Assets 185,500.00 J
15600-00 Building Improvements Fixed Aszets 2E,500.00
account 1E300-00 Land Fized Assets
balances 17000-00 Accumn. Deprecistion-Fumniture Accumulated Depreci. 53418.21
g enerated 17100-00 Accum. Deprecistion-Equipme Accumulated Depreci. 3.67292
17200-00 Accum. DeprecistionYehicles| Accumulated Depreci. 4727153 v!
before you The Trial Balance is made up of the balances of all Total 506.705.76 506 705 78
Sta rted accounts. Inorder for the Trial Balance to be in balance, e e &
the sum of Assets and Expenses should equal the sum of Trial Ea"a’"PE' 0.00
u sing Liabilties. Equity. and Incame. Difference posts to Bea Bal Equity)
Met Income iz the difference of Income and Expenze Income - Expenses: 0.00 0.00
account values. 2 INcome an( ¥PENZE values
Peachtree. hies. The | dE i
making up Net Income are already included in the total Met Income: 0.00
|

5. Using the numbers that you’ve gotten either from your old accounting
system’s Trial Balance or from your accountant, enter the balances for
each account.

If you have an unusual balance in an account (for example, your cash
balance is a negative instead of a positive balance), enter a negative
number for the account balance.

When you finish, the Net Income number at the bottom of the window
should represent your Net Income for the period. Look for the Net
Income at the bottom of your Income Statement.

6. Click OK to store your beginning balances.

You can find out more about posting transactions in Chapter 5 — and also in
Chapters 6 through 9.
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If you're out of balance . . .

You know that you're out of balance if the Trial
Balance number in Figure 3-7 is not zero. In this
case, Peachtree wants to post the difference to
an Equity—doesn't close account called Beg.
Bal. Equity. This account doesn't appear in the
Beginning Balances window, but it does appear
on financial statements, General Ledger reports,
and in the Chart of Accounts list. The chances
are good that you're out of balance due to a
typing mistake; double-check the numbers that
you've entered and make sure you've entered
allthe numbers.

If you still can't find the mistake, you can click
through Peachtree’s warning and let it create
the Beg. Bal. Equity account. Your company is

then in balance, and you can safely proceed to
enter transactions. If you have to use this
workaround, you need to live with the Beg. Bal.
Equity account until you find the source of the
problem. You can then correct it by clicking the
Beginning Balances button in the Maintain
Chart of Accounts window. Peachtree displays
the Beginning Balances window if you haven't
posted any transactions. If you have posted
transactions, Peachtree displays the Prior
Period Adjustment window, which looks and
operates just like the Beginning Balances
window. When the Beg. Bal. Equity account has
a zero balance, you can delete the account.

An alternative method for entering beginning balances

If you start using Peachtree at any time other than the beginning of the busi-
ness year, we suggest that you enter one (or more) journal entries to repre-
sent your beginning balances rather than using Peachtree’s Chart of Accounts
Beginning Balances or Chart of Accounts Prior Year Adjustments window. We
find that using journal entries for midyear starts seems to be less confusing.
You'’d enter the journal entries to provide balances as of the first day of the

first open month.

Because we're trying to avoid using the d word and the ¢ word this early in
the book (debits and credits), we save the discussion of journal entries for

Chapter 17.

The B word — Budgeting

Nobody likes to live on a budget, but for most of us, budgets are a sad fact of
life. In the business world, budgets can help you compare how your business
is actually doing to how you thought it would do.

You can create budgets for each account in Peachtree; you can then print
Budget vs. Actual reports to see how well you're doing. Although we’d love to
walk you through the details on budgeting, space is limited. We know you’re a
pretty smart reader, so, here’s a synopsis.
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In Peachtree Premium, choose Maintain=>Budgets. In the Maintain Budgets
window that appears, select an Account ID for which you want to establish
budget numbers. Then fill in budget amounts for each month in the available
fiscal years. You can use the Adjust\Copy button to copy amounts from the
first month to all other months — and save yourself some typing — or to
copy amounts from one fiscal year to another. Click Save, select the next
account, and repeat the process.

If you're using any other edition of Peachtree, you open the Maintain Budgets
window by choosing Maintainm>Chart of Accounts. In the Maintain Chart of
Accounts window, click the Budgets tab. You can create budgets for three
years instead of two.

Visit this book’s Web site for more information on Peachtree.
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Before you dive into the day-to-day stuff of managing your company’s
books, you need to set up preferences. Doing so will save you time
when performing daily tasks because Peachtree uses the default information
as a model whenever you create vendors, customers, employees, and inven-
tory items, produce statements, and enter transactions (purchase orders,
purchases, invoices, payroll checks, and so on). You can alter this global
information when a particular person or item requires something other than
the default.

Terminology alert: Peachtree switches back and forth between two terms
when referring to bills that vendors send you: a purchase and an invoice. For
the sake of clarity, we call vendor bills a purchase; invoices are the things
you send to customers so that you can get paid.

Setting Purchasing Preferences

“What kind of information do you supply for vendors?” you ask. Well, you set
up standard terms. Terms describe how long the vendor gives you to hold a bill
before you need to pay it and how you want Peachtree to respond if vendors
offer you a discount for paying early. You also identify the default account to
assign to most vendor bills and vendor discounts. And you specify how you
want Peachtree to age bills that you enter. Last, you can set up custom fields
for vendors to track information you specify about the people from whom you
buy goods or services.
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|
Figure 4-1:
Use the
Vendor
Defaults
dialog box
to define
typical
settings for
vendors.
|

Aging is the concept of holding onto a bill for a specified period of time
before you apply payment terms to it.

Peachtree applies these preferences to all vendors you create and all pur-
chases you enter. If a vendor or a transaction is unusual in some way, you
make a change to the specific vendor or transaction. Using standardized
information in this way saves you time because you need to change the stan-
dard information only for exceptions to the rule. And let’s face it — we all like
to save time. See Chapter 5 for information on setting up vendors.

Establishing default payment
terms and accounts

Efficient bill paying is an art. You don’t want to pay your bills too early or too
late. For example, if your bank account earns interest, you don’t want to pay
a vendor’s bill too soon, because you lose interest from the bank. On the
other hand, if your vendor assesses late fees or finance charges for bills that
you don’t pay on time, you don’t want to pay a bill too late.

Using Peachtree’s Vendor Defaults dialog box, you can establish a typical set
of terms to use for most vendors. In Chapter 5, you can find out how to create
vendors and how Peachtree automatically assigns these default terms to
each vendor. You need to change terms only for those vendors who don’t use
the typical terms.

To set default payment terms and accounts that most vendors use, follow
these steps:

1. Choose Maintain=>Default Information=>Vendors to display the dialog
box shown in Figure 4-1.

Vendor Defaults

Payment Terms ] Lccount Aging T Custom Fields I 1099 Settings I

Standard Teims Sets Default Terms for Purchases, Default for Credit Limit
 cop. Netduein  [30 daps C_ :
" Prepaid 3 . =ance

Discount in o days
o s Ll
~ ot Discount % 200
" Due at end of manth Credit Limit: 5.000.00

Sets Default Accounts for new Vendor Records, the
GL Link Accounts Purchage Account can alzo be changed in each Vendor Record

Purchase Account | 75500-00 Supplies Expense

Discount GL Account |33500-00 Purchase Disc- Expense [tems
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2. From among the Standard Terms option buttons, choose the option
that best describes the terms most of your vendors offer you.

The terms shown in Figure 4-1 are 2% 10 Net 30, which means you can
discount the bill by 2 percent if you pay it within 10 days; otherwise, the
entire amount of the bill is due in 30 days.

3. Fill in the appropriate boxes to the right of the terms you select in
Step 2.

As you select an option button on the left, the boxes on the right
change. For example, if you choose C.0.D. (cash on delivery) or Prepaid,
only the Credit Limit box on the right remains available, because none of
the other boxes apply.

4. At the bottom of the Payment Terms tab, click the magnifying glass to
select the account that you use most often when you post purchases
from vendors.

If you don’t select an account, Peachtree will prompt you for an account
each time you create a new vendor.

5. In the Discount GL Account text box, select the account to which you
want Peachtree to post discounts that vendors give you for paying in
the specified time.

To select the account, type its account number or click the Lookup list
indicator (the magnifying glass) to the right of the account number to
display a list. In the list, highlight the account number and click OK.

6. Click OK to close the dialog box or leave it open to review additional
defaults in the sections that follow.

Keep two points in mind: First, you may never receive discounts from your
vendors, but Peachtree expects you to set up the account anyhow. Second,
you may want to increase the credit limit. If you exceed the credit limit when
buying from a vendor, you can still buy from the vendor, but you see an
annoying message telling you that you've exceeded the credit limit.

Aging vendor bills

When you age a bill, you hold onto it for a specified period of time before you
pay it. You can age purchases (that is, you can tell Peachtree to count the
number of days you hold the bill) from either the billing date or the due date.

To set account aging defaults, choose Maintain>Default Information=>
Vendors. On the Account Aging tab, select a method to age bills: Invoice Date
or Due Date. Optionally, you can change the number of days in each of the
four columns on the Aged Payables report.

49



50 Part I: Getting Started

|
Figure 4-2:
An Aging
report
showing
bills aged by
due date.

|
Figure 4-3:
An Aging
report
showing
bills aged by
invoice date.

You may find the difference between the two aging methods easier to under-
stand if you take a look at two Aged Payables reports, each prepared using
one of the aging methods. In Figure 4-2, we set the Aging option to Due Date
and then prepared a customized Accounts Payable Aging report for only one
vendor, Akerson Wholesale Nursery, as of March 31, 2007. In Figure 4-3, we
switched the Aging Option to Invoice Date and printed the same report for
the same vendor and time frame. (Note that invoice here refers to bills your
vendors send you.)

l#= Aged Payables D]
E= KB -2 2 = oy wiw Sy FEH .
$§ Save  Optiors  Hide Einn Sgn E%I Fré?é-lw i e % ﬁp
Bellwether Garden Supply )

Aged Payables
As of Mar 31, 2007

Fiter Criteria includes: 1) Ds from AKERSON to AKERSON. Report order is by ID. Report is printed in Detail Format

Vendor ID Invoice/CH # 0-30 31.60 61-90 Over90days AmountDue Date Date Due
Vendor
Contact
Telephone 1
AKERSON AT 1,586.25 ]
1 1,750.00
596250
5179.20
AKERSOM 11,141.70 3,436.25 14,577.95
Akerson Wholesale Nur
Report Total 11,141.70 3,436.25 14,577.95
v
< [>
15 Aged Payables &[]

o
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Bellwether Garden Supply fall

Aged Payables

As of Mar 31, 2007
Fiter Criteria includes: 1 Ds from AKERSON to AKERSON. Report order is by ID. Report is printsd in Detai Format,

Venclor ID Invoice/CM# 0-30 31-60 61-90 Over90days AmountDue Date Date Due
Vendor
Contact
Telephone 1
AKERSON ABA1T 1.686.25 ]
1,750.00
5.962.50
678-555-1279 4 5172.20
AKERSON 5179.20 596250 3436.25 14,577.95
Akerson Wholesale Nur
Report Total 5170.20 5,062.50 3436.25 14,577.95

Both reports show four outstanding bills for Akerson Wholesale Nursery.
Each bill, along with its date and due date, is listed on a separate line.
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Notice the third bill — the one for $5,962.50. It was posted as of February 1,
2007, with terms of Net 30; the bill is due 30 days from the bill date of February
1 — on March 3. On the first report, the bill appears to be somewhere between
0 and 30 days old, while on the second report, it appears to be somewhere
between 31 and 60 days old. In actuality, according to the first report, on March
31, 2007, the bill is somewhere between 0 and 30 days past the due date of the
bill. According to the second report, on March 31, 2007, the bill is somewhere
between 31 and 60 days past the invoice date of the bill.

This report is not showing you what is past due; it is showing you the bill’s
age based on the number of days past either the due date or the invoice date.

Many people choose to age vendor bills by Due Date because the bills look
“less overdue” on the aging report.

Creating custom fields for vendors

Custom fields are a great way to store information about your vendors that
doesn’t fit elsewhere in Peachtree, such as details specific to your business
or industry. For example, many businesses track a workers compensation
certificate number for subcontractors to justify not covering the subcontrac-
tor on the company’s workers compensation insurance. On the Custom Fields
tab of the Vendor Defaults dialog box, you can create up to five fields for each
vendor. Check a box and, in the Field Labels boxes, type identifying labels for
the information you want to store.

When you set up vendors, you can fill in this information for each vendor.
(See Chapter 5 for more information on creating or editing vendor informa-
tion.) On some reports in Peachtree, you can print this information.

1099 Settings

On the 1099 Settings tab, you can, if necessary, change the way that Peachtree
calculates 1099 payments. For each account on the Chart of Accounts, you
can identify whether and how Peachtree should calculate 1099 income. By
default, Peachtree assumes that you will establish the correct 1099 type for
each vendor when you create the vendor, so each account is set up to look

at the vendor’s record. You can, however, specify that a particular account
should be used to calculate 1099 miscellaneous income, 1099 interest income,
or you can specify that the account should not be used when calculating 1099
income. In most cases, you don’t need to change the default settings.
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“What kind of information do you supply for customers?” you ask. Well, you
set up standard terms for customers like you do for vendors. Only this time,
you're the one establishing when payment is due and whether you offer cus-
tomers a discount for paying early. Customer terms also tell Peachtree how
to respond if customers pay early. You also identify the default sales account
and discount account where you want Peachtree to assign most customer
invoices. You specify how you want Peachtree to age invoices that you pre-
pare. As with vendors, you can set up custom fields for customers to track
specific information that may help you increase sales or offer perks. You also
can decide whether to charge your customers finance charges for overdue
invoices, and you can set their Pay Methods — cash, check, credit card, or
anything green.

The concept of aging applies also to invoices you send to your customers. In
this instance, aging refers to the specified period of time you allow before
you pay an invoice — and potentially charge the customer finance charges
for late payment.

As with vendors, Peachtree applies these preferences to all customers you
create and all invoices you enter. If a customer or a transaction is unusual in
some way, you can make a change to the specific customer or transaction.

Establishing default payment
terms and accounts

When customers don’t pay you in a timely fashion, you may experience
cash flow problems. That is, you have money going out of your business
for expenses but not enough money coming in to cover those expenses.

To encourage your customers to pay on time, you establish payment terms
similar to the ones your vendors set for you.

Using Peachtree’s Customer Defaults dialog box, you can establish a typical
set of terms to use for most customers. In Chapter 7, when you create cus-
tomers, you'll see that Peachtree automatically assigns these default terms to
each customer. Change preferences for only those customers who don’t use
the typical terms.

To set default payment terms and accounts for most customers, follow these
steps:

1. Choose Maintain~>Default Information=>Customers to display the
Customer Defaults dialog box (see Figure 4-4).



|
Figure 4-4:
Use the
Customer
Defaults
dialog box
to define
typical
settings for
customers.
|
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Customer Defaults
:'_il_?’[;_l‘l’_s’_é’[l’_&_r[.:_;é_l‘i_ii_ri Account Aging I Custom Fields T Finance Charges T Pay Methods
Standard Terms Sets Defaulk Terms, Credit Limit. and Credit Status
" COD. Netduein [30 days c |
" Prepaid : ancel ]
Discount in (10 days
{* Due in number of days Help
" Dus o dey of next manih Discount Percent: [2.00
¢ Due at end of month Credit Limit: {50,000,00

Credit Status: |Motify Over Limit

GL Link &ceounts Sales Account can also be changed in each Customer Record

Sets Default Accounts for new Customer Fecords. the:

Dizcount GL Account |49000-00 Sales Discounts

6L Sales Account [40000-00 Sales

2. From among the Standard Terms option buttons, choose the option

that best describes the terms you offer most of your customers.

The terms shown in Figure 4-4 are 2% 10 Net EOM, which means your
customers can discount the invoice by 2 percent if they pay it within 10
days; otherwise, the entire amount of the invoice is due at the end of the
month. (EOM stands for end of month.)

3. Fill in the appropriate boxes to the right of the terms you selected in

Step 2.

The options for customer terms work like the options for vendor terms.
As you select an option button on the left, the boxes on the right
change. For example, if you choose C.0.D. or Prepaid, only the Credit
Limit box on the right remains available because none of the other
boxes apply.

You can use the Credit Status list to control Peachtree’s behavior in rela-
tion to the customer’s credit limit when you enter an invoice. The list con-
tains five choices. On one end of the spectrum, you can record invoices
without seeing any messages, regardless of the relationship between the
customer’s balance and credit limit. On the other end of the spectrum,
Peachtree will not allow you to enter an invoice for a customer regardless
of the relationship between the customer’s balance and credit limit. In
between these choices, you can have Peachtree display a warning or an
error message when a transaction will cause a customer’s balance to
exceed the credit limit. And you can have Peachtree display a warning
whenever you record a transaction for a customer who owes you money
even if the customer’s balance doesn’t exceed his or her credit limit.

4. Select the GL Sales Account that you use most often when you sell

goods or services to customers.
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To select the account, type the account number or click the Lookup list
identifier (the magnifying glass) to the right of the account number to
display and select from a lookup list. If you don’t select an account,
Peachtree will prompt you for an account each time you create a new
customer.

5. Select the Discount GL Account you use to track discounts taken by
customers.

6. When you’ve finished setting payment preferences, click OK to save
those preferences.

Even if you never offer discounts to your customers, Peachtree expects you
to set up the account anyhow. (If you haven’t set up a discount general ledger
account, see Chapter 3 for information on creating accounts.)

Aging customer invoices

We talk about aging a lot in our society, and now you're getting a whole new
picture of wrinkled bills and invoices. Just as you can control the aging process
for vendor bills, you can age customer invoices from either the invoice date or
the due date.

Accounts receivable aging works the same as accounts payable aging — that
is, you can choose to age by due date or by invoice date. Suppose that you
post an invoice as of February 20, 2007, with terms of 2% 10, Net 30 Days.

If you set up accounts receivable aging to age by due date, the invoice is due 30
days from the invoice date of February 20, which is March 22. On the Accounts
Receivable Aging report, the invoice appears to be somewhere between 0 and
30 days old — that is, on March 31, 2007, the invoice is somewhere between 0
and 30 days past the due date of the invoice.

Alternatively, if you set up accounts receivable aging to age by invoice date,
the same invoice appears on the Accounts Receivable Aging report to be some-
where between 31 and 60 days old. That is, on March 31, 2007, the invoice is
somewhere between 31 and 60 days past the invoice date of the invoice.

This report is not showing you what is past due; it is showing you the age of
invoices based on the number of days past either the due date or the invoice
date.

Many people choose to age customer invoices by invoice date because the
aging report then reflects how old the invoice is. Others prefer to age invoices
by due date so that they can see how many days the invoice is overdue.
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Creating custom fields for customers

In the Custom Fields tab of the Customer Defaults dialog box, you can enter
labels for up to five fields for each customer. Use these fields to store extra
information about customers, such as noting new customers who found your
business on the Web. Simply place a check in any Enabled box, and type the
descriptive text in the Field Labels box. When you set up customers, you can
fill in this information for each customer. On some reports in Peachtree, you
can print this information.

Suppose that you've established a label and filled in information for cus-
tomers. If you reopen the Customer Defaults dialog box and change the labels,
you won't affect the information you stored for each customer; you must edit
each customer’s record and make a change to match the new label you've
established. If you simply don’t want to show the information you’ve already
entered, you can hide the stored information by removing the check mark
from the Enabled check box in the Customer Defaults dialog box. However, the
information reappears if you enable the custom field once again.

Setting up finance charges

Finance charges are fees you charge customers who pay late. Many busi-
nesses don’t charge finance charges; others believe that finance charges
encourage customers to pay on time and therefore improve cash flow. Still
others believe that charging these fees is necessary if customers continu-
ously ignore payment terms.

If you want to be able to charge finance charges, follow these steps:
1. Choose Maintain=>Default Information=>Customers and click the
Finance Charges tab of the Customer Defaults box.

2. Place a check mark in the Charge Finance Charges box.

3. Complete the remaining information to tell Peachtree how to calcu-
late finance charges.

Peachtree charges an interest rate that you specify on invoices that are
overdue by the number of days you specify. You can charge a higher rate
on balances that exceed an amount you specify, specify a minimum
finance charge amount.

4. Optionally, check the Charge Interest On Finance Charges box.

5. Use the Lookup list indicator to select a G/L account for finance
charges.
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6. From the Appears On Invoices and Statements As list box, select the
description for the finance charge (either Late Charge or Finance
Charge).

7. Optionally, provide a warning message that Peachtree can print on
invoices.

8. Click OK.
This information becomes part of your standard terms.

Placing a check mark in the Charge Interest on Finance Charges check box
tells Peachtree to calculate interest on any unpaid balance as well as unpaid
finance charges. Check with your accountant before you check this box; in
some states, it is illegal to charge interest on interest. Also, enabling finance
charges does not make Peachtree automatically assess finance charges. And
you don’t need to assign finance charges to all of your customers. See
Chapter 8 for information on assessing finance charges.

The Finance Charge Warning message at the bottom of the Finance Charges

tab is printed on the bottom of invoices you send to customers. If you're not
charging finance charges, you may want to change the message to something
like “Happy Holidays” or “See our exhibit at the Business Expo March 16-19.”

Establishing payment methods

Pay methods are exactly what they sound like — the various methods of pay-
ment that your company accepts. You establish these default settings on the
Pay Methods tab of the Customer Defaults dialog box. Choose Maintain=
Default Information=>Customers and click the Pay Methods tab. Then, in the
boxes provided, type the names of the payment methods your company
accepts.

These payment methods are available when you record payments you receive
from customers. You can include the Payment Method field on reports. For
example, you can add this field to the Cash Receipts journal and filter the jour-
nal to see only transactions of a particular pay method.

Adding a new payment method after you've already recorded transactions in
Peachtree doesn’t affect previously recorded transactions. The new payment
method is simply available for new transactions.

On the Pay Methods tab, you also can tell Peachtree to automatically assign
Deposit Ticket IDs in either the Receipts window or in the Select for Deposit
window. Deposit Ticket IDs help you group payments you receive from cus-
tomers. To help you reconcile your bank statement, you typically use the
same Deposit Ticket ID for all customer payments that you plan to deposit in
the bank at the same time. See Chapter 8 for more information on recording
receipts and using Deposit Ticket IDs.
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To correctly set up and use payroll in Peachtree, you need to identify some
basic information, such as the state where your company operates. But under-
standing payroll is difficult even when you aren’t worried about setting up pay-
roll in an accounting program. On the “good news” front, Peachtree uses a
wizard to walk you through establishing the defaults for preparing payroll
checks and tax-related forms (W-2s, Federal Form 940, and Federal Form 941).
Peachtree doesn’t prepare most state tax forms, but Chapter 9 shows you how
to use Peachtree payroll reports to find the information you need to complete
the forms.

Using the Payroll Setup Wizard

The Payroll Setup Wizard helps you set up basic information about payroll,
including payroll fields that Peachtree then uses to calculate payroll checks.
Payroll fields are things such as gross wages and federal income tax (FIT) —
one of those many mysterious abbreviations that appear on your payroll
check stub. Chapter 19 describes how to set up a payroll field for some
common payroll deductions (or additions — for those lucky enough to get a
bonus) that you want to include on a paycheck.

Peachtree Software Company does not ship tax tables that calculate federal
taxes with the software. To subscribe to Peachtree’s Payroll Tax Table Update
service, call 1-800-336-1420 Monday through Friday, 8:30 a.m. to 5:30 p.m. east-
ern standard time. You can use the Payroll Setup Wizard to help you set up pay-
roll when you first create a company or later, after you've been using Peachtree
for awhile. No problem — take your choice. In the paragraphs that follow, we
show you how to use the wizard to set up basic payroll information.

The Payroll Setup Wizard also can be useful after you’ve set up payroll. For
example, suppose that your company didn’t have a 401(k) plan when you orig-
inally set up payroll but later decided to add one. The Payroll Setup Wizard
makes implementing this change easy. Similarly, you can set up payroll and
then decide to track vacation and sick leave. See Chapter 19 for information
on setting up a 401(k) plan and tracking both vacation and sick leave.

To start the Payroll Setup Wizard, follow these steps:

1. Choose Maintain=>Default Information=>Payroll Setup Wizard.

The first screen of the Payroll Setup Wizard lists the options you’re
going to set: general ledger accounts, standard payroll fields (taxes and
so on), and optional payroll fields.
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2. Click Next.

You see the version number of the current global tax table installed on
your computer. Peachtree uses tax tables to make calculations related

to payroll. The most obvious tax tables calculate the amount of tax to
deduct for FIT, FICA, Medicare, and Federal Unemployment Taxes (FUTA).

To determine whether your tax tables are up-to-date, visit Peachtree’s
Web site at www.peachtree.com. Click the link for Tax Service, select
the Peachtree product you're using, and then click the View Tax Update
Version History link. Look through this Web page and compare your tax
table version to the latest available.

. Click Next.

A screen appears for specifying the primary state to receive your payroll
taxes, the applicable percentage in the Unemployment Percent for Your
Company, and whether you want to record meals and tips for employees.

When you enter rates into Peachtree, you must express them as percent-
ages, but many state forms express rates in decimals. For example, sup-
pose the state form shows that your unemployment rate is 0.008. That’s
a decimal. To express it as a percentage (0.8%), you’d type 0.8 into
Peachtree. Yeah, entering these numbers requires that high school math
stuff, where you have to divide a decimal by 100 to get the percentage
equivalent. Yeah, yeah, yeah. . ..

Depending on the state you select, Peachtree may ask you for a Locality
and Locality Rate.

If you choose to record meals and tips, Peachtree tracks the amounts for
reporting and tax calculation, but it won’t post any entries to the general
ledger. For more information on recording meals and tips, refer to IRS
Publication 15, Circular E, Employer’s Tax Guide. You can download a
copy of Circular E at the Web site of the IRS:

www.irs.gov/formspubs/index.html

See Chapter 21 to find out about more stuff you can find on the Web.

. Click Next to select general ledger accounts to use for payroll (see

Figure 4-5).

If you based the Chart Of Accounts on one of the standard companies
when you created your company, Peachtree suggests payroll accounts.

If you don’t have payroll accounts set up, you can define them on the fly.
Click the lookup list button next to each account box to display a list of
existing accounts. Click the New button to create new accounts while
still using the Payroll Setup Wizard. Refer to Chapter 3 for information
on setting up accounts.



Chapter 4: Setting Up the Background Information

A\

|
Figure 4-5:
Identify your
payroll
accounts.
|

A\\J

Some people create separate payroll liability accounts for each payroll
tax liability. To make your life easier using Peachtree, we recommend
that you create payroll liability accounts that correspond to the taxing
authority you pay. For example, you pay FIT, FICA, and Medicare to the
same taxing authority, so set up only one payroll liability account for all
three taxes. If you pay state and local taxes to the same taxing authority,
set up only one liability account for both taxes. Check with your accoun-
tant if you are unsure. We recommend this approach because it makes
writing your payroll tax liability checks easier.

5. Click Next four times to skip setting up the optional payroll fields and
see the payroll fields you created.

At this point, you've finished the basic setup for payroll; the remaining
choices in the Payroll Setup Wizard enable you to set up payroll fields
for a 401(k) Plan, vacation tracking, and sick leave tracking.

6. Click Finish.

Payroll Setup Wizard

Payroll Setin Default Payroll G/L Accounts

Tax Table Version Enter the default General Ledger accounts that will be used when
getting up basic payrall figlds.
Initid Payroll Setup

Payroll L Accounts Gross Pay Acct |77500

‘Wages

401(K} Set =
L Setun Tax Liability &cct: |23000

Yacation Tracking Federal Payrall T axes Payable

Sick Time Tracking Tax Expense Acct |72000

Payroll Tax Expense

Payroll Setup Complete

Help I Cancel << Back Mext >

Establishing general employee defaults

Once you run the Payroll Setup Wizard, you can change the payroll

settings from the Employee Defaults dialog box (choose Maintain=>Default
Information=>Employees). You can use the General tab to change your state
or set a locality if necessary and to establish custom fields for storing miscel-
laneous information about each employee. To make a custom field available,
place a check mark in the Enabled box next to the field.

Peachtree automatically assigns payroll fields to the various boxes on the
W-2 form, employee-paid taxes, or employer-paid taxes. You can, however,
edit the assignments by clicking the appropriate button in the Assign Payroll
Fields For section.
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Setting pay levels

Pay levels are names you set for various types of hourly and salary pay. Choose
Maintain=>Default Information=>Employees and click the Pay Levels tab. By
default, Peachtree automatically establishes the pay levels that appear on the
tab. Hourly wage pay levels appear on the left, and salary pay levels appear on
the right.

You can create up to 20 hourly pay levels and 20 salary pay levels, and you
can assign different pay levels to different general ledger accounts. Just type
the name for the pay level in the Field Name list and assign the pay level to a
G/L account.

You can override these defaults as necessary when you set up your employ-
ees. For example, suppose that you need to keep track of wages by depart-
ment. You can set the default G/L account to the department with the largest
number of employees and then, on individual employee records, change it to
the appropriate department G/L account as necessary.

To make your general ledger and income statement more meaningful, your
accountant may want you to use a different set of pay levels, pointing some
or all to different general ledger accounts. For example, you can use pay
levels based on your worker’s compensation categories as one method of let-
ting Peachtree help you determine your worker’s compensation liability.

Employee fields and employer fields

Peachtree categorizes the payroll fields created by the Payroll Setup Wizard
into employee-related fields or employer-related fields. On the EmployEE
Fields tab (see Figure 4-6), you see payroll fields belonging to employees.
These include gross wages, FIT, and the employee’s share of FICA and
Medicare. On the EmployER Fields tab, you can view payroll fields paid by
the company, including FUTA, state unemployment taxes, and the employer’s
share of FICA and Medicare. You can see the general ledger account and pay-
roll tax table Peachtree associated with each of the fields.

On the EmployEE Fields tab, you can do the following:

v Change the G/L account for a payroll field.

v Change the tax table Peachtree uses to calculate a particular payroll
field. Click in the Tax Name column to display a Lookup list indicator
that enables you to choose from a list of available tax tables.

v Place a check in the Memo column next to a field, such as Tips, to tell
Peachtree to calculate that field without updating your general ledger or
including the amounts in employees’ pay; note that Peachtree can use
fields marked as memos to calculate taxes.



Chapter 4: Setting Up the Background Information

v Place a check in the Run column next to a field to tell Peachtree not to
set the balance for this field to zero at the end of the payroll year. For
example, if you allow your employees to retain unused vacation from
year to year, set up your Vacation field with a check in the Run box.

v For fields Peachtree calculates, you can click the Adjust button to iden-
tify the fields you want Peachtree to add when calculating Adjusted Gross
Wages for the field. For example, you may want Adjusted Gross Wages to
include gross wages, FICA, and Medicare, but not FIT when calculating an
auto expense deduction.

v For fields Peachtree doesn’t calculate using a tax table, you can supply
a default amount. For example, if most employees pay the same amount
for medical insurance, you can type that amount in the Amount column,
and on the individual employee’s records, supply the appropriate
amount for employees who don’t pay the standard amount.

\\J
If you're entering an amount you want deducted, enter it as a negative
amount.
Employee Defaults
General ] Pay Levels -"Ti EmployER Fields I
Field Mame | G/L Account | Cale Tax Name Amount  Memo| Fun fidjust | 0K |
— Gross 77500 [ =] =1 i‘
i Fed_Income 23400 L& | AT |l g m
Figure 4-6: Soc_Sec | 23400 G2 | FIchEE =] =1 _ ek |
On the Medicare | 23400 L# | MEDICARE [
EmplovEE State 23400 G | =sIT [ o
mploy = o=
tab, you = ] ]
see payroll = 1L
field = ==
nelds = ==
belonging to
employees.
|
V?‘“\NG! Although you are allowed to edit the names of payroll fields, don’t change the
8 name of a payroll field and don’t change the order of the payroll fields after

you’ve entered payroll transactions. You'll get inaccurate information on the
payroll earnings reports and W-2 forms. We recommend that you retain the
names of payroll fields Peachtree creates for you because they are often used
in payroll tax tables.

On the EmployER Fields tab, you can set these preferences:

v Change the general ledger liability and expense accounts for a payroll
field.

v Change the tax table Peachtree uses to calculate a particular payroll
field. Click in the Tax Name column to display the Lookup list indicator
and then select from a list of available tax tables.

01
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v For fields Peachtree calculates, you can click the Adjust button to iden-
tify the fields you want Peachtree to include when determining Adjusted
Gross Wages for the field.

The same warning applies to EmployER field names that applied to EmployEE
field names. Don’t change the name of a payroll field and don’t change the order
of the payroll fields after you've entered payroll transactions. These alterations
create inaccurate information on the payroll earnings reports and W-2 forms.
And the names of payroll fields are often used in payroll tax tables.

Setting Inventory Preferences

Before you start filling your virtual shelves in Peachtree, you need to set up
the preferences that help track all those wonderful items as they come and
go. Inventory items in Peachtree terms are typically anything that you buy
from vendors or sell to customers. It’s important to understand that
Peachtree inventory items do not necessarily have to be things that you keep
on hand or that add value to the balance sheet; the item class of the inven-
tory item determines whether it adds value to your balance sheet. In the sec-
tion “Inventory items and general ledger accounts,” later in this chapter, you
read about item classes.

You can set preferences for inventory items using the Inventory Item Defaults
dialog box, which you open by choosing Maintain=>Default Information=>
Inventory Items. The dialog box contains six tabs. On the General tab, you
can specify whether to permit duplicate values in the UPC/SKU field of inven-
tory items. Read on to find out about the other defaults you can set.

Inventory items and ordering defaults

The Ordering tab of the Inventory Item Defaults dialog box, shown in Figure
4-7, helps you control issues related to, well, ordering inventory items. For
example, you can choose to have Peachtree include items on purchase
orders when it calculates the quantity available.

You can have Peachtree warn you when you’re entering a sales order, an
invoice, or a receipt for an inventory item that is out of stock based on the
quantity on hand or the quantity available.

In the last section of the Ordering tab, you can enable the auto-creation of
purchase orders for drop-ship transactions and non-drop-ship transactions.
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When you enable real-time posting and assign a preferred vendor to each
inventory item, Peachtree will automatically create purchase orders for you
when you convert a drop-ship quote to a sales order, a drop-ship quote to an
invoice, or when you enter a drop-ship sales order or a drop-ship invoice con-
taining inventory items.

Inventory Item Defaults
General Ordering ] GL Accts/Costing T Taxes/Shipping [ Custom Fields ] Price Levels
Quantity Available
I™ Include purchase orders when calculating quantity available
Cancel
Sales Invoice / Receipt Out of Stock Waming Message w

Dot wam me
" Wam f inventory item is out of stock based on quantity on hand
 Wam f inventory item is out of stock based on guantity available

Sales Order Out of Stock Waming Message

& Do not wamme
" Wam f inventory tem is out of stock based on quantity on hand
" Wam f inventory tem is out of stock based on quartity avalable

Auto Creation of Purchase Orders:

™ Enable auto creation of purchase orders for drop ship transactions

I™ Enable auto creation of purchase orders for non-drop ship transactions

If your transactions are not drop-ship transactions, you can have Peachtree
automatically create purchase orders for you when the quantity of an item
you specify causes the quantity available as of the transaction date to fall
below the minimum stock levels you set for the item. Again, for this feature
to work, you must enable real-time posting and assign a preferred vendor
to each inventory item.

Inventory items and general
ledger accounts

Peachtree uses item classes to organize inventory items. You assign each
inventory item to a class when you create the item. And you can choose the
various accounts affected by inventory items in each of these item classes.
For stock, master stock, and assembly items, you can also choose an inven-
tory method. Chapter 11 includes information on how to create inventory
items.

For the purpose of setting defaults, remember that an item’s class determines
how Peachtree records the cost of the item.
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Peachtree Premium supports 11 item classes, Peachtree Complete supports 9
item classes, and the other versions support 7 item classes. These item
classes follow:

v Stock: For inventory items that you track for quantities, average costs,
vendors, low stock points, and so on.

When you’ve assigned an item to the Stock class, you can’t change the
item’s class.

1 Master Stock: For items that consist of information shared by a number
of substock items. For example, you might sell blue jeans, which consist
of a number of attributes, such as size and style (straight leg, relaxed fit,
classic fit, and so on.) After you create a master stock item and define its
attributes, Peachtree automatically generates substock items based on
the attributes of the master stock item.

v~ Serialized Stock: Available only in Peachtree Premium accounting, use
this item class when the inventory items have serial numbers that you
plan to track.

v Nonstock: For items that you sell but do not put into your inventory,
such as service contracts. Peachtree prints quantities, descriptions, and
unit prices on invoices but doesn’t track quantities on hand. You can
assign a cost of sales G/L account, but it is not affected by a costing
method.

v Description only: When you track nothing but the description. For
example, you can add comments to sales or purchase transactions using
description-only items.

v Service: For services you can apply to your G/L salary and wages
account to bill a customer for services provided by your employees.

v Labor: For third-party labor costs that you pass on to a customer. You
can apply these costs to your G/L salary and wages account.

1 Assembly: For items that consist of components that must be built or
dismantled.

v~ Serialized Assembly: Available only in Peachtree Premium, use this item
class for assembly items that also have serial numbers.

v Activity: Available only in Peachtree Premium and Peachtree Complete,
for recording, using Peachtree’s Time & Billing feature, how time is spent
when performing services for a customer or job.

v Charge: Available only in Peachtree Premium and Peachtree Complete,
for recording, using Peachtree’s Time & Billing feature, the expenses of
an employee or vendor when working for a customer or job.
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See Chapter 10 for more information on Peachtree’s Time & Billing feature.

Follow these steps to set or review the account assignments for the inventory
item classes:

1. Choose Maintain->Default Information=>Inventory Items to display the
Inventory Item Defaults dialog box.

2. Click the GL Accts/Costing tab.

3. Move the mouse pointer over any white box to see the Lookup list
mouse pointer (arrow + ?), and then click to display the Lookup list
button, as shown in Figure 4-8.

4. Click the Lookup list indicator (the magnifying glass) to display a list
of your available accounts.

5. Highlight the account you want to use and then click OK.

6. Repeat Steps 3 through 5 as necessary in any white box on this screen
to change an Item Class assignment.

For the Costing column, choose FIFO, LIFO, or Average as your costing
method.

Check with your accountant to help choose the correct method for your
business. Just so you know what we’re talking about, turn to the sidebar
in Chapter 11.

7. If necessary, change the GL Freight Account using Steps 3,4, and 5.
You use the GL Freight Account to assign freight charges to an invoice.

8. When you are finished, click OK or click another tab and read the
related information in the next section.

Inventory Item Defaults

General | Ordering |GL Accts/Costing || Taxes/Shpping | CustomFields | Price Levels

kem Class. | GLSales/inc|GL nviry/Wage | GL Cost Sales | Cesting i

Stosk tem =
carcel |

Master Stock tem

Senalized Stock tem e e e 2 e |
Non-stock item ( C
H . Description only
Figure 4-8: || !
e
Setthe Lebor

Equity-doesnt close
Equiy-Fetained Eamings
Dividends Paid Eauty-gets closed

omm
Paidin Captal
Retained Eamings

Assembly

default ‘Serialized Assembly
e nzem

These Defauts ars uss
accounts ety tools. Incividual record) ] @ oy 55 WEe @
Invéntory tems Sereen. Ok Cancel Fin Edi  Mew Help

foryour || siospsseon
invento ry 575000 S E‘ga(\}:s L\I\rw‘fc:usc:r?; it
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Taxes and shipping

Ah, taxes. The government needs to get its cut when you sell something —
and so, when appropriate, you must collect sales tax and pass it on to your
state’s taxing agency. As you would expect with anything connected with
then government, sales taxes are not straightforward. The government
requires that you charge tax on some things but not other things. To take that
concept a step further, some organizations (notably governmental and chari-
table agencies) don’t pay taxes. And, of course, it’s up to you, the seller, to
keep straight who pays tax and for what.

If necessary, choose Maintain=>Default Information=>Inventory Items to dis-
play the Inventory Item Defaults dialog box. Click the Taxes/Shipping tab. On
the left side of the Taxes/Shipping tab, you can define up to 25 tax types (you
have our sympathy if you need all of them). You use tax types to organize the
sales taxes that you remit and report to your state sales tax agency. Typically,
you want to set up tax types that match the categories you must report on
your state’s sales tax return.

After you establish tax types, you assign a tax type to each inventory item

you create — see Chapter 11 for more information. When you sell the item,
Peachtree will note the tax type, and when you pay your sales tax, you use a
report that segregates your sales by tax type. So that’s why you want to set up
tax types that match the categories you report on your state sales tax return.
See Chapter 7 for information on setting up sales taxes and Chapter 6 for infor-
mation on paying sales taxes.

You also can use the right side of the Taxes/Shipping tab to create up to 10
shipping methods. Remember that shipping methods don’t have anything to
do with inventory items; you assign shipping methods to customers and ven-
dors. The shipping methods you assign will appear on quotes, sales orders,
invoices, purchases, and purchase orders. Find out more about setting up
vendors in Chapter 5 and setting up customers in Chapter 7.

Custom fields

Although you don’t assign shipping methods to inventory items, you may
assign custom fields to inventory items — notes, alternate vendors, and
weight are a few examples of the type of information you might store in
custom fields. Choose Maintain=>Default Information=>Inventory and click the
Custom Fields tab. Place a check mark in the Enabled box next to each
custom field that you want to use and then type the name of the custom field
in the Field Labels box.
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Price levels

Peachtree Premium and Peachtree Complete support multiple prices — price
levels, so to speak — for inventory items. You can set up to 10 price levels
for each inventory item, assigning an easy-to-remember level name such as
Retail, Wholesale, and Discount5 (for Discounted 5%), and then use the vari-
ous price levels to establish pricing schemes. For example, you might estab-
lish Price Level 1 as your full retail price, Price Level 2 as a 5% discount off
the retail price, and Price Level 3 as a 10% discount off the retail price. You
start by identifying which of the 10 price levels you want to use on the Price
Levels tab of the Inventory Item Defaults dialog box, shown in Figure 4-9. To
use a price level, place a check mark in the Enabled column next to the price
level.

Inventory Item Defaults
General | Odeing | GLAcclsfCosting | Tawes/Shipping | CustomFields || Price Levels |

Level 1 Price Level 1 GA | No Caleulation b
Lovel2 | Prce Level2 LA | No Calculation ’ _Cered |
Level 3 Price Level 3 G | No Caleulation 3 Help
Leveld | PrceLevel 2 G | N Caleulation »
Level5 | Prce Level 5 2 [ o Calculation »
Level8 | Frice Level 6 G | N Calculation »
Level7 [ PrceLeval 7 LA | No Calculation ’
Level8 | Frics Level & # | Ne Calculation >
Level 3 Price Level 9 GA | No Calculation b
Level 10| Price Level 10 & | No Calculation [

Frice Levels ars used in sales transactions to estabiish diferent ftem pricing categeries.

Enter the price level name for example, Ful Price or Sele Prics) here. Click the Edit

buttor to set up the prics level's defaut calculation

You also can set default price calculations for each price level. The calculation
can be based on the last cost of an item or on Price Level 1. After selecting the
basis for the calculation, you can increase or decrease the price by either a
percentage or an amount. You set default price calculations by clicking the
button in the Edit column next to the appropriate price level. Peachtree dis-
plays the Default Price Level Calculation dialog box, shown in Figure 4-10.

Default Price Level Calculation

Calculate Price for. Price Level 2

Frice Calculation

Use |Last Cost ;J and ‘Increase by Percent j ‘ 000 x
Frice Level1

hanStEE\?:ﬁ\atinn Round Frice |Mo Rounding =
oK | Cancel ‘ Help |
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The calculations you establish in the Inventory Item Defaults dialog box are
defaults for all items. You also can establish selling prices for each individual
item by using the Maintain Inventory Items window. Any prices you establish
for an individual item override prices you set in the Inventory Item Defaults
box. See Chapter 11 for details.

The Price level feature in Peachtree is powerful. Even after you establish
defaults and then override them by setting price levels for individual items,
you can override individual item price levels on invoices as you create them.
See Chapter 7 for more information.

Peachtree also enables you to assign price levels directly to customers; sup-
pose, for example, that you always discount all merchandise for a particular
customer to Price Level 3. In the Maintain Customers/Prospects window, you
can assign a customer to Price Level 3 so that all items on all invoices for the
customer default to Price Level 3. Again, see Chapter 7 for more information.

You’re probably wondering about how to change prices — after all, nothing
stays the same price forever (unfortunately). Yes, you can easily raise (or
lower, if you are so inclined) prices without editing individual items. See
Chapter 11 for more information.

Setting Preferences for Printing
Statements and Invoices

Just as you can set defaults for the way you want Peachtree to handle your
customers, vendors, and employees, you also can control the information
printed on statements and invoices. You set these preferences by choosing
Maintain>Default Information=>Statement/Invoices.

Suppose, for example, that you don’t use preprinted invoices or statements
but that you want your company’s name, address, and phone numbers to
appear on the top of the invoice or statement. In the Statement/Invoices
Defaults box, shown in Figure 4-11, simply place a check mark in the last
check box to print your company’s name, address, and phone numbers, as
they appear in the Maintain Company Information window.

Use the rest of the boxes on the Statement Print Options tab to control the
customers selected when Peachtree prints statements:

v If you place a check mark in the Any activity since the last statement
was printed check box, Peachtree will print a statement for any cus-
tomer who has purchased something from you since the last time you
printed statements.
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v If you place a check mark in the Balances at least check box and supply
a minimum balance number, Peachtree will print statements for cus-
tomers with balances equal to or greater than the minimum balance.

v If you place a check mark in the At least one invoice X days past due
check box and then type a number of days overdue, Peachtree will print
statements for any customers who have an invoice overdue by at least
the number of days you entered.

v Place a check mark in the Negative balances box to specify whether
Peachtree should print statements for customers with credit balances —
the people to whom you owe money. You can choose Always, Never, or
Only when the above options apply.

v Place a check mark in the Zero balance box to specify whether
Peachtree should print statements for customers whose balance is 0.
You can choose Always, Never, or Only when the preceding options
apply.

Strangely enough, each of these check boxes is a yes-or-no question, but the
check boxes in this section of the dialog box work together. If a customer
meets any condition that you have checked, Peachtree will print a statement.
For example, suppose that you place a check mark in the Any Activity Since
The Last Statement Was Printed box and also in the Balances At Least check
box and you supply $1.00 as the minimum balance. Peachtree will print state-
ments for all customers who have bought something from you and all cus-
tomers whose balance is greater than $1.00. So, even if you did not want
customers with 0 balances, Peachtree will print statements for those cus-

tomers if they have bought something and paid for it. Be sure to examine the

logic of all the boxes you choose to check.
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Peachtree can print balance forward statements, similar to the way informa-
tion appears on a MasterCard or Visa credit card bill, where an invoice
appears only once on a statement and its balance subsequently becomes
part of the Previous Balance line. Or Peachtree can print open item state-
ments, where all outstanding invoices — the ones that aren’t paid in full —
appear on the statement.

Using the Dunning Messages tab, you can specify four messages that may
appear on statements. The message that appears on a particular statement
depends on the length of time a customer’s account is overdue. In addition to
entering the message, you also can enter the number of days the account is
overdue.

Visit this book’s Web site for more information on Peachtree.
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In this part . . .

Data entry. It’s a dirty job . . . but somebody has to do
it. Whether you handle the day-to-day accounting
responsibilities associated with your business or have
someone in your office do them for you, you'll find this
part valuable.

In this part, we show you how to keep up with tasks
including billing your customers and collecting money
from them, purchasing and paying for goods and services
used in your business, and paying employees. We also
cover job costing and time and billing tasks.




Chapter 5
Buying Goods

In This Chapter
Setting up vendors
Tracking goods with purchase orders
Entering a vendor bill
Receiving inventory

Getting credit for returns

Buying things is part of the business of doing business. Some businesses
buy goods from vendors and keep them in inventory to resell to cus-
tomers. Some businesses buy goods to use in the manufacturing of a product
to sell to customers. And all businesses buy the goods and services that they
use to stay in business, such as office supplies and utilities.

So, no matter how you look at it, you can expect to receive bills in the mail.
And, of course, paying bills isn’t fun, but at least Peachtree can make the
process easier and save you time — time you can spend earning more money.

This chapter describes the typical actions you take to record and track ven-
dors’ bills.

Terminology alert: Peachtree tends to switch back and forth between two dif-
ferent terms when referring to bills that vendors send you: a purchase and an
invoice. For the sake of clarity, we call it a purchase unless the screen calls it
an invoice. For our purposes, invoices are things you send to customers so
that you can get paid.

A\

Working with Vendors

If you buy goods or services from a particular vendor on a regular basis, you
can save time in the long run if you set up that vendor in Peachtree. In fact, if
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you don’t set up the vendor, you'll find it difficult to track how much you’ve
spent with that vendor. There . . . you have two good reasons to set up ven-
dors with whom you do business on a regular basis.

Adding vendors

When you set up a vendor, you supply name and address information, a pur-
chase account to use each time you post a purchase from the vendor, and
custom field information. You also can view historical information about your
purchases from the vendor for the previous 12 months.

To add a new vendor, follow these steps:

1. Choose Maintain->Vendors to display the Maintain Vendors window,
as shown in Figure 5-1.

= Maintain Vendors ==
el W el s o BE (B &,
EEQ Save  Delete Changeld  New effefrf Log  Letters %
Vand 0. [TV o @
MName: |Ea|dw5IITnnIs Company ‘ [~ Inactive
General ] Purchase Defaults T Custom Fields T History i
Contact: [Carl Caldwel | Wendor Type: [ADMIN
Account # [HPFIE? 1099 Type: |None -
Address: |2356 Steve Reynolds Placs Telephone 1: [F70-655-7130
Telephone 2: |770-555-7131
City, 5T Zip: [Nororass G4 [30033 Fo (7705555545
LS54 i
bty é E-mail cca\dwel\@samp\e.paachtlee@
Begnning Balances: E' ‘weh Site: [www. peachires.com &]
Curent Balanca on Mar 15,2007 [+] 21.304.10

2. Fill in the Vendor ID and the Name text boxes.

The ID is the number you use to select the vendor when you want to
post a purchase or payment, so try to make it meaningful. The ID can be
up to 20 characters and numbers long, and it is case sensitive. We sug-
gest that you use lowercase letters so that you can type the ID quickly.
By default, Peachtree sorts the vendor list and reports using the Vendor
ID. To get Peachtree to sort the vendor list in alphabetical order by
default, use characters from the vendor’s name as the ID.

3. On the General tab, fill in contact information — your account number
with the vendor and the vendor’s address and phone numbers.
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The account number you supply appears by default on checks you print
from the Payment window. Find out more about the Payment window in
Chapter 6.

. If appropriate, identify the vendor’s 1099 type by selecting an option

from the 1099 Type drop-down list.

According to IRS rules, you must issue a 1099 to a vendor who is an inde-
pendent contractor if the contractor is not incorporated and you pay
$600 or more per year to that vendor. Peachtree can print 1099s at the
end of the year for vendors you designate as 1099 vendors. Sales repre-
sentatives might be considered 1099 vendors, based on the IRS defini-
tion of employees and independent contractors. If you have Peachtree
Complete or Premium, you can filter several of Peachtree’s reports by
1099 Type; see Chapter 14 for more information on printing and filtering
reports. See Chapter 9 for more discussion on paying sales representa-
tives who are also employees.

. Use the Vendor Type text box to group similar vendors together.

For example, you may want to distinguish between vendors who supply
you with inventory and vendors who provide overhead services such as
telephone. The text you enter in the Vendor Type text box can be up to
eight characters long; note that this field is case sensitive. Entering a
vendor type is useful because you can limit some reports to specific
vendor types.

. If appropriate, supply an e-mail and a Web address for the vendor.

Both e-mail and Web addresses are interactive. So, if you supply an e-mail
address and click the icon next to the E-mail text box, Peachtree opens
your e-mail program and starts a message to the vendor. Similarly, click-
ing the button next to the Web Site text box launches your browser and
directs it to the vendor’s Web site.

To generate e-mail messages from within Peachtree, you must have a
MAPI-compliant, default e-mail application installed on your computer. If
your default e-mail system is AOL, you will not be able to send e-mail
alerts from Peachtree because AOL is not a fully MAPI-compliant e-mail
application.

. Click the Beginning Balances button to display the Vendor Beginning

Balances window, where you can enter unpaid bills you received
from vendors before you started using Peachtree.

Technically, you can enter as many beginning balance bills as you want for
an individual vendor; however, if you exceed 100 bills, you can enter but
not edit or delete any information for the 101st bill and subsequent bills.

If you click the Current Balance button, Peachtree displays the Vendor
Ledger report for the current vendor, showing you the bills and checks
that comprise the vendor’s balance as of the specified date.

75
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8. Click the Purchase Defaults tab to select a default purchase rep,

10.

11.

account, terms, and form delivery options for the vendor.
An employee can serve as a purchase representative.

You need to select a default Purchase Account and terms only if they
differ for the vendor you'’re creating from the default account and terms
you established in the Vendor Defaults dialog box. (See Chapter 4 for
details on global default purchase settings.)

In the Form Delivery Options area, you can choose to e-mail forms (such
as purchase orders) to vendors or print them and mail them. If you select
the E-mail option, you can choose to e-mail a copy of the form to the pur-
chase representative at the same time that you e-mail the form to the
vendor.

. If the vendor is a 1099 vendor, supply the vendor’s Tax ID number,

which eventually appears on the 1099.
Select a shipping method from the Ship Via drop-down list.

Peachtree creates most of the shipping methods that appear in the Ship
Via drop-down list when you create your company; you can add to or
change these methods when you set up defaults for inventory. You can
find information on setting up inventory defaults in Chapter 4.

To change the terms for the vendor, click the Terms button.

Peachtree displays the Vendor Terms dialog box (see Figure 5-2). Deselect
the Use Standard Terms check box and set up the vendor’s terms.
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12.

13.

On the Custom Fields tab, fill in the information you established in the
Vendor Default dialog box.

Click the Save button to save the vendor information.

Changing vendor information

You can change any information you have entered about a vendor, including
the vendor ID. If you need to make a change to a vendor’s information, follow
these steps:

1.
2.

Choose Maintain=> Vendors.

Type a few letters of the vendor’s ID — remember, ID’s are case-
sensitive — or click the lookup list box indicator next to the Vendor
ID text box to display a list of vendors.

. Highlight the vendor you want to change and click OK.

The information you saved previously for the vendor appears.

. If you need to change the vendor ID, display the vendor’s information

in the Maintain Vendors window and then click the Change ID toolbar
button.

Peachtree displays the Change Vendor ID dialog box. Type a new ID in
the New Vendor ID text box and click OK. Peachtree changes the
vendor’s ID.

. Click the tab containing any additional information you want to

change.

6. Make the change(s).
7. Click the Save button.

Viewing vendor history

After you have recorded purchases and payments for vendors, Peachtree
tracks these transactions by month. Choose Maintain>Vendors to open the
Maintain Vendors window. Type the Vendor ID or highlight your choice from
the lookup list and then click the History tab to view a history of your activ-
ity with the vendor.

/7
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“De-activating” a vendor

If a vendor has gone out of business or you've decided that you just don’t

want to do business with a particular vendor, you can change the vendor’s
status to inactive. After you make a vendor record inactive, Peachtree dis-
plays a warning if you try to buy something from the vendor.

Although you see a Delete button in the Maintain Vendor window, you can’t
delete a vendor unless no transactions exist for the vendor. You know, you
put somebody in and then realized you didn’t want them after all — and you
didn’t record any transactions. Then you can display that vendor on-screen
and click Delete. Otherwise, to get rid of a vendor, you must first make the
vendor inactive. After closing a fiscal year, you can purge inactive vendors so
that they don’t appear in lookup lists. See Chapter 17 for information on clos-
ing a fiscal year and purging.

To make a vendor inactive, follow these steps.
1. Choose Maintain~>Vendors to open the Maintain Vendors window.

2. In the Vendor ID text box, select the vendor you want to make inactive.
3. When the vendor appears on-screen, select the Inactive check box and
then click the Save button. The vendor is now inactive.

When you need to reactivate the vendor, deselect the Inactive check box.

An inactive vendor won’t appear in the lookup lists if you decided to hide
inactive records when you set Peachtree’s global options. You can find out
how to hide inactive records in Bonus Chapter 1 on this book’s Web site.

Working with Purchase Orders
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A purchase order is a document you use to request merchandise from a vendor.
When you enter a purchase order, Peachtree doesn’t actually affect any of your
accounts — that doesn’t happen until you either receive the merchandise or, if
you're using cash basis accounting, when you pay the vendor.

Peachtree takes note of the transactions — that is, you can print reports that
show you the accounts that the purchase orders will affect when they are
filled. But the purchase orders don’t actually update the accounts when you
save the purchase orders.
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Entering purchase orders

“If a purchase order doesn’t affect any of my accounts, why use it?” you ask.
Well, first, you don’t need to use purchase orders; Peachtree operates correctly
if you don’t use them. But most people use purchase orders as reminders, par-
ticularly when ordering inventory, because the purchase order shows the
items they’ve ordered but not yet received. Others use purchase orders for
non-inventory items such as office supplies or contract labor to help track
expected expenses.

Purchase orders provide you with a great way of remaining organized so that
nothing slips through the cracks. You can use the Purchase Order report to
help you stay on top of things.

You can’t enter purchase orders in Peachtree unless you have set up a vendor,
but you can set up a vendor while working in the Purchase Orders window.

To enter a purchase order, follow these steps:
1. Choose Tasks=>Purchase Orders to display the Purchase Orders

window, as shown in Figure 5-3.

You can customize the appearance of the Purchase Order window to
better suit your needs; if you have changed these settings, your window
won’t look exactly the same as the window you see in Figure 5-3.

Purchase Orders =(E]%]
Ny N ﬁ— P @ f? E. £ £, € & 1= &
e “New  Open Piint. * Emal Delete Fiow n%ﬁu M Joita Even Twad e
Vendor ID; [ SOGARDEN Purchase Order[€]
Remit Ta: Southem Garden Whalesale shpTo: - Date:[Mar 3, 2 =
3555 Dakland Park Blvd. = =
Atlanta, GA 30312 USA Bellwether Garden Supply Good Thru: Apr 14, 2007_|E]
1505 Paviion Place PO No.:[10302 |
| [ ClasePo
Noraross [ca [30m93-3203 [ orog ship
Ush
Customer SOMo. _ Customer Invoice No. _ Discount Amount Terms ship Vi AP Account
12.%6 [2% 10, Net 30Days_|UpsGround  [wf2000000 [
Quentity Receved  Item Description GL Account Uit Price Amount Job
.00 | Equw-14120 [ Catclog = L140090: Reel Mowe| 1200000 | 19,25 119,70 |
.00 | Eqtw-14110 | Catclog = Gas4s5a: Cas Power] 1200000 | 59,35 352,70 |
12.00 ‘ |EQ\-T—15]6\] Catalog = WT1005280: Snruwe‘ 12000-00 ‘ 1195 143.40 ‘
Purchase Order Tatal: 622.30
Vendor Balance on Mar 3, 2007 [2] 31,072.25
QOrder Peachtree compatible Checks and Forms.
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2. Type the vendor’s ID in the Vendor ID text box or click the lookup list

box selector to display the list of vendors.

If the vendor exists, Peachtree fills in the vendor’s name and the Remit
To address. Your company’s name also appears in the Ship To address
box. You can see the vendor’s current balance as of the system date, and
you can click the button next to the balance to display a Vendor Ledger
report of the purchases and payments that comprise the balance.

If you need to add a vendor, click the lookup list selector and then click
the New button on the toolbar. Peachtree displays the Maintain Vendors
window. Refer to the earlier section in this chapter, “Adding vendors.”
Close the Maintain Vendors window to return to the Purchase Orders
window.

. In the PO No. text box, type a number for the purchase order if you

don’t intend to print it but just want to save it or if you intend to print
it later.

If you intend to print the purchase order, leave the PO No. box blank, and
Peachtree supplies a sequential purchase order number when you print
the purchase order.

You can’t use the same purchase order number more than once for a
particular vendor. You can reuse a purchase order number as long as
you assign it to a different vendor.

4. If necessary, change the date of the purchase order.

5. Enter a date in the Good Thru text box — the date after which the pur-

chase order should not be filled.

. If necessary, change the shipping method in the Ship Via drop-down

list.

While you can change the A/P account, typically, you don’t. Although
Peachtree doesn’t affect any of your accounts when you post the pur-
chase order, later, when you receive merchandise against the purchase
order, Peachtree uses the account information on the purchase order to
update your company’s books.

. In the Quantity text box, type the quantity you want to order.

For a whole number such as three, type 3.0. If you set global options to
Automatic Decimal Entry and you type simply 3, Peachtree assumes you
want .03.

. Click in the Item box.

The Lookup list box appears so that you can select the item you want to
order from the existing inventory items. Peachtree fills in the item
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description, the general ledger account associated with the item, the
item’s unit price, and the amount (unit price times quantity).

Read about setting up inventory items in Chapter 11. If you want to order
something that you haven’t set up as an inventory item, skip the Iltem box
and fill in the Description, GL Account, and Unit Price text boxes. Peach-
tree calculates the amount. If you enabled Peachtree’s spell-checking
options (see Bonus Chapter 1 on this book’s Web site for more informa-
tion), Peachtree flags any spelling mistakes as they happen.

9. Click in the Job box to display the Lookup list box selector and
choose a job from the list.

If you're purchasing a Stock item or an Assembly item, you cannot assign
it to a job; however, if you're purchasing any other type of item, you can
assign it to a job. You also can assign the line to a job if you don’t select
any item from the Item list. Chapter 12 covers setting up and assigning
types of jobs.

10. Repeat Steps 7 through 9 for each item you want to order from this
vendor.

11. Click either the Save button or the Print button.

If you want to continue entering purchase orders and print them later in
a group, click the Save button. Otherwise, click the Print button. To print
your purchase orders in a group, see the section about printing forms in
Chapter 14.

You can preview the purchase order before you print it by clicking the drop-
down arrow on the Print button and selecting Preview.

But there’s an easier way . . .

This feature is available only in Peachtree Premium and Peachtree Complete.

In Chapter 4, where we discuss setting up inventory options, you have the
choice to enable auto-creation of purchase orders for drop ship and non-drop
ship transactions. If you enable these options and enable real-time posting,
you can let Peachtree generate purchase orders for you, based on informa-
tion you supplied when you defined your inventory items (see Chapter 11 for
details on inventory items).

To make this feature work, you need to assign a preferred vendor to each
inventory item and, to make the feature work well, you need to supply a mini-
mum stock quantity and a reorder quantity for each inventory item.
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Assuming that you've done these things, choose Tasks=>Select for Purchase

Orders. The Select for Purchase Orders dialog box appears, as shown in
Figure 5-4.

Select For Purchase Orders - Filter Selection
Select items with
TemID: @ Al O Select: D Ttem Class: [V Stock
[~ Assembly Cancel
TemType: & Al € From: s
em Types & Al From: s —
Tor ’7 I™ Service

I™ Labor

And items with

VendorIDi @ Al Select: =
BuyerID: @ al € Select: D

Display 2 list of items
Based on: And stock status: And set order quantity to:
& Quantity Available & Outof stack @ Grester of rearder quantity and
¢ Quantity On Hand € Below mirimum stack (L Rt T
£ st shove mmom stock (" Bing auantity i to minimum stock
=  Reorder quantity

" Quantity needed to fil SOs anly

Asofi |Mar 15, 2007

In the Select For Purchase Orders dialog box, you set up the selection criteria
that Peachtree should use to display a list of potential purchase orders to
create.

In the Select Items With section of the dialog box, you can choose which items

to include using the Item ID, Item Type, and Item Class options. For example, in
the sample company, you can select the All option for the Item ID, the SUPPLY

option for the Item Type, and the Stock option of the Item Class.

In the And Items With section, you can narrow the selection by choosing only
certain vendors or buyers (buyers are set up as employees and you identified
buyers as well as vendors when you created inventory items).

In the Display a List of Items section, you can indicate that you want Peachtree
to select items to order based on the how many items are available or on hand
by selecting the Quantity Available or the Quantity On Hand options as of a
particular date; you can also order based on as the item’s minimum stock level.
In the And Set Order Quantity To section, you can identify the quantity you
want Peachtree to place on the purchase order(s) it suggests.

When you click OK, Peachtree displays the Select For Purchase Orders window
shown in Figure 5-5, where you can review the proposed purchase orders and,
if necessary, exclude any you don’t want Peachtree to create by deselecting the
check box in the Order column of the proposed purchase order.
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Select For Purchase Orders =a
Ly ﬂ-"Lé—ﬂ&! .,‘*;E@a 5 O &.
Close 557; Select  Refresh ﬁﬂﬂ -mail All Al Help
PO Date: [Mar 15, 2007 Quantity As Of Date:  Mar 15, 2007 Purchase Orders
Order | vendor | 1tem | Description | Avaiable=| ©nHand=| Order Oty | UnitPrice | Amount | GL Account | Job | Quantity on $0s* | Quantity on POs*
= ABNEY  TAVRY-1005... Prefabricated BirdhouseL. ., -3.00 5.00 0.00 0.00
AENEY  AVRY-1005... Prefebricated Birchoused -6.00 -6.00 0.00 0.00
ABNEY | AVRY-1005.. Birdhol 0.00 0.00 0.00 0.00
ABNEY  AVRY-1005.. Prefa Birdhouse 5., 0.00 0.00 187.50 0.00 0.00
CLINE AVRY-1020...  Birdbsth-Flastc-2ft- Gresn 0,00 0.00 187.50 0.00 0.00
CLINE AVRY-1020...  Birdb: tic-2ft-Red 0.00 0.00 172.50 0.00 0.00
CLINE AVRY-1020.,. Eirdbath-Plastic-2ft-White 0.00 0.00 172.50 0.00 0.00
CLINE AVRY-1020...  Eirdbath-Plastic-4ft-Green .00 0.00 187.50 0.00 0.00
CLINE AVRY-1020..,  Birdbath-Plastic-4ftRed 0.00 0.00 187.50 o 0.00 0.00
CLINE AVRY-1020...  Eircbsth-Plastic-4ft-Wihite 0,00 0.00 15.00 1250  187.50 1200000 0.00 0.00
< i >
“Quantity is expressed in stocking units. Total Amount: 207,00
Humber of POs: 2

You can make changes to the purchase orders before Peachtree creates them,;
click in the appropriate column and make your change. For example, you can
select a different vendor or change the Order Qty or GL Account.

After you identify the purchases you want to create, you can preview them
as they will appear to the vendor by clicking the drop-down arrow on the
Print button and selecting Preview. If you want a hard copy of the Select For
Purchase Orders window, click the drop-down arrow on the Print button and
select Report.

To create a purchase, click the Save button; if you prefer, you can click the
Print button or the E-mail button. If you click the Print button, Peachtree
prints the purchase order and asks you to confirm that it printed properly.

If you click Yes, Peachtree saves the purchase order. If you click the E-mail
button, Peachtree displays a dialog box where you can assign a purchase
order number; when you click OK, Peachtree displays the e-mail message it
will send to the vendor (see Figure 5-6), including the purchase order in PDF
format. After you review the message, Peachtree again displays a dialog box
that asks you to confirm that the purchase e-mailed properly. If you click Yes,
Peachtree saves the purchase order.

After you produce a purchase from the Select For Purchase Orders window,
you can click the Refresh button on the toolbar; Peachtree updates the infor-
mation in the Quantity on POs column.



84

Part ll: The Daily Drudge
’E‘? schaen Nedore
gy 1 Purchase Order # m101 - Message (Plain Text) =[]
Close’ i File Edit View Insert Format Tools Actions Help T
FODst=: V3l {3 Send il A LB = = e —A Purchase Orders
Order i z : i | 6L Account | Job | Quantity on 50s* | Quantity on Pos*
I m] Tous scine @sample.peadhtres, com S 1200000 0.00 15.00
m] 0 12000-00 0.00 16.00
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Editing and erasing purchase orders

You can change purchase orders, and you can delete purchase orders.
Although good accounting practices say you shouldn’t ever delete anything,
because a purchase order doesn’t affect your accounts, the offense doesn’t
seem quite so serious.

You can change or remove items from purchase orders if you have not yet
received the items. If you know you’ll never receive the items, you can close
the purchase order. If the purchase order was simply a mistake and you have
not received any items listed on it, why not just erase it? To edit or delete a
purchase order, choose Tasks=>Purchase Orders to display the Purchase
Orders window. Then click the Open button to display the Select Purchase
Order dialog box, as shown in Figure 5-7.

The Select Purchase Order dialog box shows, by default, the period in which
you are working. In Figure 5-7, you see the purchase orders entered with March
(Period 3) dates. If you don’t see the purchase order you want to edit or
delete, open the Show list box and select an earlier period.

You can edit any purchase order, whether it is open or closed. Look for the Y
in the Open? Column of the Select Purchase Order dialog box. If the Open?
column is blank, the purchase order is closed, meaning all the goods have
been received and entered, or you got tired of waiting and canceled it.
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Show list box

Select Purchase Order |

& oK Sort by | Date - Show: - -
i
€3 Cancel|[FeriodDate Reference Open? Amount_Vendor Hame
TE007 T A0 A0] Dl holesle B mnlers 2 Order[€]
D9 Firg | D303A0/07 0301 297.60) Clooney Chemical Supply
0303/03/07 0302 v 62280) Southem Garden Wholssle 15, 2007 |5
: 0303/05/07 10303 [1.15250] Deduia wholesale Supplers —
0303/13/07 03508 ¥ [3117.00] Sulley Pinting 14, 2007 [
© e | 03037507 ¥ 18750) Cine Construction, Inc.
£ 0 | 03pas507 ¥ 256.75) Abney and Son Canlractors
D303/15/07 ¥ (150:00) DPH Wb Design Closz PO
0303/15/07 031507 ¥ (55.30] Caliwel T ools Company Do Shi
0303/15/07 031508 ¥ (276.00) Abrey and Son Cortrastors
0303/15/07 2 v (167.20) Calcivel Taols Company

Purchase Order Total: 0.00

Maximize your results with help from Peachtree experts

Select a purchase order to view and click OK to display the purchase order in
the Purchase Orders window. You can make any of the following modifica-
tions to the purchase order:

v Change the date entered in the Date or the Good Thru text boxes.

v Select a different shipping method from the Ship Via drop-down list,
enter a new amount in the Discount Amount text box, change displayed
terms in the Terms text box, or change the account number in the A/P
Account text box.

v Adjust the quantity you ordered on any line of the purchase order —
even a line you've already received. Find out how to receive items you
order in the section, “Receiving goods against a purchase order,” later in
this chapter.

v Remove any line if you have not received those items. Click anywhere in
the line you want to delete and click the Remove button.

v Close the purchase order by selecting the Close PO check box that
appears immediately below the PO No. text box.

You cannot delete a purchase order if you have received any of the items
listed on the purchase order; the Delete button appears grayed out (unavail-
able). If you know you’ll never receive items remaining on a purchase order,
close the purchase order.
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Scenario: A vendor with whom you do business on a regular basis sends you
a bill. (Peachtree uses the terms purchase and invoice interchangeably to rep-
resent a vendor bill.) You don’t want to pay the bill immediately, but you do
want to pay the bill in a timely manner. So, enter the bill into Peachtree as a
purchase, and Peachtree tracks the bill’s age so that you pay it A) when it’s
still eligible for a discount and B) before the vendor charges you a late fee.

Do you receive a bill on a regular basis from a vendor? Chapter 6 shows you
how to create a recurring purchase or payment for things like monthly utility
bills or lease payments.

Purchasing without using a purchase order

Unlike purchase orders, purchases update your company’s accounts. When-
ever any transaction updates your company’s books, at least two accounts
are affected because of the double-entry bookkeeping concept.

Every purchase you enter automatically updates Accounts Payable. The other
account Peachtree updates depends on whether you record a bill for an inven-
tory item. If you select inventory items in the Purchases/Receive Inventory
window, you tell Peachtree to update inventory for the other side of the trans-
action. If you don’t select an inventory item, then you probably select an
expense account, such as your telephone expense account. In that case,
Peachtree updates Accounts Payable and the expense account.

Peachtree assumes that you wouldn’t enter a bill from a vendor for merchan-
dise without having first received the merchandise—and entering a bill for
merchandise does update quantities on hand, so, don’t enter a bill until you
receive the goods. You might, however, receive the goods without yet receiv-
ing the bill. In this second case, you enter a purchase and make sure that you
check the Waiting on Bill box.

If you're curious about the accounts Peachtree is updating (yes, debiting and
crediting), Chapter 17 shows you a neat way to find out what Peachtree is
doing.

Peachtree assumes that you wouldn’t bother to enter a bill from a vendor you
use only occasionally; instead, you’d just pay that bill. Therefore, you can’t
enter purchases in Peachtree unless you have set up a vendor. For one-time
or occasional purchases from vendors you don’t expect to use often, use the
Payments window to pay the bill directly. See Chapter 6 for more information
on paying bills.



87

Chapter 5: Buying Goods

|
Figure 5-8:
Use this
window to
record a bill
froma
vendor.
|

\\J

WMBER
@"&
&

To enter a purchase (a vendor’s bill) that doesn’t reference a purchase order,
follow these steps:

1. Choose Tasks=>Purchases/Receive Inventory to display the Purchases/
Receive Inventory window (see Figure 5-8).

Purchases/Receive Inventory ®[=[x)
I EES oF § BE. mm £, & < =, &,
E}Q e e e . # 2 T e N P BT . T
Vet e
Remit To; Caldwell Tools Company Ship Ta: o Date: [Mar 15, 2007 \QI
2356 Steve Reynolds Place - T
Norcross, GA 30083 USA Belether Garden Supply ige Mot [ 12335 |
1505 Pavilion Place [ trop Ship
[ waiting on Bil
Narcross [ca J30me3-3203
USA
Customer 5O No. Customer Inveice No. Terms Ship Via AP Account
[3]tene [ [ 2000000 =
Apply to Purchase Orger: 0.00 IApdv to Purchases: 151.75

Quantity

Ttem

Description

GL Account

Unit Price

Amount

Job

2.00[ AvRY-10150

Catelog 511315: Bird Sath | 12000-00

[ 5135

10330 |

3.00 | POTS-30200

Catalog = P70125: Cadar Wi 12000-00

[ 15.95

47,85

Other Payments and Credits:

0.00

Amount Paid at Purchase:

151,75 Invoice Total

151.75 Net Due

vendor Balance on Mar 15, 2007 [ 21,304.10

Crder Peachtree compatible Checks and Forms.

You can customize the appearance of the Purchases/Receive Inventory
window to better suit your needs; if you do, the window won’t look
the same as the window you see in Figure 5-8.

2. Enter the vendor’s ID in the Vendor ID text box or click the lookup list
box and select a vendor from the list.

After you select a vendor, Peachtree fills in the vendor’s name and Remit
To address. Your company’s name also appears in the Ship To address
box. You can see the vendor’s current balance as of the system date, and
you can click the button next to the balance to display a Vendor Ledger
report of the purchases and payment that comprise the balance.

If you have previously entered purchase orders for this vendor, Peachtree
displays the Apply to Purchase Order tab. If you want to receive goods
against one of these POs, skip to the next section.

3. In the Invoice No. text box, type a number for the vendor’s bill.

You can’t use an invoice number more than once for a particular vendor.
You can reuse an invoice number as long as you assign it to a different
vendor.
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k‘&N\BEn 4. If necessary, change the date of the purchase.
& Yes, you can change the A/P account, but typically, you don’t.

5. In the Quantity text box, type the quantity for which you’re being
billed.

For a whole number such as three, type 3.0. If you set global options to
Automatic Decimal Entry and you type simply 3, Peachtree assumes you
want .03.

6. You have two options for entering items that appear on the bill:

e [f you are recording a bill for an item that you haven’t set up as an
inventory item, skip the Item text box and just fill in the Description,
a GL Account, and Unit Price boxes. If you enabled Peachtree’s spell-
checking options (see Bonus Chapter 1 on this book’s Web site for
more information), Peachtree flags any spelling mistakes as they
happen.

e If you are recording a bill for an inventory item, select the item in
the Item list box. Peachtree fills in the Description, GL Account, the
Unit Price, and the Amount (unit price times quantity) boxes.

7. If you are purchasing a serialized item, click the Serial No. button to dis-
play the Serial Number Entry dialog box shown in Figure 5-9, where
you can add the serial numbers you are purchasing.

Type the serial number for the first item and click Add. Repeat the
process for each serialized item you are purchasing. If the serial num-
bers are consecutive, select the Add consecutive serial numbers check
box and specify the number of items you are purchasing. When you
finish, click OK.

Serial Number Entry

Enter a serial numberto add

|1235D ‘ | Add |

¥ Add Eljcnnssmtme serial numbers

Senal Number | Status
12345 New
|
Figure 5-9:
Use this
window
to record
serial
numbers
when you
purchase
serialized
invento ry Added: Serial Number 1 of 10 for bicycle
items. [ ok | oK/hes Cancel Help
|
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8. Click in the Job text box to display the lookup list button and choose
a job from the list.

If you're purchasing a stock item or an assembly item (serialized or unse-
rialized for Peachtree Premium users), you cannot assign it to a job.
However, if you're purchasing any other type of item, you can assign it to
a job. You can also assign the line to a job if you don’t select an item from
the Item list. You can read about setting up jobs in Chapter 12.

If you assign a line to a job, Peachtree allows you to include it on a cus-
tomer’s bill as a reimbursable expense. Chapter 12 covers information
about including reimbursable expenses on customer invoices.

9. Repeat Steps 5 through 8 for each item you want to order or that
appears by the bill you’re recording.

10. Click the Save button to save the transaction.

Receiving goods against a purchase order

Scenario: You ordered merchandise using a purchase order, and the mer-
chandise arrives. Maybe the bill comes with the merchandise, and maybe it
doesn’t. Either way, you need to update your company’s accounts to reflect
the receipt of the merchandise so that you know they’re available to sell.

You use the Purchases/Receive Inventory window to receive goods against a
purchase order. You can, simultaneously, indicate whether you received the
bill. Follow these steps:

1. Choose Tasks>Purchases/Receive Inventory to display the Purchases/
Receive Inventory window.

2. Type the vendor ID in the Vendor ID text box or click that handy mag-
nifying glass to display the list of vendors.

After you select a vendor, Peachtree fills in the vendor’s and Remit To
address. Your company’s name also appears in the Ship To address box.
You can see the vendor’s current balance as of the system date, and you
can click the button next to the balance to display a Vendor Ledger
report of the purchases and payment that comprise the balance.

If you have previously entered purchase orders for this vendor,
Peachtree displays the Apply to Purchase Order tab, and the window
looks like the one shown in Figure 5-10.

3. In the Invoice No. text box, type a number for the vendor’s bill.

You can’t use an invoice number more than once for a particular vendor,
so if you get stopped by this, be sure you haven’t got an old invoice.



90

Part ll: The Daily Drudge
G fvs Inventory B
FEELSLERE MRS ST
Vendor ID: Purchase
Remit To: Caldwell Tools Company Ship To: % Date: [Mar 15, 2007 \QI
iér;os:fz;‘ 3-39931?:“ Bellwether Garden Supply Tny u:gelln.“ 1
| 1505 Pavilion Place [ brop ship
. [ waiting on 8il
Flgllre 5-10: Norcross [ea [30093-3203
The
Customer SO No. Customer Invoice No. Terms Ship Via AP Account
PUrChaseS/ [ [ rone 3 [ ] 2000000 =1
Receive Apply to Purchase Order No.: NoPO selected> [w] | Apely to Purchgses: 0.00 )
InVe ntory Ttem Remaining ~ Received <;“DPOSE‘E¢E'1> ] GL Account Uit Price Amount Job
; 7 \ \ [
window ‘ ‘ ‘
when you've
Other Payments and Credits: 0.00 0.00 Invoice Total
enterEd Amount Paid at Purchase: 0.00 NetDue
POs for the ,
Vendor Balance on Mar 15, 2007 B 21,304.10
vendor.

I Order Peachtree compatible Checks and Forms.

P If you have vendors who don’t provide you with an invoice number, your
company might have a standard solution for this problem like entering a
combination of the vendor ID plus the date or the primary PO number.
This usually helps avoid duplications (but not always).

4. If necessary, change the date of the purchase.
5. If only the merchandise arrived but you have no bill from the vendor,
select the Waiting on Bill check box.
° If you received both goods and a bill, leave the box deselected.
h\

As with other transactions, you can change the A/P account, but typi-
cally, you don'’t.

. On the Apply to Purchase Order No. tab, click the Apply to Purchase

Order No. drop-down list, select the PO number that lists the goods
you ordered.

Peachtree fills in the lines that appear on the purchase order.

. On each line of the Apply to Purchase Order tab, in the Received text

box, type the quantity you received.

If you are purchasing a serialized item, click the Serial No. button to add
the serial numbers you are purchasing. In the Serial Number Entry box
that appears, type the serial number for the first item and click Add.
Repeat the process for each serialized item you are purchasing. If the
serial numbers are consecutive, select the Add consecutive serial num-
bers check box and specify the number of items you are purchasing.
When you finish, click OK.



Chapter 5: Buying Goods

Remember that you have to put the decimal-zero after the whole number,
or Peachtree adds the leading decimal: To get 6, type 6.0. Peachtree fills in
the Amount text box by multiplying the unit price by the quantity.

8. Click the Save button to save your work.

When the bill arrives . . . finally

If you have entered vendor receipts against a purchase order but didn’t have
a bill at the time you entered the vendor receipts, you should have selected
the Waiting on Bill check box in the Purchases/Receive Inventory window.
When the waiting is over and you’ve got the vendor’s bill, follow these steps
to tie up the loose ends:

1. Choose Tasksw>Purchases/Receive Inventory to open the Purchases/
Receive Inventory window.
2. Click the Open button to display the Select Purchase dialog box.

If you select the vendor first, Peachtree alerts you that a bill already
exists for this vendor.

3. From the Sort By drop-down list, select ID to sort the list by vendor
name.

4. Find the vendor’s name in the Vendor Name column, and then look
for a Y in the Waiting? column and Unpaid in the Status column.

Use the Reference column to further help you identify the correct
purchase.

5. Highlight the correct purchase and click OK.

Peachtree displays the purchase in the Purchases/Receive Inventory
window.

6. Deselect the Waiting on Bill check box.
7. Click the Save button.

By making this status change, you indicate to Peachtree that you now consider
the bill eligible for payment. See Chapter 6 for information on paying bills.

Shipping Directly to Customers

Suppose that you need to buy something, maybe a special order for a cus-
tomer, and you want to ship it directly to the customer. No problem. You can

91



92

Part ll: The Daily Drudge

\\3

\\J

specify a customer’s address in the Ship To box on either a purchase order or
a purchase. Choose Tasks>Purchase Orders to display the Purchase Orders
window or Taskst>Purchases/Receive Inventory to make a purchase. In either
window, follow these steps:

1. Type the vendor ID in the Vendor ID text box or click the lookup list
box selector to display the list of vendors.

2. Select the Drop Ship check box.
Peachtree displays a Customer ID field next to the Vendor ID field.
3. Select the customer from the Customer ID list.

Peachtree supplies the customer’s address and enables you to select a
different shipping address if you click the Ship To drop-down list arrow.

You can type the recipient’s name and address if you haven’t set the
recipient up in the Customer List.

4. If you have already entered an invoice to the customer, you can enter
the invoice number in the Customer Invoice No. text box. If you've
entered a sales order but not an invoice, enter the sales order number
in the Customer SO No. text box.

Both of these text boxes are informational only; they don’t tie to invoice
or sales order transactions. You'll find them most useful, however, if you
enter numbers that represent real transactions because they can help
you track drop shipments on reports.

You don’t need to create the invoice before you set up the drop ship-
ment, but don’t forget to bill your customer. For more information about
creating invoices for customers, see Chapter 7.

5. Click the Save button.

To help you track drop shipments, you can add the Drop Shipment, Customer
ID, Customer SO No., and Customer Invoice No. fields to the Purchase
Journal, the Purchase Order Journal, and the Purchase Order report. You also
can filter the Purchase Order report so that it displays only drop shipments
created in the Purchase Orders window.

Entering Credits

Suppose that you have a purchase that you no longer need. Should you just
erase it? If you want to practice good accounting, the answer is a definite no.
Deleting purchases removes the audit trail — that thing accountants mean
when they talk about the list of transactions you enter because your business
does business. When accountants can trace transactions from beginning to
end, they’re really happy campers.
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Having said that, you need to understand that Peachtree allows you to delete
any unpaid purchase, even though your accountant won'’t like it. Display the
purchase in the Purchases/Receive Inventory window and click the Delete
button.

But Peachtree won't allow you to delete a purchase if you've applied any trans-
actions to it. Suppose, for example, that you accidentally paid a purchase that
you later determined you should not have paid. If you try to delete the pur-
chase, the Delete button in the Purchase window is unavailable. In this case,
you need to void the check you wrote that paid the purchase, and then you
need to enter a vendor credit memo in Peachtree to cancel the effects of the
purchase. (See Chapter 6 to find out how to void a check.) After you’'ve voided
the check, follow the steps in this section to finish canceling the purchase.

Besides fixing errors in purchases, don’t forget about the times when a vendor
issues a credit memo to you for merchandise you return. You need to enter the
vendor credit memo into Peachtree to reduce the balance you owe the vendor
and match it to the original purchase. To record the vendor credit memo, use
the Vendor Credit Memos window. While you can enter a vendor credit memo
without having previously entered a purchase (you use the Apply to Purchases
tab of the Vendor Credit Memos window), typically you enter vendor credit
memos for existing purchases. In the following steps, we assume that you are
returning any merchandise for which you received a credit:

1. Choose Tasks=>Vendor Credit Memos to display the Vendor Credit
Memos window.

2. Enter the vendor’s ID in the Vendor ID text box.

After you select a vendor, Peachtree fills in the vendor’s name and Remit
To address. You can see the vendor’s current balance as of the system
date, and you can click the button next to the balance to display a Vendor
Ledger report of the purchases and payment that comprise the balance.

3. Enter a date in the Date text box, and then enter a credit number in
the Credit No. text box.

For the Credit No. text box, we suggest that you enter the original invoice
number followed by CM to indicate credit memo. This numbering scheme
helps you tie the credit memo to a particular purchase.

4. On the Apply to Invoice No. tab, click the Apply to Invoice No. drop-
down list, select the invoice number of the purchase for which you
are recording a credit memo.

Peachtree fills in the lines that appear on the purchase.

5. On each line of the Apply to Invoice No. tab, in the Returned text box,
type the quantity you want to return (see Figure 5-11).
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If you plan to return everything, you can click drop-down list arrow on
the Return button and select All to have Peachtree fill in all the amounts
for you.
Apply Invoice No. tab
Vendor Credit Memos B[]
’EEQ *‘h%'vr Open 52\‘7? Dgle H%m‘ J!J!glﬂn lete J%al %'
Vendor D Vendor Credit Memo
RemitTo: ;:eﬁ\:: ole Nursery Date:
Suite 7. Credit No.: | A-6411-CM
Duluth, GA 30084 USA
Terms Return Authorization AP Account
[ [2] [ ]
Apply to Invoice No.: A6411 v Iappiy to Purchases: 0.00 1
Item Quantity Returned Description GL Account  Unit Price Amount Job
] SERL 31D | 10000  100.00 ] Catelog = 101034 Sunfloner Seeds [1200000 | 0.55 5500 |

Figl,lre 5-11: SEcR3200 | 2500  25.00 Catolog = 101130
Applymg SEGR-32110 |  150.00 0.00l}log =: 101140: Fire Fescue Seeds | 1200000 | 9,55 |

Kentucky Blusgrass See{ 1200000 | 7.95 19875 |

a vendor I I i i i
credit
Other Applied Payments 0.00 253,75 Credit Total
memotoa || . B s oo Apcied i ke O
Vendor Balance on Mar 15, 2007 14,577.95
purchase.

E—— Maximize your results with help from Peachtree experts,

If you are returning a serialized item, click the Serial No. button to dis-
play the Serial Number Selection dialog box and identify the serial num-
bers you are returning. Select the check box next to the number(s) you
are returning and click OK.

If you are using Automatic Decimal Entry, remember that you have to put
the decimal-zero after the whole number, or Peachtree adds the leading
decimal: To get 9, type 9.0. Peachtree fills in the amount (unit price times
quantity).

6. Click the Save button to save the transaction.

Peachtree records the transaction; if you print your Aged Payables
report, you'll see that the purchase no longer appears on the report.

“&N\BER If you aren’t applying the credit memo to an existing purchase, make sure
& that the credit memo you enter on the Apply to Purchases tab of the Vendor
Credit Memos window mirrors the purchase you entered originally; that is,
the credit memo should affect the same things (vendor, general ledger
accounts, and inventory items) that the original purchase affected.



Reporting on Purchasing

To keep things short and sweet, Table 5-1 provides you with a description of

the reports that pertain to buying goods. Chapter 15 covers the details on

how to print reports.

Chapter 5: Buying Goods

Table 5-1 Reports Related to Buying Goods
Report Name What It Does
Vendor List For each vendor, lists the ID, name, contact name,

telephone number, and tax ID.

Vendor Master File List

Similar to the Vendor List report, but also includes
address information and terms.

Vendor Ledgers

Shows the transactions and a running balance for
each vendor.

Purchase Order

Lists the details of all purchase orders by purchase
order number.

Purchase Order Register

Lists purchase order numbers, dates, vendor IDs,
and amounts; optionally use the PO State on the
Filter tab to display only open purchase orders.

Aged Payables

Lists outstanding invoices by vendor and the age of
each outstanding invoice.

Purchase Journal

Shows the accounts Peachtree updated for each
purchase in the period.

Purchase Order Journal

Listing only purchase orders, this report closely
resembles the Purchase Journal.

Items Purchased from
Vendors

Lists, by vendor, the item ID, description, quantity,
and amount of each item purchased from each
vendor. If you sort the report by vendor name or 1D,
you can drill down to view the transactions in the
transaction window.

Visit this book’s Web site for more information on Peachtree.
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Chapter 6
Paying Bills

In This Chapter
Paying a group of bills

Generating checks and reports

Paying one bill at a time

Creating recurring transactions

Tracking payments and voided checks

Remitting sales tax

A Ithough we wish things were different, the facts are simple: You can’t hold
those bills indefinitely . . . eventually, you have to pay them. If you prefer
to let the bills pile up awhile, you can enter them gradually and pay all bills due
by a certain date on your bill-paying day. Occasionally, you may need to pay
only one or two bills or write a check to cover an unexpected expense — you
know, the UPS person is standing there waiting for a check to cover the COD
package in your hand.

Peachtree helps you pay groups of bills all at once or pay individual bills on
the spur of the moment. You can make repetitive payments easily. And when
you have to void checks or pay sales tax on all those goods you’ve sold,
Peachtree helps you keep all the amounts in the right accounts.

Terminology alert: Peachtree tends to switch back and forth between two dif-
ferent terms when referring to bills that vendors send you: a purchase and an
invoice. For the sake of clarity, we use the term purchase (or bill) unless the
screen uses the term invoice. For our purposes, invoices are things you send
to customers so that you can get paid.
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Paying a Group of Bills

s

|
Figure 6-1:
Select bills
to pay in the
Select for
Payment —
Filter
Selection
dialog box.
|

Most people sit down on a regular basis — say every two weeks — and pay
all bills due by a certain date. They hold the bills that are due later until the
next bill-paying day. In Peachtree, you can select all bills due by a certain date,
or you can select bills for certain vendors or greater than an amount you
specify. Then you can simply tell Peachtree to write the checks and bid your
bundle good-bye.

Before you start paying your bills, you may want to print the Aged Payables
report and the Cash Requirements report to get a handle on the outstanding
purchases you’ve entered into Peachtree. (See Chapter 15 for information on
printing reports.) By reviewing these reports, you can determine whether you
need to pay a group of bills or just a few bills. To pay a group of bills, you use
Peachtree’s Select for Payment window. (To pay just a few bills or to pay a bill
from an occasional vendor that you don’t want to set up in Peachtree, see
“Paying One Bill at a Time,” later in this chapter.)

Using the Select for Payment window, Peachtree looks for purchases you've
entered that are eligible for payment based on criteria you provide. You can
use this window only to pay bills you've entered previously as purchases. (See
Chapter 5 for help entering bills.) To pay a group of bills, follow these steps:

1. Choose Tasks-Select for Payment.

The Select for Payment - Filter Selection dialog box appears, shown in
Figure 6-1.

Select for Payment - Filter Selection

QDK Check Date: Jan 19,2007 [
Cancel Invoices Due Beforer |Feb 2, 2007 f
Help or Discounts Lost By ban 19, 2007 f

Include Invoices
& Alllnvoices
" Onlylnwoices [0 daps past Inv. Date

with halances over: 0.00

Inchude Yendaors

& Allendors
" From: ,7
T ’7
Type Mask:

™ Always Take Discounts regardiess of due date
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2. Set the Check Date.
Most people use today’s date.

You can enter just the month and the day; Peachtree automatically uses
the current year established by your computer’s clock. If you enter only
the day, Peachtree automatically uses the month and year established
by your computer’s clock.

3. Use the Invoices Due Before date to set a cut-off date for purchases
that you want to pay.

Peachtree does not select any purchases due after the date you enter in
this box.

Peachtree calculates the due date when you enter the bill by using the
terms you established for the vendor. So the due date typically is not the
same as the date you entered the bill and usually is 30 days later. We
suggest that you set the Invoices Due Before date equal to a date that
falls just before your next bill paying date. That way, you won’t be late
paying bills.

4. Set a date for the Or Discounts Lost By box if your vendors offer you
discounts for paying by a specified date.

If you don’t get vendor discounts, this date doesn’t matter.
5. In the Include Invoices section, select the range of invoices to include.

If you set dates in the preceding steps, you typically click the All Invoices
option. However, you can click the Only Invoices . . . Days Past Inv. Date
option and specify a number of days. In the With Balances Over box, you
can also filter the invoices to only those more than a specified amount.

6. In the Include Vendors section, make your choices regarding payees.

You may want to simply include All Vendors, but you can choose to
include a range of vendors by entering the Vendor ID in the From and To
boxes, or the Vendor Type in the Type Mask box, or both the ID and Type.

7. If you always take discounts offered by vendors — even if you’re
paying later than the discount date — place a check mark in the
Always Take Discounts Regardless of Due Date check box.

8. Click OK.

Peachtree displays the Select for Payment window you see in Figure 6-2,
displaying purchases that meet the criteria you just specified.

Peachtree initially displays the bills in Invoice Date order, but you can change
to Due Date order or Vendor order using the Sort By list box. Peachtree also
selects a cash account to use to pay the bills and a discount account to use
for any discounts you take, but you can select different accounts using the
Lookup list indicator (magnifying glass) next to the appropriate fields.
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Sort by list box

Select For Payment
Nyl O % 2
Close”  Select P’liﬁ v Al All ‘5’5?5\ gﬁp
Check Date: | Cash acct: [10200 Discount Acet [B9500-00 Sort By [Inv. Date =
These Invoices are: 1) For all Invoice amounts 2] For all Yendors 3] and Discounts expire on the discount date.

Inv. Date DueDate Yendor Name Invoicett Balance Discount &mt | Pay Amount  |Pay
Dec 2, 2006 Jan 1, 2007 Arbor Wholezale Supplq 93238-01 141250 141250
Dec 8. 2006 Jan B, 2007 Jones Auto Repair AB-12985 B30.25 530.25 | A
Dec 15,2006 | Jan14. 2007 | Gunter, ‘Wilson, Jones, § 121501-B E&0.00 £50.00 | G|
Dec18 2006 | Jan 17, 2007 | Southem Garden \whold LL-150236; 1.150.00 1.150.00 | A
Jan 2. 2007 Feb1, 2007 Southem Garden Whalg 5G-11010 7.200.00 —
Jan 3, 2007 Feb 2, 2007 Caldwel Tools Company C1280 3498.75 _
Jan 3, 2007 Feb 2, 2007 Southern Garden Whold 5G-12230 1578.25 =
Jan 9, 2007 Feb 8, 2007 Juan Motar Tools & Tire| JMG414 3.568.00 71.38 349762 [
Jan 8, 2007 Feb 8, 2007 Southern Garden \Whalg 5G-12300 16.144.25 ) |

Reagular Checking Account Balance:
Total Checks:

Balance After Checks:

]

When the entire line for a bill appears gray, that entry is a purchase for which
you have not yet received a bill (the check mark remains in the Waiting for Bill
check box on the purchase). Peachtree won't let you pay these purchases. If
you think the entry should be eligible for payment, close the Select for Pay-
ment window and edit the purchase to remove the check mark from the
Waiting for Bill box. See Chapter 5 for more information.

Peachtree assumes that you want to pay all the bills it displays, but you can
choose not to pay any bill by removing the check mark in the Pay column, as
we did in Figure 6-2. If you allow Peachtree to calculate balances automatically,
it updates the numbers that appear at the lower-right corner of the window.

If you don’t allow Peachtree to recalculate balances automatically, you see
Uncalculated in the lower-right corner of the window. You can recalculate bal-
ances in this window only by clicking the Recalc button ($). If you want to
recalculate balances in all windows, go to Bonus Chapter 1 on this book’s
Web site.

On the toolbar at the top of the window, you can click the drop-down arrow
on the Print button and click Report to print a report of the bills you've
selected to pay. The report sorts the bills by vendor, as shown in Figure 6-3.

You also can preview the checks as they will look when they print if you click
the drop-down arrow on the Print button and select Preview.
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48004 w1 12:48:27 .90 Page: 1
Bellwether Garden Supply
Select For Payment Preview Report
As of Mar 15, 2007
Fifter Critefia includes: 1) For al Invoice amounts 2) For al Viendors 3) and Discounts expire on the discount date ) Bark Account 10200 5) invoices Due Before: 2207 ) Discounts Lost By 1/1907.
FRepert ordar is by Viendor 1D,
Vender 1D Invoices Inv. Date Due Date Balance Disc. Date Discount Amt Pay Amount  Pay Method
Vendor
DEJULIA 832381 12208 M7 141250 121208 141250
Arbor Wholesale Suppliers.
141250 141250
GARY 121501-BGS 121506 nan? 650.00 1212506 65000
Gunter, Wilson, Jones, & Smit
650.00 650.00
JuAM AB-12885 128008 1eoT 650,25 1205 660,25
Jones Auto Repair
690.25 £90.25
SOGARDEN LL-15020684 THB0E 7T 1,150.00 12028008 1,150.00
‘Southern Garden Wholesale _ - _ _
1,1%0.00 1,150.00
Reoport Totals: 3,502.78 390275
Number of Checks: 4
Beginning Account Balance: H2076.85
Total Amount of Payments: 350278
Ending Account Balance: 308,173.80

The Print button also has a Postage option that you can use to buy postage
online at Stamps.com. Using Stamps.com requires software available on the
Peachtree CD-ROM or from Stamps.com. Stamps.com is a fee-based service
you can use to print postage from your computer.

If you highlight any line in the window and double-click or click the Detail
button, you can see but not edit the details for that line. Click the Select
button to change the bills you selected, and Peachtree redisplays the dialog
box your saw in Figure 6-1.

Printing Checks

As you would expect, Peachtree supports printing checks on your computer’s
printer. You must order check stock with the correct bank information on it.
You can order checks from Peachtree. Look for the check ordering informa-
tion inside the box with your Peachtree software, in Help (click the Contents
tab and open the Peachtree Products and Services book), or on Peachtree’s
Web site at www.peachtree.com.

You can also ask your local forms supplier if they have purchase check forms
that work with Peachtree and your printer.
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Whoever supplies your checks can also supply window envelopes. Using these
envelopes will save you time when paying bills because you won'’t need to use
labels or address envelopes.

When you click the Print button in the Select for Payment window (see the
preceding section for details on displaying this window), Peachtree starts the
printing process. Follow these steps to complete the process:

1. Establish the starting check number.

Peachtree suggests a starting check number that you can change if Peach-
tree suggests an incorrect starting number. Peachtree assigns the starting
number to the first check you print and subsequent numbers to subse-
quent checks when Peachtree posts your checks. If you had numbers
preprinted on your check stock, make sure that the check(s) you print
and the check(s) Peachtree posts both use the same check numbers.

2. Select a check form from the Print dialog box.

The form should match the type of check form you purchased. You can
customize Peachtree’s forms; see Chapter 13.

On the check stub, most of Peachtree’s check forms print purchase
information such as the invoice number, date, and amount, but you can
print the details of the items you bought (each line item that appears on
the purchase) instead if you choose the OCR — MultiP AP 1 Stub Detail or
OCR - MultiP AP 2 Stub Detail form.

3. Choose the number of copies you want to print.
4. Click Print.

You can click the Practice button to print a practice check. On practice
checks, Peachtree prints a check filled with Xs and 9s that you can use
to determine if the form alignment is correct.

Peachtree prints the checks and a message appears on-screen asking if
the checks printed correctly. If you choose Yes, Peachtree assigns the
check numbers and posts the checks. If you choose No, Peachtree doesn’t
assign the check numbers or post the checks; you can print them again.

Paying One Bill at a Time

Occasionally, you need to write only one or two checks. You know, you went
to the office supply store and bought a box of copy paper, and you paid for it
with a check. Now you need to record the check. You certainly don’t want to
enter a purchase and then pay the purchase using the Select for Payment
window. To print or record a single check, use the Payments window. Essen-
tially, you use the Payments window in three situations:
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v You don’t need to print a check — you just need to record that it was
written.

v You don’t have many checks to write.

v You need to write a miscellaneous check, like a refund check to a cus-
tomer or a loan check to an employee.

From the Payments window, you can print checks that pay bills, print checks
without first recording bills, or simply record checks you wrote manually. For
example, suppose that it’s bill-paying day and you have only two bills to pay.
Use the Payments window to print checks to pay the bills. Or, suppose that the
UPS guy is waiting for a check for a COD purchase. You can print the check
from the Payments window without first recording a purchase. Or, suppose
that you enter the telephone bill in the Purchases/Receive Inventory window,
intending to pay it on bill-paying day. Then you change your mind because
you're going to be at the phone store anyhow, and you want to bring a check to
pay the bill. Use the Payments window to record the check you wrote manually.

You can use the Write Checks window to produce a single check, but do not
use this window to write a check that pays a bill. If you entered a bill for a
vendor, pay the bill by using either the Select to Pay window or the Payments
window. We're not overly fond of the Write Checks window, because you won’t
see any warning if you select a vendor for whom a purchase exists, enabling
you to accidentally write a check to pay a bill without applying the check to
the bill. For this reason, we strongly recommend that you use either the
Select to Pay window to pay a group of bills or the Payments window to pay
a few bills or write miscellaneous checks, and just ignore the existence of the
Write Checks window.

From the Payments window, you can pay vendors you’ve set up, or you can
write a check to someone you haven’t set up in Peachtree. You also can use
this window to issue an employee loan or (heaven forbid) write a refund
check to a customer. Follow these steps:

1. Choose Tasks=>Payments to display the Payments window.
2. Select a vendor or type a name in the Pay to the Order of box.

If the vendor doesn’t have any unpaid purchases, or if you don’t select a
vendor but instead type a name in the Pay to the Order of box, Peachtree
displays the Apply to Expenses tab shown in Figure 6-4. Fill in the quantity
and, if appropriate, select an item. If you don’t select an item, fill in the
description, supply the GL account if necessary, and type a unit price.
Peachtree calculates the amount. If appropriate, assign the line to a job.

You can include payments that you assign to jobs as reimbursable
expenses on customers’ bills. See Chapter 7 for more information.



104 Partii: The Daily Drudge

|
Figure 6-4:
Use the
Payments
window to
post (and
optionally
print) a
single
check.
|

|
Figure 6-5:

If the
vendor has
outstanding
bills, check
the ones
you want

to pay.
|

= Payments SiE]
Ny I G o 2 SR = &
Cliése “New Open o= Hé?gr Fow " SeralNo J%a\ A ?\p
Payment
Belwether Garden Supply Check Number:
Date: | Mar 15, 2007 |u Cash Account

[iencarm [ [Paris ] s 10200 o

Regular Checking Account

Seventy-Five and 00/100 Dollars
Pay to the e
- ash Account Balance
Lavrencevile ENEES
UsA. Memo: [BEL00Z |
T Apply to Expenses: 75.00 1 O
Quentity Item Desaription GLAccount  UnitPrice Amaunt Job
| Removal of dead tree [7es0000 ] 0.00 75.00 |

Secure remote access to your key business data.

If you select a vendor and the vendor has outstanding purchases,
Peachtree displays the Apply to Invoices tab, listing all unpaid pur-
chases for the vendor (see Figure 6-5). Place a check mark in the Pay
column next to all purchases you want to pay. Peachtree displays the
dollar amount on the check face.

You can partially pay the purchase by typing an amount in the Amount
Paid column on the line of the purchase you want to pay.

= Payments ot

i

- . aF . W = = 2, =
$§ = %' e T Pin T Dﬁ!te n%r ‘B&;\ J%a\ E?;ﬂ %

un

Payment

Bellwether Garden Supply TR
Date: [Mar 15, 2007 |5 Cash Account
vendor D | w] [ CALDWELL 4] s 10200 Q]
Regular Checking Account
Eighteen Thousand Seven Hundred Sixty-Eght and 85/100 Dollars
Pay to the ATt
- ash Account Balance
Order of: 3356 Steve Reynolds Place 2
Narcross ENEE]
Ush Memo: [HPF367
Apply to Invoices: 18,768.85 T 200l to Expenses: 0.00 | O
Invoice DateDue  AmountDue Description Discount__ AmountPsid Py
c1280 Feb 2, 2007 3,438.75 5,428.75 ||
c1s50 Feb 23,2007 15,270.10 15,270 10 | LA
c1563 Mar 10,2001 2,445.25 [=]
51004 apr 3, 2007 0.00 [=]

Discount Account | 89500-00 [=%

Secure remote sccess to vour kev business data,
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You can display the purchase shown on any line. Double-click the pur-
chase, and Peachtree displays it in the Purchases/Receive Inventory
window where you can edit it.

3. If you don’t intend to print the check, type the Check Number.

For example, if you're recording that check you wrote at the office supply
store for the box of copy paper, you have no reason to print the check, but
you must enter it. For this situation, enter the check number.

“‘QN\BEI? By default, Peachtree supplies a check number for any check you print. If
& you enter a check number in the Payments window for a check you intend
to print, Peachtree prints the word Duplicate on the check face — and you
don’t want that to happen. Therefore, leave the check number blank if you
intend to print the check.

If you're a Type A personality who insists on completing all empty boxes
on a screen, you can suppress the printing of the word Duplicate by cus-
tomizing the check form. See Chapter 13 for details.

4. At the top of the screen, supply a date for the check.

5. In the right column, select the Cash Account from which you want to
write the check.

6. Depending on whether you enter a check number in Step 4, continue
by clicking Save or Print.

If you included a number in the Check Number box, click the Save
button to save the check.

If you didn’t include a number in the Check Number box, click the Print
button to print the check immediately. Peachtree displays the Print Forms
dialog box, which we cover in the “Printing Checks” section earlier in this
chapter. Select Print; when you finish printing checks, Peachtree assigns
the check numbers and posts the checks.
¥ If you prefer to keep working and print a batch of checks later, click Save to
post your checks without assigning check numbers to them. See Chapter 13
for details on printing checks in batches.

Editing Payments

From an accounting perspective, there’s little reason to edit a payment. In the
real world, however, you’ll come up with a reason — such as, you recorded
that check for office supplies and typed the wrong amount, which you noticed
when you were about to file the receipt. You edit payments the same way you
edit purchase orders and purchases, which we describe in Chapter 5. In the
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Payments window, click the Open button to display the Select Payment
window, which lists all payments you recorded. Highlight the transaction you
want to edit and click OK. You also can erase checks. We talk more about that
in the section on voiding checks later in this chapter.

Handling Repeat Bills and Payments

\\3

Suppose that you pay a bill — such as your rent or your health insurance —
every month for the same amount. Peachtree lets you set up recurring
purchases or payments. You enter the purchase or payment once and tell
Peachtree how often to record the transaction. Recurring transactions save
you data-entry time.

You set up recurring purchases and recurring payments in the same way; the
only difference is the window you use. To set up a recurring payment, start in
the Payments window.

Recurring transactions affect the general ledger. In accrual-basis companies,
both recurring purchases and recurring payments affect the general ledger.

In cash-basis companies, only recurring payments affect the general ledger.
Therefore, if you enter a recurring transaction, Peachtree updates the general
ledger in the appropriate period; if you print future period reports, you will
see the effects of the transactions in those future period reports. As you would
expect, though, Peachtree displays each period’s balances accurately for that
period.

Use recurring purchases when you expect to print a check to pay a bill. If you
don’t expect to print a check — perhaps your health insurance company auto-
matically deducts its payment from your checking account — use recurring
payments.

To set up a recurring purchase, follow these steps:
1. Choose Tasks>Purchases/Receive Inventory to open the Purchases/

Receive Inventory window.

2. Set up the purchase (select the vendor, and so on), but don’t assign an
invoice number.

You may want to click the Waiting on Bill box so that you don’t acciden-
tally pay a future bill before it becomes due.

3. Click the Recur button on the toolbar.

Peachtree displays the Create Recurring Journal Entries dialog box (see
Figure 6-6). Don’t let the name scare you.
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Create Recurring Journal Entries

oK You can save this journal entry in this AND future accounting

(el zave thiz entiy, the first one being the curent period.
M Mumber of Times [12° ‘when to Recur

periods. Do this by entering the number of times [periods) to

 Weekly
F ™ Biwfeskly
Begin with #: &+ Monthly
[zo07 o1 " Per Period
© Quarterly
" Yearly

4. In the When to Recur list, select the frequency you want.

5. In the Number of Times box, type the number of transactions you want

to enter for the time frame you chose in Step 4.

For example, if you're going to make a payment every week for 7 weeks,

choose Weekly from the When to Recur list and type 7 in the Number of
Times box. If you're going to make the payment every month for one year,
choose Monthly in the When to Recur list and type 12 in the Number of

Times box.

You can create recurring purchases and payments that extend to the end
of the last open period, but not beyond. Peachtree allows you to have
two years open (usually 24 months).

. In the Begin with # box, assign a starting number for the recurring

purchase.

If you want, set up a prefix for the bill. In Figure 6-6, we added the year
and a dash to the number to make Peachtree start each purchase it cre-
ates for this recurring transaction with 2007-. Peachtree adds an incre-
mental number, starting with 01. Because we created 12 transactions,
Peachtree numbers the last recurring purchase as 2007-12.

. Click OK.

You can hear some activity on your hard disk while Peachtree creates
the transactions. Then Peachtree redisplays the Purchases/Receive
Inventory window, ready for you to enter your next purchase.

If you open a recurring purchase, take a minute to notice a couple of interest-
ing things:

v You can see multiple entries for the recurring transaction in the Select

Purchase window. For example, if on April 1 you set up the payment to
recur weekly for seven weeks, look for at least four or possibly five
entries in April. If you set up the purchase to recur monthly, you need to
use the Show list box in the Select Purchases window to display All
Transactions or a future period.
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v When you display the recurring purchase in the Purchases/Receive
Inventory window, look at the bottom of the window for an entry telling
you how many more entries exist.

v When you save an edit to any recurring transaction, Peachtree prompts
you to save the change for the current entry or the current entry and all
remaining entries.

v In the Payments window, when you select a vendor for whom you set up
a recurring purchase, you see lines for all recurring purchases, regard-
less of the period. Remember, you can double-click any line and view or
edit the purchase in the Purchases/Receive Inventory window.

1 When you click the Edit button in the Payments window to display the
Select Payment window, recurring payments don’t have reference num-
bers like recurring purchases do. The Reference number for a payment
is the check number. Peachtree leaves the number blank so that you can
print a check for the payment. If you write the check by hand, edit the
payment and assign a check number.

Voiding Checks

If you write a check and then discover a problem with the check, you can void
it. When you void a check, Peachtree creates a negative check for the same
amount as the check you void, but the value of the voided check increases your
cash account — remember, the original check reduced your cash account. In
other words, if you add the two transactions, you get 0 (accountants say the
transactions “Net to 0”), and a $0 transaction causes no change in your cash
balance. The voided check transaction that Peachtree creates has the same
number as the original check, but Peachtree adds a V to the number; that is, if
you void check 101, Peachtree creates check 101V. You can view (and edit) the
voided check in the Payments window the same way you can view and edit any
other payment.

To void a check, follow these steps:
1. Choose Tasks- Void Checks to display the Void Existing Checks window

shown in Figure 6-7.

2. If necessary, click the lookup list indicator to choose the cash account
from which you wrote the check that you now want to void.

3. Enter the Void Date for the check.

Be sure this date falls in the period that you want the cash account
increased, which is not necessarily the same period that the check was
written.
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Void Existing Checks
Accourt|D; [10200 Void Date: [Mar 15, 2007 [&]
Mumber | Date | Sowce | Amount | Payes |

1020 3IN207 AP 124.68 Clooney Chemical Supply

10202 31207 AP 360.00  Gary, Wilson, Jones, & Smith

10203 31207 AP 850.00  Mils Leasing Corp.

10204 3207 AP 336,60 Daniel Lawn Pro, Inc.

10205 3407 AP 147.00  Gwinnett County License Board

10206 31407 AP 27466 Juan Motor Tools & Tires

10207 311407 AP 550.00  Mils Leasing Corp.

10208 31407 AP 25064 Southern Garden ‘Wholesale

10209 3407 AP 500,00 Jackson Advertising Company

10210 3507 AP 530,64  Safe State Insurance Company
Yaid Clase Help

4. Highlight the check you want to void and then click the Void button.

Peachtree displays a message asking whether you're sure you want to
void the check.

5. Click OK, and Peachtree creates a voided check transaction.

You can sort the checks in the Void Existing Checks window in different ways
to help you find the check you want to void. Click any of the column headings
in the window to sort checks by that column heading.

If you accidentally void the wrong check, open the Payments window and click
the Edit button. You can find the voided check in the window — the check
number ends with a V for Void. Highlight that transaction and click OK to dis-
play it in the Payments window. Then delete it by clicking the Delete button.

After you void a check, you can see both the original check and the voided
check transaction in the Account Reconciliation window when you balance
your checkbook, and Peachtree has already marked them both as cleared.
For more information on balancing your checkbook, see Chapter 16.

When you void a check that paid a vendor bill, Peachtree reopens the vendor
bill. That is, Peachtree assumes you still want to pay the bill. If you do want
to pay the bill, simply use the Payments or the Select for Payment window. If,
however, you don’t want to pay the bill, enter a vendor credit memo for the
bill. Chapter 5 has more information on creating vendor credit memos.

Paying Sales Tax

Most states expect customers to pay a sales tax on goods they purchase; in
some states, customers also pay tax on services. In addition, the county or
local government may also assess a tax on customer’s purchases. If your
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business sells taxable goods, you collect the sales tax for at least one taxing
authority. Then, of course, you're expected to remit the sales tax to the taxing
authority — along with a sales tax return (so that they can make sure that
you're not cheating them out of any of the sales taxes you collect).

Paying sales tax in Peachtree is no different than paying any other bill; you
can enter a purchase to remind yourself that you owe the money or you can
simply write the check. The tricky part? Finding out how much to pay because
not all sales are taxable in every state. And when the sales are taxable, local
taxes might apply as well. To complicate the issue further, if you operate your
business close to a border between jurisdictions, your business may be col-
lecting taxes for more than one jurisdiction — and at different rates.

If you set up your sales taxes correctly (see Chapter 7 for more information),
you can use the Taxable/Exempt Sales report (see Figure 6-8) to help you pre-
pare the sales tax return and remit your sales taxes. Select Reports=>Accounts
Receivable to print this report, which breaks down the taxes you owe by taxing
authority.

If you set up multiple exempt categories as described in the Inventory Prefer-
ences section Chapter 4, customize this report to add a column for the Tax
Type, as we did in Figure 6-8 so that the report lists and identifies the totals
for each exempt category that you need for the sales tax return. See Chap-
ter 14 for help customizing reports.

1% Taxable / Exempt Sales B2
y bE BE B o B @ = piw O BR OB -
’EEQ Save [Options  Hide Erint S%p E-mail Preview Eﬁgn Find  Ewcel P %
Bellwether Garden Supply ~
Taxable f Exempt Sales =
For the Period From Mar 1, 2007 to Mar 31, 2007
Fiter Criteria includes: Report is printed in Summary Format.
Authority 1D Authority Description TaxRate Taxable Sale Tax Amount ExemptSales Total Sales Taxable Type
CHEROKEE Cherokee County Sales Tax 5998 59.98 Total for Exempt
CHEROKEE Total Cherokee County Sale 59.98 59.98
coBB Cobb County Sales Tax 2.00000 11.310.02 22621 11,310.02 Total for Regular
coBB Cobb County Sales Tax 949 7! 94975 Total for Exempt
cosB Total Cobb County Sales Ta 11,310.02 226.21 12,25877
FULTON Fultan County Sales Tax 2.00000 16,980.43 33961 16,8043 Total for Regular
FULTON Fulton County Sales Tax 5429.93 5,429.93 Total for Exempt
FULTON Total Fulton County Sales T 16,98043 33961 542003 2241038
Georgia State Sales Tax 4.00000 61,292.30 245173 61,202.30 Total for Regular
Georoia State Sales Tax 7.469.43 7.469.43 Total for Exempt
Total Georgia State Sales T 61,292.30 245173 746943 6878173
Gwinnett County Sales Tax 2.00000 33,001.85 680.04 3300185 Total for Regular
Gwinnett County Sales Tax 102977 1.028.77 Total for Exempt
Total Gwinnett County Sales 33,001.85 680.04 102977 34031862
Transportation Tax 1.00000 1698043 169.80 16,980.43 Total for Regular
Transportation Tax 5,429.03 £,420.03 Total for Exempt
Total Transportation Tax 16,980.43 189.80 5429.93 2241038
v
< >
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Using Reports to Track
Money You've Paid

When you need to track the outflow of money, Peachtree offers some reports
that help you. Table 6-1 provides you with a description of the reports that
pertain to paying bills. See Chapter 14 to find out how to print reports.

Table 6-1 Reports Related to Paying Bills
Report Name What It Does
Check Register Lists each check with the check number, payee,

the amount, and the cash account from which
the check was written.

Cash Requirements Lists all unpaid purchases and their due dates
for the date range you specify.

Cash Disbursements Journal Shows the accounts that Peachtree updated for
each check you wrote in the period. You can
filter this report for 1099 vendors.

WMBER
é&
&

Visit this book’s Web site for more information on Peachtree.
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Chapter 7
Selling Products and Services

In This Chapter

Setting up sales tax authorities and codes

Creating customer defaults

Entering quotes, sales orders, and invoices
Shipping your packages

Managing sales transactions and invoices

Wlat incredible assets we have in our customers! (Well, most of them
anyway.) After all, we wouldn’t be in business without them, would we?

Peachtree operates under the assumption that you might generate a quote to a
customer, convert that quote into a sales order, and then turn that sales order
into an invoice when you produce the goods or service. You do not, however,
have to use quotes or sales orders to use Peachtree’s invoicing feature.

Even if you don’t use quotes or sales orders, we suggest that you read this
entire chapter. Peachtree’s steps for creating and editing quotes, sales
orders, and invoices are almost identical. Therefore, to eliminate redundancy,
we explain most of the details in one place (see the section, “Bidding with
Quotes™). We show you the differences between entering quotes, sales
orders, and invoices in the individual sections of this chapter.

In addition to talking about the forms you use to sell things to your customers,
we're going to start by talking about another important selling issue — sales
taxes.

Working with Sales Taxes

Everyone hates to pay sales tax; taxes make us feel like we're paying more
for our purchase than we should. Like it or not, though, most states expect
customers to pay sales tax, usually on goods, but occasionally on services or
freight as well. If you run your business in a locality that charges sales taxes,
you, as the seller, are obligated to collect the sales tax from your customer.
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Vielding to the authorities

If your business sells taxable goods or services, you collect the sales tax for
the taxing authority — that’s the term Peachtree uses to identify the agency
that has the right to tell you to collect sales tax from your customers. That
authority could be only your state government but frequently other local
agencies are involved as well.

For example, suppose that your state along with several counties in your
state charge a sales tax. In this case, you need to set up Sales Tax Authorities
for your state and for each county as well.

Most states base the tax amount on the total invoice amount, but some states
base their sales tax on the individual line item amount. Peachtree provides
the ability to calculate sales taxes using a variety of methods. Table 7-1 illus-
trates the different scenarios in which your state might calculate sales tax.
(Of course, if your state doesn’t have sales taxes . . . feel free to avoid this
table completely.)

Table 7-1 Sales Tax Scenarios

Scenario What It Does

Single tax rate Applies the standard tax rate on all sales regardless of
amount.

Maximum dollar Applies the standard tax rate up to a ceiling amount. After

sales that, no more tax is calculated. For example, if the tax is 3%

on the first $4000 of a sale and the sale is $5000, only $4000
is taxed at the 3% amount. The remaining $1000 is untaxed.

Minimum dollar Applies the standard tax rate only when sales reach a
sales specified amount. For example, if the minimum taxable sale
amount is $500, a sale of $450 it is not taxed.

Maximum dollar tax ~ Applies the standard tax rate until the tax reaches a
maximum amount, and then no more tax is calculated on
that sale. For example, if the tax rate is 2%, with a maximum
dollar tax of $20, sales up to $1000 are taxed at the 2%
amount, but sales of $1000 and more are taxed a flat $20.

Maximum percent ~ Applies the standard tax rate to a specific maximum
sales amount percentage, less than 100%. For example, the tax rate might
be 3% but it applies only to 75% of the sales price.

Each taxable line Calculates the tax rates on each line item, instead of
item applying the previous tax rates to the grand total of the order.
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Suppose that your business is located in the state of Georgia and that the state
charges 4 percent sales tax for goods up to $999.99 and 3.5 percent sales tax for
sales $1000.00 and over. You pay the tax to the Georgia Department of Revenue.
If you have a branch of your business located in Brown County, Georgia, which
has its own local tax, you have to charge those customers the additional local
tax — say, 2 percent — which, in turn you pay to the Brown County Treasurer’s
office. If another branch is located in Green County, Georgia, another locality
with a tax, the customers at that store have to pay an additional, say, 2.5 per-
cent, which you turn over to the Green County Treasurer’s office. In this situa-
tion, you have three taxing authorities: the State of Georgia, Brown County, and
Green County.

What if you pay two or more of your taxes to the same payee? What authori-
ties should you create? In that situation, you still should set up three differ-
ent authorities. Doing so allows you to determine the exact amount of tax
collected for each locality tax on Peachtree’s Sales Tax report.

Before you set up the Sales Tax Authorities codes, you must set up a vendor
to whom you remit the sales tax. You can find out how to set up a vendor in
Chapter 5.

To follow this exercise, you must have a vendor set up; we will use Georgia
Department of Revenue as the vendor name in this example. To set up Sales
Tax Authorities, follow these steps:

1. Choose Maintain~>Sales Taxesr>Sales Tax Authorities to display the
Maintain Sales Tax Authorities window.
2. Type an ID for the authority.

You can use up to eight letters or numbers (alphanumeric characters).
For our example, use GEORGIA.

3. Type a description of the authority.

You can type up to 30 characters. We typed Georgia State Sales Tax for
our example.

4. In the Tax Payable To box, type or select the vendor ID to which you
remit this sales tax.

This step assumes that you have set up the tax payee as a vendor, as
mentioned at the beginning of these steps. For our example, we chose
the Georgia Department of Revenue.

5. Enter the G/L liability account to which you want to post the sales tax
you collect.
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6. Enter the tax rate, or select the Formula option and enter your sales
tax calculation method.

If your state charges 4 percent, type 4.00; if it charges 5.5 percent, type it
as 5.50. Peachtree automatically converts this value to a percentage.

7. Click Save.
8. Repeat Steps 2 through 7 for each authority you need.

Figure 7-1 shows the three authorities for our example.

=O/E

= Maintain Sales Tax Authorities

a=s = H
Cloze §a've Dgte Firn Hgip'

Rates

2.00000
4,00000/3.50000
280000

Account
230
230
23a

'E) Drezcription

EROMWMN Brown County Tax
GEORGIA, Georgia Sales Tax
GREEM Green County Tax

ID: [GEORGIA Description: ‘GEDIQIE Sales Tax ‘

Tax Payable To: |G REVENUE
Sales Taw Payable G/L Account: |2310

Tan Calculation

Georgia Department of Revenue

Sales Tax Payable

" Single Taw Rate:

(¢ Fomula:  Basedon !tntal taxahle sales

99999 charge | 4.00000] %

above that charge 3.50000| %

ﬂ upluSl

Creating sales tax codes

After you determine the sales tax authorities, you need to set up the Sales
Tax Codes. The Sales Tax Codes are made up of combinations of Sales Tax
Authorities. Following along with the example we used in the preceding
section, because your customers in Brown County have to pay a Georgia
State and Brown County tax, those two taxes together make up one Sales Tax
Code for your Brown County branch. The customers in Green County pay
Georgia State tax and Green County tax, so that combination generates the
need for a second Sales Tax Code. You also need a third Sales Tax Code for
those customers who simply pay the Georgia State tax with no county tax
included.

Follow these steps to set up a Sales Tax Code:

1. Choose Maintain->Sales Taxes->Sales Tax Codes to display the Maintain
Sales Tax Codes window.

2. In the Sales Tax Code box, type an ID. In the Description box, you may
type a description.



Chapter 7: Selling Products and Services

\\J

|
Figure 7-2:
Create

a Sales

Tax Code
for each
combination
of tax.
|

Use a maximum of eight alphanumeric characters for the ID. We suggest
you use some type of description, perhaps using GABrown as an ID with
the description Georgia, Brown County.

. Click the box in the ID column and enter the first taxing authority ID

for this tax code.

Peachtree fills in the description, tax rate, and G/L account you assigned
to the selected authority.

This ID text box reveals a little quirk in Peachtree. Generally, if a field
has a lookup list available, the field displays a magnifying glass for you
to click. This one doesn’t. We don’t know why . . . but it doesn’t. So, if
you don’t remember the taxing authority ID, you can right-click the ID
field to display the Sales Tax Authority lookup list. If you double-click
the ID field, the Maintain Sales Tax Authority window opens, allowing
you to create new sales tax authorities.

4. If your state requires you to charge sales tax on the freight you charge
to your customers, place a check mark in the Tax Freight box.
If you add a freight amount in the invoice freight box when you create an
invoice to your customer, Peachtree calculates tax on the freight.
5. Enter any remaining tax authorities for this sales tax ID and then click
Save.
See Figure 7-2 for an example.
6. Repeat Steps 2 through 5 for each Sales Tax Code you need.
7. Click Close.
= Maintain Sales Tax Codes =mE
ool e
Sales Tax Code  Description Tax Freight
GeBrawn Georgia, Brown County
GG ieen Georgia, Green County
Georgia Georgia Sales Tax
Sales Tax Code: ™ TaxFreight

Description: ‘Gemgia, Browin Caunty

The abaove tax code is made up of the following taxing authorities:

1D

Description Rate G/L Account - Description

GEORG!

2

BROWwWN

Total Sales Tax Fate: Farmula

117
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Working with Customers

|
Figure 7-3:
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customers.
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Before you can generate quotes, sales orders, or invoices, you need to set up
your customer defaults and enter the individual customers. In Chapter 4, we
show you how to create the defaults you use here. Peachtree identifies each
customer by a unique ID that allows Peachtree to track any transactions
related to the customer.

Adding customers

When you set up a customer, you supply the customer’s name and address, a
sales account to use each time you post a sale to the customer, credit infor-
mation, and any custom field information you set up in your defaults. You also
can view historical data about your sales to and receipts from your customers
over the previous 12 months.

To add or modify customer information, choose Maintainm>Customers/
Prospects. Peachtree displays the Maintain Customers/Prospects window, as
shown in Figure 7-3. The following sections examine what you can do with
each tab in this dialog box.

The General tab

Peachtree supplies the General tab for basic customer identification informa-
tion, such as ID, name, address, and phone numbers. You use the ID as the
identification to select the customer when you create a customer transaction.
You can enter up to 20 alphanumeric characters (except the characters *, ?,
and +) for a customer’s ID. Peachtree sorts the customer reports by customer
ID. Numbers sort before letters, and because the field is case sensitive,
uppercase letters sort before lowercase letters.

= Maintain Customers/Prospects ===
E= 9 el ca e BE 2 -
‘cﬁg Save Dgle Mo = M= B2 O ng
Custarer ID: [CHAPPLE I~ Prospect
Name: |Chapple Law Offices I Inactive
General || SelesDefauls | TemsandCredi | PaymentDefauts | CustomFieks | Histary
Contact: [Francis Chapple Customer Type:
BiltoAddiess =] Telephone 1: [F706058868 |
Telephone 2 [770-555-8659
Addvess: [12558 Lamnencevile Huy. Fasc [F70565-8360
) £ mal:[ichapple@sample.peachiiee o (&5
City, 57 Zip: [Libum G4 [30085.1120 web St [rompasepmes o[
Counliy
Sales Tay: (GBI Beginning Balances: [+]
Curent Balace an #ipr 4, 2004 [+] 0.00
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To make data entry easier, we suggest that you use either all uppercase or all
lowercase letters so that you don’t need to bother with the Shift key. Peachtree
sorts the Customer List report and many other reports using the Customer ID
by default. To get Peachtree to sort the customer list in alphabetical order by
default, use characters from the customer’s name as the ID.

Choose Maintain=>Customers/Prospects. Peachtree displays the Maintain
Customers/Prospects window. Fill in the General tab by following these steps:

1. Type a Customer ID and the customer’s Name.

You may enter up to 30 alphanumeric characters for the customer’s
name. IDs are case sensitive, so the IDs Baker, BAKER, and baker, for
example, are treated as three different customer IDs.

If you determine that you want a different ID, click the ChangelD button,
type the new ID in the Enter New Customer ID box, click OK, and then
click Save.

2. If you do not want this customer ID included on any customer reports,
click the Prospect check box.

A prospect is a potential customer, one who has not actually bought any
goods or services from you. If you generate an invoice for the prospect
or clear the check box, the prospect becomes a regular customer, and
Peachtree includes the ID on customer reports.

3. Fill in the contact information and phone numbers and, if appropriate,
the E-mail and Web Site addresses.

If you enter an e-mail address and click the icon next to it, Peachtree
opens your e-mail program and generates a message to your customer.
Clicking the button next to the Web address launches your Web browser
and directs it to the customer’s Web site. If you plan to e-mail forms
(quotes, sales orders, or invoices) to your customers, fill in the e-mail
address.

4. Click the drop-down arrow for the Bill to Address box, choose the ship-
ping address you want to enter, and enter the shipping information.

You can store up to nine shipping addresses for each customer.
Whenever you create a quote, sales order, or invoice, you can choose
from the stored shipping addresses, thereby saving data entry time.

We need to discuss two additional fields in this window: the Customer Type
field and the Sales Tax field.

v Customer Type: Use the Customer Type field to group similar customers
together. You can then limit the information on most A/R reports to a
specific customer type. For example, you may want to distinguish
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between commercial customers and retail customers. Being consistent
when entering the customer type is the secret to using the Customer
Type field effectively. The Customer Type field is case sensitive.

1 Sales Tax: You need to choose the Sales Tax Code that applies to this

customer. To do so, type the applicable Sales Tax Code or click the
lookup list button.

If you no longer do business with this customer, place a check mark in the
Inactive box.

The Sales Defaults tab

On the Sales Defaults tab, you can define several additional pieces of cus-
tomer information. Peachtree relates many of the fields on this window to the
inventory and payroll modules:

1.
2.

Choose Maintain~>Customers/Prospects and click the Sales Defaults tab.

If applicable, select a default Sales Rep for this customer and type the
Sales Rep ID or select one from the lookup list.

See Chapter 9 for information on creating sales reps.

. Define a GL Sales Account for the customer if it’s different from the

default account established in Customer Defaults.
For more information about Customer Defaults, see Chapter 4.

When you create an inventory item, you specify a sales account for the
item. When you generate an invoice, the sales account associated with

inventory items overrides the customer sales account. You can find out
how to set up inventory items in Chapter 11.

. In the Open P.O. # box, enter a purchase order number if your cus-

tomer has given you a standing purchase order number to use for all
purchases from you.

This purchase order number appears by default in the Customer Purchase
Order field on the Quotes, Sales Orders, and Sales/Invoicing windows.

. In the Ship Via box, choose a preferred shipping method.

Determine shipping methods in the Maintain Inventory Item Defaults
window. If necessary, you can override the preferred method when you
generate a customer invoice. You set up shipping methods in Chapter 4.

. If the customer does not have to pay sales tax, enter the Resale number.

Most states require a customer to provide you with their resale number
for tax-exempt purchases.
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7. Choose the pricing level most often associated with this customer.

Pricing levels are tied to inventory items. See Chapter 11 for details on
how to assign up to ten prices to each inventory item. Peachtree then
automatically charges the customer the price shown in the pricing level
you specify here.

8. Select a form delivery method.

Forms include Sales Orders, Packing Slips, Invoices, and Statements.

To use the e-mail delivery method in Peachtree, you must have a MAPI-
compliant, default e-mail application installed on your computer. If your
default e-mail system is AOL, you will not be able to send e-mail from

Peachtree because AOL is not a fully MAPI-compliant e-mail application.

Terms and Credit tab

All things not being equal, Peachtree provides the ability to assign different
credit terms to different customers. You use the Terms and Credit tab to
establish the specific terms for the current customer.

Choose Maintain>Customers/Prospects and click the Terms and Credit tab.
Peachtree assumes that each customer uses the default terms you established
when you set up Customer Defaults. To make any changes from the Terms and
Credit defaults, you must first remove the check mark from the Use Standard
Terms and Credit check box. You can then edit the terms, indicating whether
to charge finance charges, change the customer’s credit limit, or determine
whether or how Peachtree should notify you about the customer’s credit limit
status.

Use the Credit Status box to place a customer on credit hold. If a customer’s
status is Always Hold, Peachtree displays a warning message and will not
allow you to save an invoice for that customer.

Payment Defaults tab

The information stored on the Payment Defaults tab is optional. If you accept
credit cards from your clients, this tab provides a place to store the customer’s
credit card number and expiration date.

Options in the Receipt Settings area are time-savers. If the Use Receipts
window settings box is checked, Peachtree uses the payment method and cash
account you selected on the last saved receipt. You might want to change this
setting if, for example, the selected customer always pays by credit card but
the majority of your other customers pay by check.
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Custom Fields tab

When you set up default customer information, (see Chapter 4), you created
the custom fields for the Maintain Customers/Prospects window. To enter
custom information, choose Maintain>Customers/Prospects. Click the Custom
Fields tab and enter the available information for the customer in each custom
field box. Click the Save button to save this information.

History tab

When you first set up a customer, the History tab doesn’t have any informa-
tion. However, after you've recorded customer sales transactions, the History
tab gives you a month-by-month summary of both sales and receipts.

To view a customer’s history, choose Maintainm>Customers/Prospects and
then click the History tab. You can’t edit any information on the History
screen; Peachtree provides it for a quick overview of the customer’s history.

Customers move around, so you may find that the information you’ve stored
about a customer is outdated. You can change any information you entered in
the Maintain Customers/Prospects window. Display the customer’s ID,
change any desired information, and then click Save.

Where to begin? Beginning balances

Chances are, you've been selling your goods and services for a while. And . . .
you probably haven’t been paid yet for all the work you’ve done. You've prob-
ably given your customers a specified amount of time to pay their invoices to
you. You specify your terms when you set up your default customer informa-

tion in Chapter 4.

Although some invoices aren’t due yet, others may be past due. Either way,
the customer owes you money. When you begin using Peachtree, you need to
tell Peachtree about those unpaid invoices, especially if your business is
accrual based. Enter these as customer beginning balances.

Entering invoices as beginning balances does not affect the general ledger. In
an accrual-based business, sales are applied to your general ledger at the time
that you create the invoices.

To enter customer beginning balances, follow these steps:

1. Choose Maintain~>Customers/Prospects.

2. Click the Beginning Balances button to display the Customer Beginning
Balances dialog box.
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. Double-click the first customer for which you need to enter a begin-

ning balance invoice.

Did you think you’d have to recreate your invoices? You don’t. Simply
provide Peachtree with a few key pieces of information.

. Enter the invoice number and the date of the original invoice.

The date is needed so that Peachtree can age the invoice properly.

. Optionally, enter the customer’s purchase order number for the

invoice.

6. Enter the invoice amount.

7. Enter A/R Account number.

The A/R Account is the Accounts Receivable account. Notice, we say
Accounts Receivable. We're not talking about the sales account. It’s a
common mistake to enter the sales account number.

. Repeat Steps 4 through 7 for each outstanding invoice for the selected

customer.

Figure 7-4 shows a sample list of outstanding invoices.

Customer Beginning Balances

/‘.

Close

=

Add Remove  Help

P

Aon A
Save F

Invoices for: ALDRED Aldred Builders, Inc.

] Customer Balances ]

Irmvice Number Date Purchase Order Number Amaunt AJR Account

17423

Nov 26, 2006 210,56 | 11000:00

17541

Dec 10, 2006 1,324,560 | 11000:00

17333

Diec 30, 2006 36.44 | 17000-00

Account Balance: 1.671.50
Number of Transactions 3

Current Accounts Receivable Balance: 164 507 95

9.

Technically, Peachtree has no limit to the number of beginning balance
invoices you can enter for an individual customer. However, if you
exceed 100 invoices, you can enter but not edit or delete the 101st
invoice and subsequent invoices.

Click Save.



124

Part ll: The Daily Drudge

A\

10. Click the Customer Balances tab and select the next customer for whom
you want to enter beginning balances.

11. When you finish entering beginning balances, click the Close button.
Click it again to close the Maintain Customers/Prospects window.

We recommend that you print an Aged Receivables report to verify the
invoice information and dates and a Trial Balance report to make sure that
the Aged Receivables balance matches the GL balance.

Bidding with Quotes
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Many businesses let their customers know how much a product or service
costs by producing a quote before the customer decides to buy. Peachtree
allows you to create a quote; when the customer determines he or she does
want to make the purchase, you can convert that quote to a sales order or
an invoice.

Quotes are optional in the Peachtree sales process.

Entering quotes

The top part of the quote window contains header information such as cus-
tomer name, address, quote number, date, and other such information. Enter
the actual products or services you supply in the body of the quote. In Bonus
Chapter 1 on this book’s Web site, you can find out how to modify the appear-
ance of the Quotes window by using templates.

The steps to create, edit, and print quotes, sales orders, and invoices are
almost identical.

To create a quote in Peachtree, follow these steps:
1. Choose Tasks=>Quotes/Sales Orders~Quotes to display the Quotes
window, as shown in Figure 7-5.
2. Type or select the Customer ID.

You can’t enter a quote in Peachtree unless you have set up a customer.
Peachtree displays the customer’s current balance and credit limit in the
lower-left corner.
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E Quotes 9=
Dy e @ 8 R L8 e =
et i et G 0 o D‘?ene Corvet Fow Motz Jobimal = Terplate Help
Customer ID: [ THURMAN Quote
il To: Thurman Golf Course Design Shi To: [ ship to Address 1 [v Date: [Mar 1, 2007 =]
3501 Northside Drive
Atlanta, GA 30333 Thurman Golf Course Desian Good Theu [Mar 31, 20077
3501 Horthside Drive oot Ha: [ 1798
[ orap Ship
Atlanta |GA ‘30333\
Custarner PO ship Vi Terms Sales Rep AJR Account
[ [Mone [ [z 10, net 30 Davs [cswmTon [ 1100000 [
Quantity Ttem Description GLAccount Uit Price Tax_ Amount Job
10.00 [ EQFF-13t20 Bell-Gra Plant All Purpase | 40000-£Q s 1 9390 |
4,00 | EQL#-14100 Bel-Gra Acrator 5ol Digad 40000-6Q EER 159,96 |
12,00 | FERT-16150 Bell-Gro Manure Mic {Com| 40000-FF 16.99] 1 203.88 |
Sales Tax: 32.46 [GAFLLTON [0
Customner Account a5 of Mar 1, 2007 2] 0.00
Balance: 3,610.33 Freight:
Credit Limit:  50,000.00 Quoke Total: 496.20
Credi: Status: Nokify Over Linit
Maximize vour results with help from Peachires experts,

If you begin typing the Customer ID, only to find you haven’t yet entered
the customer into Peachtree, press the plus (+) key while the insertion
point is in the ID box. Peachtree displays the Maintain Customers/
Prospects window, allowing you to create the customer record. When
you close the Maintain Customers/Prospects window, Peachtree redis-
plays the Quote window. This procedure works for any lookup list you
open in Peachtree. Pressing the plus (+) key opens the appropriate
Maintain window: Vendors, Customers/Prospects, Inventory,
Employees/Sales Reps, or Chart of Accounts.

Type the recipient Ship To address, or click the Ship To arrow and
choose the Bill To address or one of the Ship To addresses you
entered when first setting up the customer.

Peachtree doesn’t store a manually entered ship to address permanently
in the customer record. However, Peachtree does store the custom
address with the current quote and transfers the address to the result-
ing sales order or invoice or both.

Enter the Date you want printed on the quote and an Expiration Date
for the quote.

Peachtree assumes that the quote is valid for a period of 30 days and
prints the ending date on the quote form. If you're giving your customer
a longer or shorter period of time, choose a different date in the Good
Thru date box.
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10.

11.

Peachtree doesn’t do anything to the quote if the customer doesn’t
respond in the specified number of days. The date is simply printed on
the quote form.

. Optionally, enter a Quote Number.

If you're going to print the quote (and usually you do), don’t enter a
quote number because Peachtree assigns the number when it prints the
quote. If you've already assigned the quote a number, perhaps from a
verbal quote, enter the quote number.

If you plan to have your vendor ship the item directly to your customer,
click the Drop Ship box.

It’s unlikely that your customer has given you a purchase order number
for a quote. After all, if you're quoting it, it’s not yet a purchase. You can
leave the Customer PO field blank.

. Optionally, type a shipping method or choose a shipping method from

the Ship Via list box.

. Optionally, change the Terms for this order.

By default, Peachtree displays the terms you chose when you set up this
customer in Maintain Customers/Prospects.

. Optionally, select a Sales Rep ID.

Take a look at Chapter 9 for information on how to set up a sales
representative.

If your business is accrual-based, you can select the A/R Account option
for this potential sale, although typically you shouldn’t change the default.
If your company is cash-based, this field displays <Cash Basis> and you
can’t access the account box. If you have elected to hide general ledger
accounts in A/R, you won’t even see an A/R Account box.

. In the body of the quote, enter the Quantity for the first item on the

quote.

If you're quoting a service or product that doesn’t have a quantity, you
can leave the quantity blank.

If you're selling an inventory item, select the Item ID.

Peachtree fills in the item description, the G/L sales account, the item’s
unit price, and the tax status. Then Peachtree multiplies the quantity
times the unit price for the amount. Read about setting up inventory
items in Chapter 11.

If you'’re quoting or selling a nonstock item or you don’t use inven-
tory, leave the Item box blank and fill in the Description, GL (Income)
Account and Unit Price.
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Peachtree calculates the amount. If you did not enter a quantity in Step 9,
you must enter an amount instead of a unit price. If you enabled Peach-
tree’s spell-checking options, Peachtree flags any typing mistakes as they
happen.

Quotes do not affect the general ledger, but whenever the quote becomes
a sale, Peachtree uses the G/L account numbers to update your financial
information.

If you have globally hidden general ledger accounts, Peachtree does not
display G/L Account fields in the Quotes window. To modify G/L accounts
used for this transaction, you must click the Journal button in the window
toolbar.

12. If you’re quoting a noninventory item, select the Tax status.

The Tax box refers to the tax types you determine when setting inven-
tory defaults. Peachtree uses default tax types of 1 for Taxable and 2 for
Exempt. If you're using inventory items, Peachtree determines the tax
type from the inventory item.

13. You probably won’t have a job number assigned yet because this is
still a quote, so skip the job box.

14. Repeat Steps 9 through 13 for each item you want to quote.

15. If you’re going to charge shipping charges, enter the estimated
amount in the Freight box.

16. Optionally, click the Note button to store one of three different notes.
Choose from a customer note, which prints on the actual Quote form,
a statement note, which prints on the customer statement, or an inter-
nal note, for internal reference only.

If you later convert the quote to a sales order or invoice, the notes con-
vert also.

We're assuming that you need to print the quote; however, if don’t need to
print the quote, click the Save button. Peachtree saves the quote for future
reference. To print or e-mail your quote, click the Print or E-mail button. See
Printing Forms in Chapter 13.

Converting a quote to a sales
ovder or an invoice

Congratulations! You got the sale! Now you’re ready to generate a sales order
or an invoice from the original quote.
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To convert a quote to make the sale, follow these steps:

1. Choose Tasks=>Quotes/Sales Orders~>Quotes to display the Quotes
window.

2. Click the Open button to display a list of previously created quotes.
3. Choose the quote you want to convert and then click OK.

You may have to click in the Show list to display quotes from a different
time period.

P If you don’t remember what month you created the quote, try this: In the
Show list, choose All Transactions (it’s at the top of the list). Then click
Find and enter a few characters of your customer’s name. Click OK, and
Peachtree locates the first quote for the customer you specify. If this
isn’t the one you're searching for, click Next. Peachtree locates the next
occurrence.

4. Change the date on the quote to the sales order or invoice date you
want to use.

The date you choose must fall within or be later than the current
accounting period.

5. Click the Convert button to display the Convert Quote dialog box.
6. Select a conversion option.
The options that appear depend on your selection are as follows:

e If you choose Sale/Invoice, you get a text box prompting you for
an invoice number. If you elect not to enter an invoice number,
the quote still converts to an invoice, but you need to print it at
a later time.

e If you choose Sale/Invoice and Print Now, you're prompted for
a beginning invoice number and other print options after you
click OK.

e If you choose Sales Order, a text box appears with the next sales
order number displayed. You can change this sales order number
if desired.

7. Click OK.
After you convert a quote, it no longer exists as a quote if you click the Open

button in the Quote window. You can, however, see it as a sales order or
invoice in the Sales Order window or the Sales/Invoicing window.
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Why should you use sales orders? Why not just create an invoice? Well, this
choice is really a matter of timing. If your business receives a customer order
and ships the product or provides the service within a day or two, you could
skip the sales order step and wait to enter the invoice. If a lapse exists between
the time you take the order and the time you provide the product or service,
however, you may find the sales order feature helpful. The sales order feature
lets you enter items for a customer and then invoice and ship the items as
they become available, tracking the backorders in the system.

By viewing inventory and sales order reports, you know the number of items
backordered for your customers, which can help you plan purchases from
your vendors.

Even though you reference G/L accounts when you create a sales order,
Peachtree doesn’t update the general ledger until you create an invoice from a
sales order.

You may find entering data in the Sales Order window similar to creating a
quote. To create a sales order, follow these steps:

1. Choose Tasks=>Quotes/Sales Orders~Sales Orders to display the Sales
Orders window.

2. Fill in the Customer information or select the customer ID from the
lookup list.

The lower-left corner displays the customer’s current balance, credit
limit, and credit status. Click the arrow to display the customer ledger.

If the customer ID is not setup in Peachtree, the ID box flashes and when
you later save or print the transactions, Peachtree will prompt you to
save the customer information.

3. Type the Ship To address, or click the Ship To arrow and choose the
Bill To address or one of the Ship To addresses you entered when first
setting up the customer.

Peachtree doesn’t store a manually entered ship to address permanently
in the customer record. However, Peachtree does store the custom
address with the sales order and later transfers the address to the
resulting invoice.

4. Enter the date you want for the sales order and a ship by date.

The ship-by date can appear on several sales order reports to help you
better track your customer orders.

129
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Peachtree automatically assigns the next sales order number, but you
can change it if you want.

. If you want your vendor to ship the item directly to your customer,

click the Drop Ship box.

If you activated the default inventory option in Peachtree Premium to
create purchases orders automatically, Peachtree creates a purchase
order for the item. See Chapter 4.

Refer to the previous section, “Entering quotes,” to review entering line
items

. Fill in the body of the sales order, keeping the following variations in

mind:
e A sales order does not have a good through field.

¢ Your customer may or may not supply you with a customer pur-
chase order number.

¢ If you do not enter a quantity, enter an amount.

e [f you're using Peachtree’s job costing, you may have already
assigned a job number to the customer order. If so, be sure to indi-
cate the job ID and optionally the phase code and cost code to
each sales order line item.

Peachtree can play a visual trick on you here. When you click the Job box,
it expands backwards and covers up part of the Amount box (see Fig-
ure 7-6). At first glance, it may appear that the amount has disappeared,
but it’s only hidden. When you move the insertion point past the Job
box, Peachtree redisplays the Amount box. Read about setting up jobs in
Chapter 12.

¢ [f you're going to charge shipping charges and you know the
amount, enter it in the Freight Amount box.

¢ The Shipped quantity box is unavailable for you to edit. When you
ship the ordered goods, whether partially or completely, and bill
them on an invoice, Peachtree tracks the quantity shipped and
enters it in this column of the sales order.

. Optionally, click the Note button to store one of three different notes:

a customer note, which prints on the actual Sales Order form, a state-
ment note, which prints on the customer statement, and an internal
note, for internal reference only.

. When you’ve finished entering the sales order, click the Save button

to save the transaction or the Print button to print it.
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Generating an Invoice

Finally! Your company has produced the product or performed the service,
and you are now ready to collect your money. Most businesses generate an
invoice as proof of the sale to give or send to their customers.

If you read the previous sections on creating quotes or creating sales orders,
you know quite a bit about creating an invoice. As with quotes and sales
orders, you enter the invoice header and body information. The difference is
that when you do use sales orders, you enter the information a little differ-
ently from the way you enter data if you don’t use sales orders.

Invoicing against a sales order

Only one sales order can apply to an invoice. However, you can create multi-
ple invoices from a single sales order.
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To create an invoice and apply it to a sales order, follow these steps:

1. Choose Tasks->Sales/Invoicing to display the Sales/Invoicing window.

The Sales/Invoicing window is similar to the Quotes and Sales Order
windows.

Type or select the Customer ID.

You can’t create an invoice in Peachtree unless you have set up a

QgN\BEIi customer through Maintain Customers/Prospects.
% . . . s -
& Remember, with the insertion point in the ID field, you can press the
plus (+) key to display the Maintain Customers/Prospects window.
Here’s where things get a little different. See Figure 7-7. When you select
your customer ID, Peachtree looks for any open sales order for that cus-
tomer. If an open sales order exists, Peachtree automatically displays the
Apply to Sales Order No. tab.
\J . . .
) If the invoice you want to enter does not apply to a sales order, click the
Apply to Sales tab and proceed to the information in the next section,
“Invoicing against sales.”
Sales order selection box
Ship button
Sales/Invoicing _l 8= ]
Clise *%7 pen §’: ¥ ‘p‘.ﬁ; Eﬁn Dégle' ' Q!!}Lmn _rgﬁ J%a\ E‘%?'t Teﬁle‘ %'
customer 10: [TacRiEn__ [ Invoice [€][2]
Bill To: ;g;:lm;ar";:sﬂég:;r;: Design Shig To: [ship to Address 1 [+ Date: [Mar 1, 2007 =]
Atlarta, GA 30333 Thurman alf Course Design Tnvoice No.: | ]
3501 Morthside Drive D Drop Ship
Atlanta EAE=E
|
. Customer PO Ship Yia Ship Date Terms Sales Rep AfR Accourt
Flgl,lre 7-7: [erbal - Henry Jones [ Cust. pickup] e = [+ [cswanTon [+ rooo-co =]
When the Apply to Sales Order No.: 10343 [l [ ooty to seles: 0.00 |
Ttem Remaining  Shipped Deseription GL Accourt  Unit Price Tax Amnount Job
sales order EQFF-13120 | 10.00] 1000 BelGro Plart AlPurpose Plastic SprayerMister [4ooo0-£q | a.99] 1 59,90 | SHARP
IS ﬁ”ed' EQUW- 4100 | a00] 4,00 | Bell-Gra Aerator Soil Digger w/ long spikes and wood han] 40000-£Q | 3099 1 150.%6 |
Peachtree
A FERT-16150 | 1z.00] 12.00 | Bell-Gra Manure Mix (Camposted) 30 Lb. Bag [4o000-FF | 16.99] 1 2035
automati-
cally marks ! ! ! ! ! !
the sales [3]4pply Ticksts/Expenses SEI:I;T? IS‘:: T
Ord er Customer Account &3 of Mar 1, 2007 Other Applied Credits 0.00 452,29 Invoice Tatal
Closed ‘éf%r:fim S’Uféfﬂ‘f;u Amourk Paid t Sale 0.00 452,29 Net Dus
. Credit Status: Mokify Ower Limit
I Take control of mailing and shipping the easy way!
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3. On the Apply to Sales Order No. tab, click the arrow to display a list
of open sales orders.

4. Choose the sales order you want to invoice.

Peachtree fills in the information you supplied when you created the
sales order, including Ship To, Purchase Order Number, Sales Rep, and
the items ordered.

5. Enter the invoice Date and change any header information.

Leave the invoice number blank if you want Peachtree to assign an invoice
number when you print the invoice.

§,‘&N\BEI? Inventory item numbers on a sales order can’t be edited from an invoice.
& To change item numbers, you must edit the original sales order. You can,
however, change the quantities or item description. To add additional
items or charges to the invoice, click the Apply to Sales tab and add the
items there.

6. In the Shipped column, enter the quantities shipped. Or if the entire
order has been filled, click the Ship toolbar button and choose All.

If you clicked the All button, Peachtree fills in the remaining quantities of
the order.

7. Enter the Freight amount.

If you entered freight information when you created the sales order,
Peachtree displays it on the invoice only if you use the Ship All feature. If
you make a partial shipment and need to charge freight, enter the freight
amount manually.

P If you're going to ship the product via UPS and plan to use the shipping
feature available in Peachtree Complete and Peachtree Premium, click
the Freight link. See “Shipping the UPS Way,” later in this chapter, for
information on the shipping feature.

8. Optionally, click the Note button to store one of three notes: a cus-
tomer note, which prints on the actual invoice, a statement note, which
prints on the customer statement, and an internal note, for internal ref-
erence only.

9. Click Save or Print.

You probably want to print the invoice, but if you are not going to print
it or if you want to continue entering invoices and print them later in a
batch, click the Save button to save the invoice. To print your invoices,
see “Printing Forms” in Chapter 13.
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When you save or print the invoice, if the current invoice total plus any unpaid
invoices for this customer exceed the credit limit determined when you set up
the customer, depending on the credit status you selected, Peachtree will warn
you and potentially stop you from proceeding with the invoice.

Invoicing against sales

Your business doesn’t use sales orders? You can create an invoice without a
sales order.

To create an invoice, follow these steps:

1. Choose Tasks=>Sales Invoicing to display the Sales/Invoicing window.
2. Enter the invoice header information.

To review how to enter the header information, see the “Creating quotes”
section, earlier in this chapter. The header information includes the
invoice date, shipping address, customer’s purchase order number

(if available), shipping method, terms, and sales rep ID.

3. If you want your vendor to ship the item directly to your customer,
click the Drop Ship box.

If you activated the default inventory option in Peachtree Premium to
create purchase orders automatically, Peachtree creates a purchase
order for the item. See Chapter 4.

4. Fill in the line items for the invoice based on the following options:

e Enter a quantity for the first item on the invoice. You can leave
the Quantity field blank when invoicing a service or product that
doesn’t have a quantity.

e If the product is an inventory item, select the item ID. Peachtree
fills in the item description, the G/L account, the item’s unit price,
and the tax status. Then Peachtree multiplies the quantity times

QQN\BE” the unit price for the amount.
Q
&

You can tell Peachtree to warn you if you do not have enough stock to
sell the item. See “Setting Inventory Defaults” in Chapter 4.

e If your product is a non-inventory item or you don’t use inventory,
leave the Iltem box blank and enter a description, G/L account, and
unit price.

e The Tax box refers to the tax types you determine when setting
inventory defaults. If you're using inventory items, Peachtree
determines the tax type from the inventory item.
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e If you do not enter a quantity, enter an amount.

¢ Optionally, if you're using Peachtree’s job costing feature, click in
the Job box to display the magnifying glass and then choose a job
from the list.

¢ [f you'’re going to charge shipping charges and you know the
amount, enter it in the Freight Amount box.

P If you are going to ship the product via UPS and plan to use the shipping
feature available in Peachtree Complete or Peachtree Premium, click the
Freight link which saves the invoice and opens the Shipping window
with the customer information already entered. See “Shipping the UPS
Way,” later in this chapter, for information on the shipping feature.

5. Optionally, click the Note button to store one of three different notes.

You can choose from a customer note, which prints on the actual
invoice, a statement note, which prints on the customer statement, and
an internal note, for internal reference only.

6. Click Save or Print.

You probably want to print the invoice but, if you are not going to print
it or if you want to continue entering invoices and print them later in a
batch, click the Save button to save the invoice. To print your invoices,
see “Printing Forms” in Chapter 13.

v?‘“\NG! As with sales orders, if the current invoice total plus any unpaid invoices for
this customer exceed the credit limit you established when you set up the
customer, depending on the credit status you selected, Peachtree will warn
you and potentially stop you from proceeding with the invoice.

Shipping the UPS Way

“&N\BER
& This feature is available only in Peachtree Complete and Peachtree Premium.

What happens when you mix brown and peach? No . . . we're not referring to
disintegrating fruit. You get UPS (brown) integration with your Peachtree
(peach) software! You might deliver your goods to your clients in many differ-
ent ways. You might hand deliver them, the customer might pick them up
from your warehouse, or you might ship them using a common carrier such
as a freight line or a parcel delivery service. If you ship your goods through
UPS, you can generate and track the shipment information directly through
Peachtree’s Shipments feature.

You must have an Internet connection for the Shipments feature to work.
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P A shipment generated through the Shipments feature doesn’t have to be for

goods you sell. It could be for any document or package you want to ship to
anyone, anywhere.

Before you can use the Shipments feature, you must have an account number
registered through UPS. Contact UPS at 1-800-PICK-UPS (1-800-742-5877) to ini-
tiate an account. Don’t lose the account number, because you’ll need it to reg-
ister through Peachtree’s Shipping Registration Wizard.

After you have an account number assigned but before you can ship your first
package, you must use the Shipping Registration Wizard to activate the link
between UPS and Peachtree. Choose Tasks=>Shipments=>Shipping Registration
Wizard. Follow the steps, which include entering your shipping address, a
contact person, your UPS account number, and the billing method you want
UPS to use.

K‘&N\BER
& The contact person entered in the Shipping Registration Wizard must be set
up as an employee in Maintain Employees even if you don’t use Peachtree to
process payroll.

Now when you have UPS packages to ship, follow these easy steps:

1. Choose Tasks=>Shipments-~>Shipments.

Peachtree opens a Shipping window like the one you see in Figure 7-8.

Ship to Type drop-down list

Estimate button

Shipments [B=]%]
My W {vors = 2 =
o e B2 EEeB e
1
Customer 10| » [ THURMaAN 4] Customer Tnvaice: | 745 (Mot Printed) | & Shipment

shig To! [ship to Address 1 [~ shipped Date:!

Thurman Galf Course Design Shiprent Mo.: [ 1001

Briana Thurmnn | 770-555-4029

3501 Northside Drive
Atlarta IEREEE @

United States

UPS Service
Service Level:

e | [ residential Delivery [7] 8l Total to Customer Tnvoice Deoo [ 0ir]

T T — [ Pickup Service [ Quantum View Motify (SM) | Receiver ]
O [ Quariur views MotiFy (SM) f Sipper Handing Charge
Flg“re 7-8: Shipmert Description; O (] Quantum View NotiFy (SM) { Other & Amourt Per Package

[ LA MATNTENANCE TTEMS | [ [l ¢ Percertagzofrorl [0 ]
Choose your
Case Package Type weight  Height Width Length Declared Value AddlHandling UPS Tracking Mo,

Sh|pp|ng 1 |Custom Package 32.0 6 8 12 0.00 ]
: 2 [Custom Package 4.0 2 2 6 0.00 [m]
options

. UPS, the UPS brandmark, and the color brawn ars registered trademarks or Randing Charge: 0.00
shi pme nt. trademarks of Lnked Parcel Service of Ameniza, Inc. All Riohts Reserved. Total: 000
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2. Optionally, in the Ship to Type list, choose whether you’re shipping to
a customer, a vendor, or an employee.

3. Select the ID. If you’re not shipping to a customer, a vendor, or an
employee, leave this field blank.

\3
P If you clicked the Freight hyperlink in the Sales/Invoicing window, you

see the shipping window with the customer information and invoice
number already entered.

4. Enter a shipment number.

This is a required data entry field. After you create a shipment number,
such as 101, Peachtree remembers the sequence for the next shipment
and numbers it 102. Optionally, you could use the customer invoice
number as the shipment reference number.

5. Select the level of UPS service you want.

You can select the service level as well as any extras, such as delivery
confirmation or COD charges.

6. Optionally, in the Shipment Description box, enter a brief description
of the contents of the shipment.

7. Enter the package information, including package type and weight.

8. Optionally enter the package value and select whether you want the
package to have special handling.

Each package going to this recipient must be listed with its own package
type, weight, and dimensions. Peachtree lists the standard UPS provided
packages as well as a custom box, where you enter your own dimensions.

° The length should be the longest dimension in the package.
h\

9. If you want a cost estimate before shipping this order, click the
Estimate button and follow the on-screen instructions.

The UPS Estimate Settings box prompts you for the method you plan on
using to get the package to UPS and then displays a list of the UPS serv-
ice level options and their published rates.

10. Click the Process button.

Peachtree registers the shipment with UPS and assigns a UPS tracking
number.

P If you are billing the total to the customer invoice and the customer
invoice already has an invoice number assigned, Peachtree thinks the
invoice is already printed and warns you that proceeding will change
the invoice’s total amount due.
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A confirmation message appears, stating the total estimated charges, and
prompts you to print the shipping labels. Print the shipping label on
plain paper and attach it to the package, usually in a special UPS window
envelope.

11. Click OK twice and then click Yes after the label prints.

Your UPS account does not get billed until the actual package is scanned
by a UPS representative. If you decide to not ship the package, you can
void the shipment by locating it through the Open button and clicking
the Void button.

You can track the status of your shipment by choosing Tasks=>Shipments=>
Track a Package and entering the UPS tracking number.

Editing a Sales Transaction

\\J

Like most transactions you enter in Peachtree, quotes, sales orders, and
invoices are not written in stone. Peachtree makes it easy for you to modify
anything on the transaction — even after it has been printed. Click the Tasks
menu and choose the type of document you want to edit: Quote, Sales Order,
or Sales/Invoicing. Next, click the Open button and choose the transaction
you want to edit and then click OK. Make any desired changes to the transac-
tion and then click Print to reprint the transaction or click Save to save the
transaction without reprinting it.

The Select Sales Orders, Select Quote and Select Invoice windows displays
sales orders generated in the current period. If you don’t see the transaction
you want to edit, open the Show list box and select a different period.

Voiding an Invoice

NNG/
S

If you generate an invoice and then discover that the invoice needs to be can-
celed, use the Void Invoice feature. See Chapter 8 if you need to issue a credit
memo to the customer.

Although technically you could delete an invoice to get rid of it, deleting an
invoice is not good accounting practice. When you delete transactions, you
lose your audit trail of the actions you've taken. And, if the original invoice
occurred in a previous month, you could hurt the integrity of your reports.
Your accountant would not be a happy camper.
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When you void an invoice, Peachtree creates several transactions. First, Peach-
tree creates another invoice with the same invoice number as the original,
except it adds a Vto the invoice number. That invoice amount is a negative
dollar amount equal to the amount of the original invoice. For example, if you
generate invoice number 1234 for $150.00 that you must cancel, Peachtree gen-
erates another invoice 1234V for -$150.00 to void the original.

If the original transaction involves inventory items, Peachtree restores to
inventory the items sold. In the general ledger, Peachtree creates a reversing
entry, affecting sales and accounts receivable, and if applicable, cost of sales
and inventory. If the original invoice does not come from a sales order, the
reversing entry contains negative values for the quantities sold. However, if
the original invoice does come from a sales order, the reversing entry con-
tains negative values for the quantities shipped. Peachtree then reopens the
sales order.

Next, Peachtree creates a zero-dollar receipt to pay both the original and
voided invoices. This receipt clears both transactions from the Aged
Receivable report. In other words, if you add the two transactions together,
you get 0 and, a $0 transaction causes no change in your cash balance. You
can view the zero-dollar receipt by clicking the Open button in the Tasks=>
Receipts window and selecting the appropriate receipt.

To void an invoice, follow these steps:

1. Choose Tasks=>Sales/Invoicing.

2. Click the Open button and double-click the transaction you want to

void.
° The transaction must appear on the screen before you can void it.
h\
Optionally, choose a different period from the Show drop-down list to
find the invoice you want.
3. Click the Delete button and then choose Void.
Peachtree opens a Void Existing Invoice dialog box like the one in
Figure 7-9.
|
Figure 7-9:
Peachtree S— .
. Void Existing Invoice
displays —
the invoice The following invoice will be voided as of: 317407
number, e MNumber Date Source Armt Custarner Name
date 4 10313 Mar15, 2007 AR 19986 Chapple Law Offices
amount, and
customer.
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4.

5.

Type the date you want — usually the current date — in The
Following Invoice Will Be Voided as Of box.

Click OK.

Peachtree lists the word Void beside both the original and reversing
invoices and uses the invoice number as the receipt reference number.

Recurring Invoices

In some businesses, you have customers that you bill the same amount every
month for the same products or services. By setting up recurring entries, you
can save a great deal of time entering these invoices. Even if the amount dif-
fers next time, it’s helpful to have all the other information filled out for you.
Then, you have to change only the amount.

WBER
‘x&
&

Recurring entries can’t be created if you generate the invoice using a sales
order.

You also can create recurring purchases, payments, and general journal
entries. You can adapt the following steps for these other tasks.

To create recurring invoices, follow these steps:

1

. Choose Tasks=>Sales/Invoicing to display the Sales/Invoicing window.
2.

Enter the invoice information as you usually would, but do not enter
an invoice number or click Save or Print.

. Click the Recur button to display the Create Recurring Journal Entries

dialog box, shown in Figure 7-10.

. Enter the number of times to create the entry, including the current

transaction.

The maximum number of times depends on the transaction’s original
date and the current accounting period. You can enter recurring transac-
tions only within the two open fiscal years of Peachtree. For example, if
you're creating a new invoice and are currently in period 3, the maxi-
mum number of monthly recurrences would be 22.

. Under When to Recur, select a time frame for the recurring invoice.

You can choose Weekly, Bi-Weekly, Monthly, Per Period, Quarterly, or
Yearly.

. Optionally, assign a beginning invoice number by clicking the Assign

Invoice Numbers check box.
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Balance: 19996 ——
Credt Limk:  50,000.00 Amount Paid at Sale 0.00 150.00 Net Due
Credit Status: Moty Ower Limit
Take control of mailing and shipping the easy way!

Peachtree displays a box to enter a beginning invoice number. All transac-
tions are numbered incrementally. A number of our clients use a system
that includes the current year as the first two or four digits of the number,
followed by a dash and then the beginning invoice number.

Peachtree doesn’t automatically print recurring invoices. If you leave the
invoice number blank, you can print the recurring transactions when you
use Peachtree’s batch printing method or edit the transaction and click
Print. Chapter 13 discusses how to print batches of forms.

7. Click OK for Peachtree to save all transactions in the appropriate
periods.

If you need to edit or delete a recurring transaction, Peachtree prompts you
with the Change Recurring Journal Entries dialog box. You can edit only the
current invoice or the current invoice and all future occurrences. Editing a
recurring transaction does not affect previous transactions.

Reviewing Customer Reports

Peachtree offers several useful reports that you can use for listing customer
information, compiling tax information, and tracking quotes that you want to
turn into sales. In Tables 7-2, 7-3, and 7-4, we provide you with a description
of the reports that pertain to selling your goods and services. You can sort
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the report data in a variety of ways, and you can control how much and
which information you want to display on the report. See Chapter 14 to find

out how to print reports.

Table 7-2  Reports Related to Quotes and Customers in General

Report Name

What It Does

Customer List

For each customer, lists the ID, name, contact name,
telephone number, and resale number

Customer Master File
List

Similar to Customer List, but also includes address
information, tax codes, and terms

Prospect List

Lists each prospect with contact and telephone number

Quote Register

Lists each quote with quote date, expiration date, cus-
tomer name, and quote amount

Sales Tax Codes

Lists each Sales Tax Code with all corresponding
authorities, tax rates, and vendor information

Table 7-3

Reports Related to Sales Orders

Report Name

What It Does

Picklist Report

Lists open sales order items such as item ID and
description, quantity to ship, and warehouse location.
Sort this report by sales order number, ship by date,
location, customer ID, or item ID.

Sales Backorder Report

Lists open order items, such as item D, description, and
quantities on order, on hand and on purchase orders.
Sort this report by sales order number, ship by date,
location, customer ID, or item ID.

Sales Order Journal

Lists sales orders in journal entry format.

Sales Order Register

Lists each sales order and its status. Sort this report by
customer ID, sales order date, or ship date.

Sales Order Report

Lists the details of all sales orders by sales order
number, ship by date, customer ID, or item ID.
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Table 7-4 Reports Related to Customer Invoicing

Report Name

Description

Customer Ledgers

Shows the transactions and a running balance for each
customer for a specified date range.

Customer Sales History

Summarizes, by customer, how much each has
purchased

Invoice Register

Lists each invoice number with date, quote number,
customer name, and invoice amount. Sort this report by
Invoice number, customer ID, or invoice date.

Items Sold to Customers

Lists for each customer, the quantity, amount, and profit
of both inventoried and non-inventoried items sold.

Sales Journal

Lists transactions as reported to the general ledger.

Shipment Register

Lists shipments and to whom they were made. Sort
this report by shipment number, shipment date, or ship
to ID.

Sales Rep Report

Lists sales statistics by sales rep ID or customer.

Taxable/Exempt Sales

Lists all taxable and exempt sales per tax authority. See
Chapter 6 for information on using this report to pay
your sales tax.

Visit this book’s Web site for more information on Peachtree.
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Chapter 8
Collecting the Money

In This Chapter

Receiving your customer’s money

Tracking accounts receivable
Issuing credit memos
Charging finance charges

Printing statements

One of our favorite sayings is, “As much fun as I'm having doing what I'm
doing . . . I'm still doing it for the money.”

Most people do find that their preferred part of being in business is collecting
the money. Peachtree not only provides you with an easy way to track the
money your customers owe you, but also provides you with a few ways to
encourage your customers to pay up.

Peachtree refers to the money you receive from your customers as receipts.
That sounds logical enough, doesn’t it?

Recording Receipts

Peachtree’s Receipts feature allows you to enter all checks, cash, and credit
card slips you receive and deposit them in your checking account. Peachtree
provides two ways to account for receipts. The method you use is mostly
determined by timing.

One method is used when you receive the customer’s money at the time of
the sale. You enter the receipt right on the invoice and when you print the
invoice, it can also show the funds received.

The other and most commonly used method is to apply the receipt to an
invoice through the Receipts window. You can use this method either if the
customer pays you at the time of the sale or at a later date.
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Applying receipts to an invoice

To apply a receipt to a customer invoice, begin by taking a look at the
Receipts window:

1. Choose Tasks >Receipts to display the Receipts window.
2. If necessary, enter a deposit ticket ID.

What appears in the Deposit Ticket ID field of the Select for Deposit
window depends on your choice of methods for generating these IDs in
the Pay Methods tab in Customer Defaults. (See Chapter 4.) If you opted
for the Receipts window, Peachtree displays the current date; otherwise
this field is blank. If you leave the deposit ticket IDs blank, Peachtree can
automatically suggest deposit ticket IDs in the Select for Deposit window.

For more information about deposit ticket IDs, see, “Laughing All the Way
to the Bank,” later in this chapter.

\P . . . .
P If you want this transaction to be reconciled as a separate item, enter a
unique deposit ticket ID. You can find out more about account reconcili-
ation in Chapter 17.
3. Select the customer ID.
If this customer has unpaid invoices, Peachtree lists them on the Apply to
Invoices tab (see Figure 8-1). If the customer has no outstanding balance,
Peachtree displays the Apply to Revenues tab.
Apply to Invoices tab  Apply to Revenues tab
£ Receipts 9=
’EEQ *%r % 5%? ;:’\lijl z E%n Dgle 1%!' :-b‘h;ﬁl J%al ?::x gﬁp'
Receipt
oepost et o[ | ] Reference: Cash Account
_ Recpipt Humber: | ‘ |1uzuu.uu |\|
Customer 10 [ [FENTEN [ Dete: [Mar 15, 2007 _[] | Regeler checking Accourt
Marne: Rechink Amount: |:|
| ‘ Paynfent Method: Cash Account Balance J
[
Apply to Invoices: 1,277.62 T 2only to Revenues: 0.00 ] O
L Invoice Date Dug Arnount Due Description Discount Amourt Paid Pay|
- 10123 Mar 17, 2007 4,587,854 \EI
Flglll’e 8'1 . 10207 Mar 22, 2007 449.28 449,28 \IE
Pea chtrEe 10310 Apr 14, 2007 845.23 16,90 528,33 E_@
lists the
customer’s
unpaid
invoices
(and
credits). | o sccar
EEE— Process credit cards directly from within Peachtree,
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Double-click any unpaid invoice to see the transaction details.

. Enter a Reference number that helps identify the receipt.

You must enter a Reference number, usually the customer’s check
number. If the receipt was transmitted electronically, you might enter
the EFTS confirmation number or the date.

. Enter the Date of the receipt.

Use this field to record the date you received the check, not the date on
the check.

. Select a Payment Method: Cash, Check, Charge, and so on.

You set up payment methods in the Customer Defaults dialog box. You
can find out how to set customer defaults in Chapter 4. You can run
some reports based on payment methods. Chapter 15 shows you how
to filter reports.

If the customer is paying by credit card, you can store the credit card
information or use Peachtree’s service to process the credit card. See
“Handling Credit Card Receipts,” later in this chapter.

. In the Cash Account list, verify the bank account into which you’re

depositing the receipt.

Always confirm the cash account. Peachtree remembers which account
you last used in this window.

. Place a check mark in the Pay column beside each invoice being paid

by this receipt.

If the amount of the receipt doesn’t match the invoice amount, enter the
actual amount received in the Amount Paid column.

If, based on the customer terms, the invoice is eligible for a discount,
Peachtree automatically displays the discount amount. You can accept
that amount, delete it, or enter a different amount. If you have discounts,
verify the discount account number at the bottom of the window.

If the amount paid is less than the amount due, Peachtree assumes
that the customer still owes the difference. The next time you open the
Receipts window for the customer, Peachtree displays the remainder
due on the invoice.

If the amount paid is less than the amount due and you’re going to write
off the difference, enter the full amount of the invoice in the amount box
and then click the Apply to Revenues tab and enter a negative amount
for the amount you're writing off. (Make sure the amount you're writing
off is not taxed.) Choose your write-off account for the G/L account. This
process clears the invoice from A/R, posts the correct amount to cash,
and charges the unpaid balance on the invoice to the write-off account.

147
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If you do not see a box to select the G/L account, it means the boxes are
hidden. You can click the Journal button at the top of the window and
enter the account numbers you want to use.

If the amount paid is more than the invoice amount, Peachtree automati-
cally creates a credit balance against the specified invoice. The next
time you display the Receipts window for this customer, you see a credit
balance. If you're going to absorb the overpayment (usually for small
amounts), click the invoice as paid in full and then click the Apply to
Revenues tab and enter the overpayment amount as a positive number.
This clears the transaction from accounts receivable.

If you make a direct sale that doesn’t require an invoice, click the Apply
to Revenues tab and specify a sales account and an amount.

The amount Peachtree displays in the Receipt Amount box should
match the total amount received from your customer.

9. Click Save to record the receipt or click Print to print a receipt that
you can give to your customer.

Printing the receipt also saves the receipt.

The Receipts window also gives you a handy way to write off an entire invoice
as a bad debt. In the Receipts window, enter a unique reference number that
helps identify the receipt as a write-off. For example, we typically use the let-
ters WO (for write-off) or BD (for bad debt) and the original invoice number
as the reference number (BD12345). Click the Cash Account box to select the
Bad Debt Expense account. Click the Pay check box for the invoice you want
to write off as a bad debt and then click Save. Peachtree clears the transaction
from account receivable and increases the bad debt expense account. Be sure
to change the cash account back to the regular checking account before clos-
ing the window.

Entering receipts from nonestablished
customers

Occasionally, you receive money from a customer you haven’t invoiced.
If the customer isn’t set up in your customer list, you can still record a
receipt.

The procedure is the same as applying receipts to an invoice, except you
won’t enter a Customer ID. Skip this field and enter the customer’s name in
the Name text box. Because you haven’t entered an invoice for this customer,
Peachtree displays the Apply to Revenues tab. Select the sales account, enter
the receipt amount, and then click Save or Print.
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Applying receipts at the time of sale

You can apply a receipt also by recording it at the time of sale as you create
the invoice. (You see how to create an invoice in Chapter 7.) Using this method
allows Peachtree to print the amount received on the invoice.

To apply a receipt at the time of the sale, follow these steps:

[

2.

dialog box, as shown in Figure 8-2.

Enter the payment information.

. Choose Tasks=>Sales/Invoicing window to display the invoice window.

Click the Amount Paid at Sale button to display the Receive Payment

Also, be sure to verify the Cash Account into which you’re depositing

the money.

Click OK to close the Receive Payment window.

. .
5. Save or Print the transaction.
Sales/Invoicing
Wy JH F— . 4P @ . E. S QL & =, &
Do e e T e P Déf!le H%r Fow  SeralNo  Nofe Jotnal s Template  Help
Customer ID: [RENTON Invoice [€] =]
Bill Te: Kenton Golf and Tennis Center Shi T2 [ship to Address 1 [+~ Date: [Mar 6, 2007 [=]
1969 Fort Solitude Circle =
Centervile, GA 31025 Kenton Goff and Tennis Center Invoice No.: [ 10338 |
1959 Fort Solituds Crcle Cloree e
Receive Payment
e O £
Cancel DK FEb
Time of Sale Receipt
|: Deposk Ticket i [ | Referance: [ 3256 Cash Account
Date: Mar 6, 2007 10200-00 =
Customer ID: KENTGH Receipt Amount: 747.04] Requiar Checking Account
Mame: Kenton Golf and Termis Center
1969 Fort Solitude Circle
Centervile, GA 51026
Payment Method:
Pracess Credit Card
T ‘ T ‘ T T
[3]Anpiy Tickets/Expenses Sales Tag: 489,81 [GAFULTON |4
Freight: 0.00
Customer Account as of Mar 6, 2007 Other Applied Credits 0.00 7,487.0¢ Invoice Total
Balance:  7,487.04
CredtLimit:  £0,000.00 [3] Amourk Paid at Sale 0.00 7,487.04 Net Due
Credi: Status: Moty Over Limit
Crder Peachires compatible Checks and Forms.

Amount Paid at Sale

Handling Credit Card Receipts

If your business accepts credit card payments from customers, you can enter
and track these transactions in Peachtree. Assuming (we know, there we go

149
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assuming again) you have to wait for that time lapse before you receive the
money from the credit card financial institution, you can begin recording credit
card transactions in Peachtree, but you need the following first:

v A G/L account in your chart of accounts to use for the credit card receiv-

able amount. Create an account in the Accounts Receivable area of your
chart of accounts, giving it an ID and a description to identify it, such as
VISA Receivable. Choose Accounts Receivable as the account type. If nec-
essary, create additional accounts using the same method. (Chapter 3
shows you how to create accounts.)

v A vendor ID for the credit card financial institution that deposits money.

This way, you can record and track processing fee expenses.

To record a credit card transaction, you must follow two sets of steps: one
when the transaction occurs and another when you know that the credit card
financial institution has deposited the money in your account:

1.

In the Receipts or Receive Payments window, record receipt informa-
tion but do not Save or Print the transaction yet.

You can apply the customer credit card receipts to open invoices or to
revenue.

Use the techniques shown in the “Applying receipts to an invoice,”
“Entering receipts from nonestablished customers,” or “Applying receipts
at the time of sale” section, earlier in this chapter. However, you must
use this exception: Enter the credit card receivable G/L account as the
Cash account.

. To keep the customer’s ledger accurate and up-to-date, record the

amount paid as the full amount of the credit card charge, regardless
of how the financial institution handles processing fees.

You enter the processing fees as an expense when your bank statement
arrives.

. Click the Process Credit Card button.

The Credit Card Information window appears, displaying fields that are
applicable to credit card transactions. (See Figure 8-3.)

. Enter the credit card number and other information pertaining to the

customer’s credit card, such as name and expiration date.

You can store default credit card information in the customer record.
See Chapter 7 for more on storing customer information.

. If you subscribe to Peachtree’s credit card service, click the Authorize

button to connect with your online merchant account provider.

When authorized, the provider will automatically supply the authorization
number. If you don’t subscribe to this service, enter the authorization
number manually.
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6. Click OK and then click Save or Print.

Credit Card Information
Cardholder's Name: [Hancy Arch Receipt Date: [l 10 007 |
Biling Address: | 778 0 akland Parkway Recsprbmow [0 |
1234-5676-9012-3455 Cl
City. State, Zip: |Alpharelta Ga_[30097 Giooi G Nmber: [1250557680220% | _theat |
ot Espiration Date: [12] 7 [08_] MMAvY)
Vefication Number: [130
E-Conmerce Sale: [
Authorzation Code: [157302
Authoiize
I Save this card as this customer's Payment Default
oK Cancel Help ]

After the credit card financial institution has notified you that the money has
been deposited into your account, you need to create another receipt that
transfers the funds from the credit card receivable account to your bank
account.

Create a receipt in the Receipts window just like you create any other
Peachtree receipt, with the following exceptions:

v Skip the Customer ID field and enter the credit card company name in
the Name field. Because you’re not using a Customer ID, Peachtree auto-
matically displays the Apply to Revenues tab.

v On the line item GL Account field, enter the credit card receivable GL
account number.

v Enter the amount actually transferred to your account.

Laughing All the Way to the Bank

When you enter receipts, you decide whether to assign a Deposit Ticket ID or
let Peachtree assign one when you go to the bank. Peachtree lets you group
deposited items together using the Select for Deposit window to greatly speed
up the bank reconciliation process.

What’s a Deposit Ticket ID, you ask? Well, Peachtree uses Deposit Ticket IDs
to make account reconciliation easier to manage. You should assign the same
Deposit Ticket ID to all transactions that you deposit on the same deposit
ticket. All receipts that use the same Deposit Ticket ID appear as one lump
sum in account reconciliation, making reconciliation a much easier process.
(See Chapter 16 for steps to use account reconciliation in Peachtree.)
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Figure 8-4:
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More often than not, you receive checks daily and enter them into Peachtree
daily, but you do not go to the bank until you’'ve accumulated several days’
worth of checks. The following example lists five checks you receive on three
different days but want to lump together into a single bank deposit:

Date Check Amount
March 16 $125.75

March 16 $28.41

March 17 $722.01

March 18 $549.10

March 18 $100.05

When you go to the bank, you make one deposit of $1,525.32, and that amount
appears on your bank statement. Although in Peachtree you have five differ-
ent receipts, assigning a single Deposit Ticket ID to these transactions makes
the total amount of $1,525.32 appear in the Account Reconciliation window. If
each of the five transactions above has its own unique Deposit Ticket ID,

the Account Reconciliation window would list all five of them independently,
making bank account reconciliation extremely difficult. You’d have to sit and
figure out which transactions add up to the ones listed on your bank state-
ment. If you have lots of receipts with separate Deposit Ticket ID’s, you’d
spend lots of time trying to reconcile receipts to your bank statement.

The Select for Deposit window lets you combine multiple customer receipts
into a single bank deposit. To select receipts to include in a bank deposit,
follow these steps:

1. Choose Tasks=>Select for Deposit.

The Select for Deposit window appears, as shown in Figure 8-4.

Select for Depaosit
mEs oF .l F O @
’EEQ Prer O PN e Al Al Fep
Deposit

Account 10: [ 10200-00 Regular Checking Account Deposit Ticket Date: [Mar 15, 2007 [

Depasit Ticket ID: | 031507-1]

CheckiRef o,
1746

31703

50503

11034

7459

1036

13621

Date
Mar 2, 2007
Mar 2, 2007
Mar 5, 2007
Mar 7, 2007
Har 7, 2007
Mar 13, 2007
Har 15, 2007

Received From Payment Method
Check
Check.
Check
Check
Check
Check
Check

Amount
149,97

Deposit

Everly Property Management:

Kenton Golf and Tennis Center 160,50

26.50

Holland Properties, Inc.

Cannon Heathcare Center 158.74

Chapple Law Offices 40.25
99.98

1,277.62

Snyder Securities

El| &1/ &l (€| & |E] &

Henton Park Apartments

Tatal Cash
000+

Total Checks
1,91386 +

Total Other
0.00 =

Totsl Deposit
1,913.56
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P To review, modify, or print an existing deposit, click the Open button.
Existing deposits include receipts that already have a Deposit Ticket ID
associated with them. If you entered the receipt with a Deposit Ticket ID,
that ID appears in the Deposit Ticket ID field.

2. If needed, select a different cash account from the Account ID drop-
down list.

If you don’t see a receipt that you plan to deposit, you may have entered
a Deposit Ticket ID on the receipt or you entered a different cash
account when you recorded the receipt. Edit the receipt to make the cor-
rection so that you can include it with the deposit.

3. Enter the Date on which you will make the deposit.
4. Enter or accept the currently suggested Deposit Ticket ID.

Peachtree maintains a numbering scheme based on the last Deposit
Ticket ID entered. Deposit Ticket IDs can be alphanumeric and up to eight
characters. We recommend using the deposit date and -1, -2, and so on.
For example, 031507-1 would be the first deposit made on March 15th.

5. Click the Deposit check box next to the receipts you want included in
the current deposit.

\3
) To quickly select all Deposit check boxes, click the All toolbar button

with the red check mark. To quickly clear all Deposit check boxes, click
the All toolbar button without the red check mark.

6. Click the Print button to print and save the deposit record or choose
Save to save the deposit without printing it.

Peachtree calls the form a deposit ticket, but it does not contain the bank
routing information needed to get the money into your account. You
might ask your bank whether you can simply attach the report to an
actual deposit slip to save you time and effort. It’s also helpful to print

a copy for your records and attach your bank receipt to it.

Boing! Handling Bounced Checks

One of those nasty facts of life, now and then, is that customers write
bad checks, sometimes by accident and sometimes not. In Peachtree, you
handle checks returned for nonsufficient funds (NSF) in two simple steps:

1. Create a new invoice to charge the customer the NSF fees.

2. Create a receipt and apply a negative amount for the same amount as
the original check.

For example, suppose the original (bounced) check is for $82.10. In
the example you see in Figure 8-5, we created an NSF invoice number,
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23501NSF, for $20.00. Then, on the receipt window, we apply a negative

$82.10 (which represents the original returned check amount) against
the open invoice.

3. Click Save.

Peachtree updates the customer balance to reflect the money that the

customer once again owes against the original invoice and corrects your
bank account balance.

E Receipts S]]
Wy W B oo O y = & N -
oM em e XE P T Ei%g\\ & = = J%a\ = %
Receipt
_ Receipt Number: ] | | [tozo0-00 |=T)
SNOWDEN a
Customer 10 | j‘ | \I Date: [Mar 15, 2007 [[=] Reaular Checking Account

Name;

Process Credit Card

Apply to Invoices: -97.57 T Apply to Revenues: 0.00 ] O

Invaice Date Dus _ Amourk Dus Description
10209 Janzé, 2007 7,102.00
10325 Mar 18, 2007] 59.98
| 10303 Apr 2, 2007 290,06

10306 Apr 10, 2007} 184.29

Figure 8-b: SF K # 31114] apr 14, 2007] 20,00
Create a
negative

receipt to
adjust your
bank

balance. | o

I Process credit cards directly from within Peachtree.

Discount  Amaunt Paid Pay]

ojojojg

-97.57

Later, when your customer writes you a second check or instructs you to rede-
posit the original check, you will have a second receipt for audit trail purposes.
If the customer writes a second check for the original amount plus the NSF
fee, Peachtree clears the invoice in full. If, however, the customer instructs
you to redeposit the original check, enter only the amount of the check. After
all, the customer still owes you the NSF fee.

We really hope you don’t have to use this section of our book.

Giving Credit Where Credit Is Due

Unfortunately, products are returned sometimes, or you need to make an
adjustment to a customer invoice. In these situations, you need to create a
credit memo to reduce the amount of money your customer owes.
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If you owe money to a customer for overpayment or because you applied a
credit memo to an invoice, you can write a check to the customer for the
refund amount you owe.

Creating a credit memo

You can create a credit memo that refers to an unpaid original invoice, or you
can create an open credit. Additionally, you can create credit memos for inven-
toried items or other goods or services. The following steps show you how to
use Peachtree’s Credit Memo feature:

1.
2.

Choose Tasks->Credit Memos to display the Credit Memos window.
Enter the Customer ID.

After you select a customer, Peachtree fills in the customer name and
address. In the lower-left corner of the window, you can see the cus-
tomer’s current balance as of the system date. You can click the button
next to the balance to display a Customer Ledger report of the invoices
and receipts that make up the balance.

. Select a Date and enter a Credit No.

For the Credit No., we suggest that you use the original invoice number
preceded or followed by CM to indicate credit memo. This numbering
scheme helps you tie the credit memo to a particular sale.

. If the credit memo is for an unpaid customer invoice, click the drop-

down list on the Apply to Invoice No. tab and select the invoice
number for which you are recording a credit memo.

Peachtree fills in the lines that appear on the original invoice.

If you're creating a credit memo for which there is no existing invoice,
click the Apply to Sales tab and enter the information for the items to be
credited, including quantity, item, price, and if applicable, job.

. In the Returned box on each line of the Apply to Invoice tab, type the

quantity the customer returned.

Enter the returned quantity as a positive number. Peachtree understands
that this is a return. (See Figure 8-6.)

To quickly fill in the original transaction quantities, click the Return
button and select All.

If the customer is returning inventory items, Peachtree automatically
restores the item quantities to inventory. If the inventory items are
damaged, you will need to enter an inventory adjustment to remove
them. See Chapter 11 to make inventory adjustments.

If the customer is returning serialized inventory items, click the Serial
Number button and select the serial numbers being returned.
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Figure 8-6:

If a line

item was
originally
assigned

to ajob,
Peachtree
also assigns
the credit

to the

same job.
|

\\J

Return button

Serial Number button

Credit Memos

(5=

Ny o 5y

Cise  Mew Upen

-

L S‘\‘ J@I

= e

Customer ID: [DasH

Credit Mermo [€] =]

il To: Dash Business Systems
1448 Steve Reynolds Bivd,
Nareross, GA 30093

Customer PO Terms

Sales Rep

Date: [Mar 15, 2007 [
Credito.: | 10322 (M

Return AfR Account

=]

[ 1746380k - [

Apply to Inyoice Ho.: [10322

Jo] | #eolytosales: 0.00

1

Item Quarkity  Returned Description

GL Account  Unit Price Ta

Amount Job

SoLG4160 | w00.00] 10000

@ Pine Stran - wire tied 4 cubic ft, bale] 4000050 |

6.59] 1 695,00 | SPENCER

AURY-1015D | 4.00] 4.00

‘Gothic Stone Bird Bath -2 pc. Height 28] 0000-8Y |

120.99] 1 519,96 |

Customer Account as of Mar 15, 2007
Balance: 1,692.00

CrediLimit;  50,000.00

Credit Status: Motify Ower Limit

Other Applied Receipts
Credit Applied to Invoice:

73,14 [GAGWINY__|CL]
0.00

1,292.10 Credit Tatal

Sales Tax:
Freight:
0.00

1,292.10 0.00 Met Credi: Due

Improve your sales and customer service efforts with ACTL

If you charge the customer a restocking fee, enter it on the Apply to

Sales button with a negative dollar amount.

6. Click the Save button to save the transaction, or click the Print button

to print and save the credit memo.

Peachtree applies the credit memo to the open invoice and closes both
transactions. If you created a credit memo without applying it to an
invoice, the credit memo appears on the Aged Receivable report.

Issuing refund checks for a credit memo

If you owe money to a customer for an overpayment, an open credit, or
some other reason, you can write a check to the customer for the refund

amount owed.

Issuing a refund check is a two-part process. First, you write the check from
the Payments window, and then you apply the check to the credit memo or

overpayment in the Receipts window. This process is based on the assump-
tion that you’ve already created a credit memo or applied the overpayment.

See the preceding section for more information.

Follow these steps to issue a customer refund check:
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Figure 8-7:
After you
select
Customer ID
from the
drop-down
list, Peach-
tree displays
customer
IDs in the
lookup list
box.

1. Choose Tasksz>Payments to display the Payments window.

2. Select Customer ID from the first drop-down list, indicating that the
check goes to a customer rather than a vendor (see Figure 8-7).

= Payments ===
My (O Fi s 4F s W El. ° i &,
oo en BT S AT o Fiow ™ SerilNo el B e
Payment
Bellwether Garden Supply Check Number:
Date: [Mar 15,2007 [ Cash Account
‘cusmme, o ‘ﬂlHOLLAND ‘;‘ § 10200-00 Q
Regular Checking Account
Forky-Nine and 99/100 Dollars
Pay ta the
Ceria Cash Account Balance

Mema:

Quantity Item Descriptian

T Anply to Customer Account: 49.99

GL Accourt

|

Unik Price

Amount Ich

Refund - CCM4010

[11000-00

43,99

A Payment to a customer should b applied ko 8 Prepayment o a Credit Mema on the Tasks/Receipts window,

Maximize your results with help from Peachtree experts.

3. Choose the Customer ID of the customer receiving the refund.

As with generating checks to vendors, don’t enter a check number if

Peachtree will be printing the check for you. Enter a check number only
if you're writing checks by hand (heaven forbid).

. Verify the check Date and the Cash Account from which you are writ-

ing the check.

. On the Apply to Customer Account tab, enter a description for the

refund.

Entering a description helps you remember later, why you issued the
refund.

. Enter or select the GL account to which you want to post the refund

amount.

Typically, this is your Accounts Receivable account.

7. Enter the amount of the refund.

8. Click Print or Save.

For details on printing checks, see Chapter 6. If you’re not going to print
the check or you plan to print a batch of checks later, click Save.
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Figure 8-8:
Clear the
credit memo
and refund
check

from the
customer
record.

When you create a check to a customer, Peachtree applies it to the customer
account, and it appears as a balance due from the customer. To complete

the process, you need to apply the refund check to a credit memo or an
overpayment.

1. Choose Tasks=>Receipts.
2. Select the Customer ID.

The credit memo appears in the invoice listing, along with the refund
check.

3. Click the Pay check box for both the credit memo and refund check.

The amount of the receipt displays zero (0.00). Therefore, no money is
being applied to the general ledger. See Figure 8-8.

4. Enter a receipt Reference number, such as the check number you
wrote to the customer.

5. Click Save.

Both transactions are cleared from accounts receivable.

E Receipts 8[=x]
e BDL &F &< y = tﬁ s -
COM e e Y P E%H D’gte Fow el J%a\ Vent %
Receipt
Depost Tickat 0: Reference: Cosh Aczount
_ Receipt Number | ] ||[1oz00-00 &
Customer 1D [w][HOLLAND Y Date: [Mar 15, 2007 [ | Regular Checking Account

Name:

— Dyt Mt = Cash Account Balance =
Process Credt Card

Apply to Invoices: 0.00 T Appl to Revenues: 0.00 | 0

Invoice DateDue  Amourt Dus Description
oML Apr 6, 2007 49,99
1746 Mar 15, 2007] 49.95

Discount  Amaunt Paid Pay)
-49.99 | oA
49.99

Discount Account: [ 43000-00

Process credit cards directly from within Peachtres.

Entering Finance Charges

Sometimes you want to nudge your customers into paying their bills on time
by charging them a late fee or a finance charge if they pay later than the due
date. Peachtree can calculate finance charges for all customers who have not
been excluded from finance charge calculations and who meet the filter crite-
ria you determine when it’s time to apply the finance charges. Chapter 4 shows
you how to set up your default finance charge terms.
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If you don’t want to charge finance charges to certain customers, you must
alter the default terms for those customers. In the Maintain Customers/
Prospects window, click the Terms and Credits tab. Then remove the check
mark from the Use Standard Terms and Charge Finance Charge boxes.

How do finance charges work?

To whom does Peachtree charge finance charges? Well, only customers who
have a check mark in the Charge Finance Charge box, mentioned in the pre-
ceding paragraph. Okay, that’s obvious, but what other criteria does Peachtree
use? After all, if a customer isn’t late paying, you don’t want to charge a finance
charge.

Peachtree calculates finance charges using the following formula for each
overdue invoice:

Finance Charge = Number of Days Past Due multiplied by the
Daily Rate multiplied by the Outstanding Invoice
Amount

The formula uses these definitions:

v Daily Rate is the percentage you set divided by 365 days.

v Outstanding Invoice Amount is the balance remaining unpaid on the
invoice.

v Number of Days Past Due is the number of days between the date that
you calculate finance charges and one of the following:

¢ The invoice date if aging is set to Invoice Date in the Customer
Defaults dialog box

¢ The due date if aging is set to Due Date in the Customer Defaults
dialog box

e The date of the last finance charge calculation
To clarify these definitions, consider an example: Suppose that today is July
15, and you want to calculate charges for an invoice dated 5/1 (due 5/31) in

the amount of $200.00. Your company charges an 18 percent finance charge
for invoices 30 days overdue. You age your customer invoices by due date.

First, the invoice is overdue by 44 days (from May 31st to July 15th):
(.18/365) x 44 x 200.00 = 4.34
The .18/365 is the annual percentage rate divided by 365 days. Multiply that

by the 44 days the invoice is past due, and then multiply that times the $200.00
invoice amount. Therefore, a finance charge applied on 7/15 would be $4.34.
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Applying finance charges

Okay, now that you understand how the finance charge process works, you

can actually apply the charges.

When you decide to apply a finance charge, Peachtree creates but does not
print an invoice for the amount due. The charges do appear on customer
statements, so you need to apply finance charges before you print customer

statements:

1. Choose Tasks~>Finance Charge to display the Calculate Finance Charges

dialog box.

2. Optionally, select a range of customers for whom you want to calculate

finance charges.

If you leave the customer range blank, Peachtree assumes you want to
calculate charges on all eligible customers (by way of the Charge Finance

Charges check box).

3. Enter the date you want Peachtree Accounting to use to calculate

finance charges and then click OK.

The Apply Finance Charges dialog box seen in Figure 8-9 appears.

Figure 8-9:

You can Apply Finance Charges

p review IF pou zelect Mo ta &pply Finance Charges, you can still print or displayp a report that

finance | Sl et smcvor v s vll gl e foencs crages . he e
C h a rg es Help balance, with or without a list of the finance charges.
before Apply Finance Charges Feport Destination
Peachtree Coes G No C Pinter
a p pl IES Frint Calculation Shest & Sereen
them to the T #
customer

account.
—

4. If you’d like to review the finance charges before Peachtree applies
them, click No to Apply Finance Charges. Or if you’d prefer to just go
ahead and apply the charges, click Yes to the Apply Finance Charges

section dialog box.

5. Choose a Report Destination (Screen or Printer) and then click OK.

The Finance Charge Report Selection dialog box appears. You don’t have
to print the report, but we recommend that you do.
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6. Click OK to print the report in detail.

7. If you elected to review the charges before Peachtree applied them,
repeat Steps 1 through 6, but choose Yes in Step 4.

Peachtree applies the finance charges to the customer.

The finance charge entries are generated with a reference number that begins
with the letters FC (for finance charge). Therefore, never enter a customer
invoice with a reference number that begins with FC. Otherwise, Peachtree
uses that transaction when recalculating finance charges.

Producing Statements

\\J

Before you print statements the first time, you may want to determine state-
ment default preferences. Refer to Chapter 4 on how to set statement default
options.

To print statements, follow these steps:

1. Choose Reports~>Accounts Receivable.
2. Click the Customer Statements folder.

Peachtree considers statements a form. See Chapter 13 for information
on customizing forms.

3. Double-click the statement form you want to use.
4. Select any of the following options from the Statement dialog box:

¢ Statement Type: On balance forward statements, only the balances
left over from previous statements appear. On open items, the detail
for all open items appears.

¢ Print Detail for: Choose to print or not print the line item detail
information for invoices, credit memos, and receipts.

¢ Date: Select the date range of the transactions you want to print on
the statements.

The Filter Range options also allow you to select specific customer IDs
or types. You can also choose the Form Delivery option, which lets you
choose how you want to deliver forms to the defined range of customers:
as paper copies only, as e-mail attachments only, or as both paper copies
and e-mail attachments. If you choose either E-mail or Both, the E-mail
tab becomes available, letting you set up more form delivery options.
See Chapter 13 for details on printing and e-mailing forms.

5. Click OK.
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When the statements finish printing, Peachtree asks you whether the state-
ments printed correctly and if it’s OK to update the Customer file. If you click
Yes, Peachtree stores the statement date in the customer record to use it as
the balance forward date the next time you print statements. If you click No or
Cancel after printing statements, Peachtree does not update the Customer file
and maintains no record of having printed a statement. That means Peachtree
will continue to list invoices as open items on any statement you print. If you
are using Balance Forwarding statements, it is therefore important that you
answer Yes when statements print successfully.

Reporting on Money Your Customers Owe
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&

Although Peachtree can’t guarantee that you make a profit every month, it
does give you some ways to show you (or your investors) your various finan-
cial reports. We're sure you like to track the money you're taking in so that you
can plan your budget or keep your banker happy. So, in Table 8-1, we provide
a description of the reports that pertain to collecting your money.

See Chapter 14 to find out how to print reports.

Table 8-1 Reports Related to Collecting Your Money
Report Name What It Does
Aged Receivables Lists each customer with their outstanding invoices or

credits in aging categories

Cash Receipts Journal Lists the date, amount, description, and general ledger
account number of all receipt transactions created
during a specified period

Visit this book’s Web site for more information on Peachtree.
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Paid Employees Are
Happy Employees

In This Chapter
Setting up employee defaults

Writing and printing payroll checks

Paying commissions or bonuses
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Fey call it work for a reason, some people say. And we can’t think of too
many people who are willing to work without being paid. If you aren’t
using an outside payroll service, you may want to consider using Peachtree’s
payroll features.

Peachtree’s payroll features mimic the functions you perform when you pre-
pare payroll checks by hand. But after you’ve set up basic background informa-
tion for each employee (yes, you still need to know the employee’s gross wages
and number of exemptions), we think that preparing payroll in Peachtree is
much easier and faster than preparing payroll checks manually. Why? Because
you don’t need to look up payroll taxes in the Circular E flyer, you don’t need to
remember which employees have various deductions, and you don’t need to
subtract the taxes and deductions to determine the net payroll check. Further-
more, you don’t need to keep track of the payroll tax liability amounts you, as
the employer, must pay. And, if you allow Peachtree to print the checks, you
don’t need to write them. In this chapter, we show you how to set up your
employees and produce paychecks.

Even if you prepare payroll in Peachtree, you're going to have questions
about handling various situations. The Circular E booklet that you get from
the government every December is your bible for payroll questions. If you
don’t understand the Circular E, contact your accountant. If you don’t under-
stand your accountant, hire a new one.
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If you use an outside payroll service, you may want to consider using
Peachtree’s payroll features to keep your general ledger up to date. That
way, you can accurately report your company’s financial picture. If your
outside payroll service provides you with journal entries, you can ignore
Peachtree’s payroll features and simply enter the journal entries (see
Chapter 17). However, if your outside payroll service doesn’t provide you
with journal entries, you may want to use Peachtree’s payroll features to
mimic the payroll process and match your records with theirs.

Understanding Payroll Basics

\NG/
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Before you start setting up employees and paying them, you really need to
consider some basic information: whom you pay and when you should start
using payroll in Peachtree.

Peachtree uses payroll tax tables to calculate the amounts you deduct for taxes
(Federal Income Tax, Social Security, Medicare, and so on). Best Software, the
company that produces Peachtree, does not ship tax tables that calculate fed-
eral taxes with the software. To accurately calculate payroll, you must either
subscribe to Peachtree’s Payroll Tax Table Update service or create your own
tax tables. To order tax table updates, call 1-800-336-1420 Monday through
Friday, 8:30 a.m. to 5:30 p.m. eastern standard time.

Employees and sales representatives

In this chapter, we're talking about paying people who work for you. You can
rule out vendors for this discussion. Vendors don’t work for you — they just
provide you with goods or services. You pay vendors from the Payments, Write
Checks, or Select for Payment window, as detailed in Chapter 6.

Both employees and sales representatives work for you. As you see in this
chapter, you pay employees from the Select for Payroll window or the Payroll
Entry window. Although employees are always employees, sales reps might
be employees or independent contractors. The windows in Peachtree that
you use to pay sales reps depend on their employment status: employee or
independent contractor.

If you are uncertain about an individual’s status, check with your accountant.

Employees work for you, so, in this chapter, we’re talking about them. And
sales representatives who are also employees work for you, so we're talking
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about them. We aren’t talking about sales representatives whom you treat as
independent contractors; you pay them as 1099 vendors from the Payments
window or the Select for Payments window. See Chapter 5 for information on
designating a vendor as a 1099 vendor. See Chapter 6 for information on paying
vendors.

Most sales representatives, whether they’re employees or independent con-
tractors, earn commissions. If you want to track commissions to make paying
sales reps easier, you need to specifically identify sales reps (both employees
and independent contractors) in Peachtree. Interestingly, Peachtree has you
set up a sales representative in the same window where you set up employ-
ees, even though the sales representative might be an independent contrac-
tor and not an employee.

So, being the logical individual that you are, you ask, “If a sales rep isn’t an
employee, why should I set up a sales rep in the same window where I set up
employees?” Peachtree has you set up sales reps in the Maintain Employees/
Sales Reps window for two related reasons:

v If you set up sales representatives in the Maintain Employees/Sales Reps
window, you can include the sales rep on invoices.

v If you include a sales rep on an invoice, you can produce the Sales Rep
report, which shows commissioned and noncommissioned sales amounts
per sales rep.

‘x&N\BER Including a sales rep on an invoice does not automatically generate a commis-
& sion amount for the sales rep. The inventory items sold on the invoice must

be subject to commission. In the “Writing and Printing Payroll Checks” section,
we tell you how to pay sales representatives who are also employees. In the
“Determining commission amounts” section, you see a sample of the Sales Rep
report. See Chapter 7 for more information about including sales representa-
tives on invoices. See Chapter 11 for information on making an inventory item
subject to commission.

When should you start to use payroll?

You can start using payroll at any time during a calendar year, but you may
find it easiest to start using payroll on January 1. Why? Because, if you start
using payroll on January 1, you won'’t have to enter any beginning balance
information — information to account for paychecks you’ve already produced
this year that need to be included on payroll tax forms and W-2s at the end of
the year.
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If you can’t start using payroll on January 1, try to start on the first day of any
payroll quarter: January 1, April 1, July 1, or October 1. Payroll tax laws require
that you file payroll tax returns quarterly, and you need to include information
only for the current quarter. So, if you start using payroll at the beginning of a
quarter, you can enter beginning balance information as lump sums for each
quarter of the current year in which you’ve produced payroll checks.

As a final resort, if you can’t start using payroll on the first day of any payroll

quarter, start using payroll on the first day of a month. You need to enter begin-
ning balance information for the other months in the current payroll quarter,

but you can enter quarterly amounts for other payroll quarters of the current
year in which you’ve produced payroll checks.

Working with Employee Information

|
Figure 9-1:
Just as

you might
expect,

you supply
general
employee
information
on the
General tab
of the
Maintain
Employees/
Sales Reps
window.
|

In Chapter 4, we show you how the Payroll Wizard walks you through setting
up default payroll information for your company. After the default informa-
tion is in place, you need to set up your employees, establishing individual-
ized information for each of them. For example, different employees claim
different withholding exemptions. And some employees may participate in a
company retirement plan, but others may not. Or some may receive a health
insurance benefit. To set up employees, choose Maintainm>Employees/Sales
Reps. Peachtree displays the General tab of the Maintain Employees/Sales
Reps window (see Figure 9-1).

(9|
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At the top of the window — not associated with any of the tabs in the
window — you assign an ID and type in a name. You also can check the
Inactive box when an employee leaves the company to avoid accidentally
generating a paycheck.

If you need to change an employee’s ID, click the Change ID button.

Note that you can set up each person as an employee, a sales rep, or both.
Typically, you deduct payroll taxes for employees, and you don’t deduct pay-
roll taxes for sales representatives. If you select Sales Rep, three of the six tabs
in the window become gray, and the individual doesn’t appear in the Payroll
windows when you are paying employees. Choose Both if the individual is both
a sales representative and an employee.

We discuss each of the six tabs of the Maintain Employees/Sales Reps window
individually.

General employee information

You use the General tab (refer to Figure 9-1) of the Maintain Employees/Sales
Reps window to give Peachtree general information about each employee —
things like the employee’s name, address, and social security number (you
need those when you produce W-2s at the end of the year). You also can
supply the employee’s telephone number, date of hire, and e-mail address.

Peachtree provides the Type field to give you a way to group employees. If
your company pays worker’s compensation insurance, you might want to
store the worker’s compensation categories in the Type field to make it easier
to produce a report that helps you pay your worker’s compensation liability.

In the lower-right corner of the tab, you see the Beginning Balances button.
Click this button if you're starting payroll on any day other than January 1 and
you've already produced paychecks in the current year. Peachtree displays
the Employee Beginning Balances window (see Figure 9-2).

Use the boxes in this window to enter payroll amounts you've already paid
this year before you started using Peachtree. Each column represents a pay
period that you specify: a week, a biweekly or semimonthly pay period, a
month, a quarter, or even multiple quarters. For example, suppose that you
want to start entering payroll as of July 1, which is the beginning of the third
payroll quarter. In the Beginning Balances window, you can enter one column
of numbers that represents the sum of all the payroll amounts you’ve paid for
the first six months (two quarters) of the year for each payroll field.



168 Partii: The Daily Drudge

|
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Although you can enter amounts for each pay period, we don’t recommend
that approach, simply because it’'s cumbersome and time-consuming.

At the top of each column you intend to use, right-click to display a calendar
and select the ending date of the timeframe represented by the amounts.
Then, in the boxes below the date, type the appropriate amounts for each
payroll field, entering deductions as negative amounts and earnings as posi-
tive amounts. Based on the information in Figure 9-2, we’re starting payroll
on May 1. In the first column, we include the quarterly amount for the first
quarter of the year. In the second column, we include the monthly amount
for April, the first month of the second quarter.

Click the Save button when you finish, and Peachtree redisplays the Maintain
Employees/Sales Reps window.

Custom fields

If you choose MaintainwDefault Information>Employees, you can view the
screen where you establish the custom fields that appear in the Maintain
Employees/Sales Reps window. When you click the Custom Fields tab, you
can type the appropriate information for the employee in each custom field
box. Custom field information is optional.

Payroll information

On the Pay Info tab of the Maintain Employees/Sales Reps window (see
Figure 9-3), you tell Peachtree the method and frequency you use to pay the
employee. We cover both of these in this section, starting with frequencies.
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Setting payroll frequency

Peachtree allows you to pay your employees using any of five frequencies:

v Weekly

v Biweekly

v Semimonthly
» Monthly

v Annually

You don’t need to pay all your employees using the same frequency; that is,
you can pay some employees weekly, some biweekly, and some monthly. The
choice is yours. Most companies tend to pay all employees at the same time,
but Peachtree doesn’t make you operate that way.

Determining pay method

Pay methods tell Peachtree how to calculate wages — and you set up the pay
methods your company uses in Chapter 4. When you open the Pay Method list
box (click the drop-down arrow to the right of the box), you see that you can

choose Salary, Hourly — Hours per Pay Period, or Hourly - Time Ticket Hours:

v Choose Salary to pay your employees a flat rate, regardless of the
number of hours they work in a pay period.

v Choose Hourly — Hours per Pay Period to pay your employees based on
hours they work in a pay period.

v Choose Hourly - Time Ticket Hours to pay your employees for hours
they work in a pay period as recorded on Time Tickets they submit.
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You use time tickets when you intend to bill your customers for the time your
employees or your vendors work on projects for them. You can, but don’t
have to, pay employees based on the time tickets they submit. To find out
more about this pay method, see Chapter 10.

When you choose Hourly — Hours per Pay Period, Peachtree displays the
standard number of hours associated with the frequency you select:

v Frequency: Standard hours
v Weekly: 40

v Biweekly: 80

v Semimonthly: 88

v Monthly: 176

v Annually: 2112

You can change the value that appears in the Hours per Pay Period box. For
example, you can set the number of hours to zero to ensure that you don’t
accidentally pay an employee for time not worked.

You indicate the amount, per pay period, that you want to pay the employee.
In Figure 9-3, we're paying the employee time-and-a-half for overtime and
double-time for special occasions (maybe Sundays). For salaried employees,
you typically don’t see an Overtime field.

If you plan to use time tickets to bill your customers for the time an employee
works on projects — even if you don’t pay the employee based on time
tickets — supply an amount in the Hourly Billing Rate box.

Peachtree Premium users can track an employee’s raise history. Click the Raise
History button, and Peachtree displays a dialog box where you can record the
following:

v The raise date

v The pay rate to which the raise applies (Regular, Overtime, or Special in
our sample company)

v The base amount associated with that pay rate, the Raise Amount, or
the Raise Percentage (you enter one and Peachtree calculates the other)

v Any notes you may want to make about the raise; for example, you might
want to note that the raise was based on the employee’s annual perfor-
mance review or was an out-of-cycle raise due to the on-going stellar
performance of the employee

The window also shows the calculated new amount for that pay rate, but
Peachtree doesn’t change the amount that appears on the Pay Info tab. You
must make that change manually.
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Withholding information

On the Withholding Info tab, you provide — you guessed it — tax withholding
information, such as the employee’s marital status and the number of exemp-
tions he or she claims for federal, state, and local withholding. You also can
supply additional federal, state, and local withholding amounts as appropriate
along with the 401k deduction amount if your company has a 401k plan. Don’t
forget to check the Retirement Plan box if your employee participates in a 401k
or other retirement plan. Check the Statutory Employee box if IRS guidelines
qualify the employee as an employee based on the law. Briefly, four categories
of independent contractors qualify by law as employees. If you don’t know or
aren’t sure whether you have independent contractors whom you must, by
law, treat as employees, ask your accountant.

Peachtree reserves Speciall and Special2 for you to use in payroll tax formu-
las where a value in the calculation is unique for each employee.

Employee fields

You really need to understand only one aspect of the EmployEE Fields tab of
the Maintain Employees/Sales Reps window (see Figure 9-4). You use that tab
to indicate anything about the employee that doesnt follow the payroll defaults
you set up for the company back in Chapter 4.

= Maintain Employees/Sales Reps 3=

General ] Custom Fields ]' Pay Info ] Withhalding Info TEmEInyEE Fields I EmployER Fields

Ficld Name [ 5td [ G/L Account | Cale | TaxMame | Amount [Memo|Fun| Adjust
State O | 2zso0on | GA | =T (] =]
K401 GA | 2330000 | GA | 40IKEE [ ]

VAL Aceng L2 A [ VAC_ADD [rv- ] L]
VAC_Taken| Z [mm] [ ] =]

VAL Remall (2 GA | VAC REM [rv. j ]

Sick v = [ev. =]

Medical | 2 | 2335000 | O [ =]

Dental | 1] 2336000 | (1 [ =] ~|

Dnline payioll processing and tax filing available!

For example, you may change the G/L account to send wages to a different
account than the default account. Or if an employee doesn’t participate in
the company’s dental plan (such as Amanda in Figure 9-4), you’d remove the
check mark from the STD column (STD represents standard, as in the com-
pany default). If there had been a check in the Calc column, you would remove
it as well.

171
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You remove the check mark from the STD column so that Peachtree allows you
to remove the check mark from the Calc column. What’s the Calc column? Well,
when you place a check mark in the Calc column, Peachtree expects to use a
payroll tax table to calculate the amount for the field. You remove the check
mark from the Calc column under two conditions:

v When you're not going to use a calculation to figure the amount for the
employee; instead, you want to supply a fixed amount in the Amount
column

1 When you don’t want to calculate the field for the employee

If the employee’s calculation is different from the standard (default) calcula-
tion, and you remove the check mark from the STD column but don’t remove
the check mark from the Calc column, you can select a different calculation
for the employee. Simply click in the Tax Name column to use the lookup list.

If you don’t intend to calculate the field for the employee, you must remove
the check marks from both the STD column and the Calc column. Otherwise,
Peachtree still calculates an amount based on the formula in the payroll tax
table.

Employer fields

The EmployEE Fields tab and the EmployER Fields tab in the Maintain
Employees/Sales Reps window closely resemble the same tabs in the Employee
Defaults dialog box. That makes sense because Peachtree gets the information
it displays in the Maintain Employees/Sales Reps window from the informa-
tion you enter in the Employee Defaults dialog box.

The EmployER Fields tab, like the EmployEE tab, is used to indicate anything
about the employee that doesn’t follow the defaults you set up for the
company.

Writing and Printing Payroll Checks

A\

Now you come to the part that your employees like most — the part where you
produce paychecks. Peachtree enables you to pay employees en masse or one
at a time; we discuss both methods. Typically, you pay groups of employees
at the same time, so we think you can make more use of the group method.

We recommend that you let Peachtree print paychecks for you. You can save
lots of time and reduce the possibility of introducing errors because you won’t
be typing in information.
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Using the Direct Deposit service

For an additional fee, Peachtree supports use of
a direct deposit solution in all versions of
Peachtree except Peachtree First Accounting.
Using direct deposit, you still create paychecks
in Peachtree the same way that we describe in
preceding sections in this chapter, identifying
employees who participate in direct deposit as
you create the paychecks. You don’t actually
print the paychecks to give to employees;
instead, through the Direct Deposit service,
money is electronically transferred from your
bank accountto each employee’s bank account

on payday. If you want to print a stub for your
employees, you can do so as you create the
paychecks. Using the Direct Deposit solution,
employees can select one or more bank
accounts into which money can be deposited;
the employees can identify fixed amounts or
percentages to deposit to each account.
Directly deposited paychecks appearin Account
Reconciliation in lump sums that should match
your bank statements. Checks processed through
the Direct Deposit service become read-only in
Peachtree, and you cannot edit them.

WMBER
“&
&

In this section, we show you how to produce and print paychecks and how to

pay commissions and bonuses — two other common payroll needs.

Paying a group of employees

Paying a group of employees is similar to paying a group of vendors. In this
section, we walk you through how to select employees to pay and how to

print paychecks.

If you write your checks by hand or use an outside payroll service, plan
to print the paychecks that Peachtree produces on plain paper, because

Peachtree posts the information to the general ledger when you print the

checks.

Follow these steps:

1. Choose Tasks=>Select for Payroll Entry.

Peachtree displays the Select Employees - Filter Selection dialog box you
see in Figure 9-5. Use this dialog box to select the majority of employees
you want to pay.

sMBER Try to make the selection include everyone you want to pay, even if the
selection includes more people than you intend to pay. After you make
choices in this dialog box, you have another opportunity to exclude

employees.
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2. In the Pay End Date box, select the date that represents the last day of
the pay period.

3. In the Include Pay Frequencies section, check all of the boxes that
represent the pay frequencies you want to include.

For example, include employees you pay weekly. As you can see from
the dialog box, you can include all pay frequencies. If you don’t have any
monthly or annual employees, you can leave the boxes checked without
affecting anything.

4. In the Include Pay Methods section, choose to pay hourly employees,
salaried employees, or both.

5. Use the Include Employees section to limit the range of employees
you pay.
If you want to pay all employees who meet the other criteria you estab-
lish in this dialog box, simply choose All Employees. Otherwise, in the

From box, select the first employee you want to include. Then, in the To
box, select the last employee you want to include.

We suggest that you include all employees because you have another
opportunity in the next window to exclude an employee.

If you have enabled direct deposit, the Employees drop-down list contains
two additional choices besides All and Range; you see Direct Deposit Only
and Manual Check Only.

6. Click OK.
Peachtree displays the Select Employees to Pay window (see Figure 9-6).

7. If you don’t like the selection you see, click the Select toolbar button
to redisplay the Select Employees - Filter Selection dialog box (refer
to Figure 9-5).
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The Select Employees to Pay dialog box has some options you should keep
in mind:

»* You can change the cash account from which the checks will be written

if necessary.

v An asterisk next to an employee’s name signifies that you've set up
the employee’s pay method as Hourly — Time Ticket Hours, and that

employee’s paycheck is based on the number of time ticket hours in the

current pay period. Find out more about time tickets in Chapter 10.

v If you've enabled direct deposit, you see an extra column in the Select

Employee to Pay window to the right of the Pay column; the additional
column is titled DD. A red check mark in this column identifies employees

who are set up to use direct deposit. You can remove the check mark,
but you cannot add a check mark to anyone who is not set up to use
direct deposit.

v You can change the number of hours worked for hourly employees or
the salary amount for salaried employees; Peachtree recalculates the
taxes and net check amount.

v You can change the number of weeks in the pay period. Typically, you see

Chapter 9: Paid Employees Are Happy Employees

1, 2, 12, or 52; these numbers indicate the frequency with which you pay
each employee (weekly, biweekly or semimonthly, monthly, or annually).
Changing the number of weeks in the pay period affects the pay period

beginning date on the paycheck stub. Peachtree calculates the beginning
date by subtracting the number of weeks from the Pay Period Ending Date.

You can print the Pay Period Beginning Date on a paycheck stub. You need
to customize the payroll check form to add the field. See Chapter 13 for
information on customizing forms.

v You can avoid paying an employee by removing the check mark from the

Pay column.

175
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Viewing the details

You can view and make changes to the details of any employee’s check.
Highlight the employee and click Detail on the toolbar. Peachtree displays
the Select Employees to Pay — Detail window. When you finish viewing or
changing details, click OK to redisplay the Select Employees to Pay window.

V?‘“\NG! Don’t change Social Security or Medicare amounts. If you do, you’ll find dis-
& crepancies on your payroll tax reports, and the 941 quarterly payroll tax return
won'’t be accurate. You can, however, change the Federal Income Tax and state
income tax amounts with no side effects. Make changes to the hours/salary
first and the taxes second; if you make the changes in the opposite order,
Peachtree will recalculate the taxes and ignore your tax changes.

Allocating time to jobs

If you use jobs and want to allocate an employee’s time to various jobs, follow
the steps in the “Paying a group of employees” section to display the Select
Employees to Pay window. Then follow these steps:

1. In the Select Employees to Pay window, click the employee.

2. Click the Jobs button to display the Labor Distribution to Jobs
window (see Figure 9-7).

Lahor Distribution to Jobs

o o BE. &
Cancel: OK Fow gip

Job Hourly Field Hours Amaunt
CHAPPLE Regular 45.00 E30.00
Mane Regular 3B.00 430,00
More Overtime 0.00 0.00
Mane Special 0.00 0.00

Figure 9-7:
Allocate
employee
hours to
Jobs.

Total for check 1120000

3. Click in the Job column on the line displaying the type of pay you want
to allocate — Regular, Overtime, or Special.

Peachtree inserts a blank line.
4. Click the blank box in the Job column to display a lookup list button.
5. Use the Lookup list indicator to select a job.
6. In the Hours or Amount column, assign hours or dollars to that job.

Peachtree assigns the hours or dollars to the selected job and adjusts the
unassigned hours or dollars accordingly.
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7. Repeat Steps 3 through 6 as needed to continue distributing hours or
dollars.

8. Click OK when you’re finished to redisplay the Select Employees to
Pay window.

Listing the checks that you plan to print

Wouldn't it be nice to know how many checks Peachtree is planning to print?
(You may have noticed that you don’t see that number in the window any-
place.) Well, if you click drop-down arrow on the Print button and then click
Report, Peachtree prints a report that shows you the details of checks you're
printing. At the end of the report, you also find the number of checks you're
printing. To preview checks on-screen, click the drop-down arrow on the Print
button and then choose Preview. See Chapter 13 for details on printing forms
(checks are called forms in Peachtree).

Printing checks

If you click the Print button in the Select Employees to Pay window, Peachtree
displays the Print Forms: Payroll Checks window. From this window, you can
confirm (or change) the first check number, select a check form, identify the

number of copies 